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Foreword and history

The SSII program was developed in 1990-91 during the work with my dr. ing. degree at the
Division of Hydraulic Engineering at the Norwegian Institute of Technology. SSII is an abbre-
viation for Sediment Simulation In Intakes. The program was originally built around the CFD
program SPIDER, made by Prof. M. Melaaen during the work on his dr. ing. degreein 1989-
90. SPIDER solves aflow problem for ageneral three-dimensional geometry. SSII was made
up of sediment calculation routines for 3D solution of the convection-diffusion equation for
the sediments, communications with SPIDER and a graphical user interface made in OS/2.

The main motivation for making SSI1 was the difficulty to simulate fine sedimentsin physical
models. The fine sediments, often under 0.2 mm, are important for wear on turbines. It was
also an advantage to be able to simulate other problems as for example sediment filling of res-
ervoirs and channels.

After finishing my dissertation in 1991, | wanted to improve the CFD program. A disadvan-
tage with the SSI1 and the SPIDER programs for practical situationswas that a structured grid
was used, and it was only possible to have one block for an outblocked region. A natural
improvement was a multi-block model with general outblocking possibilities. This meant con-
siderable changesin SPIDER. Instead, a new water flow module for multi-block calculation
was made. This model was added to SSI1, and the resulting model was called SSIIM.

SSIIM, version 1.0, was uploaded on the Internet 17th of June 1993. Version 1.1 had some
bug-corrections and some improvements in the water flow calculation for multiple blocks.
Version 1.1 was uploaded on the net 18th of October 1993. In thefall of 1993 version 1.2 was
made, with an improved user interface, some additional tools and arevised manual. It was
uploaded on the net 22nd of December 1993. It was also distributed by diskette to selected
water institutions in January 1994. Version 1.3 included several bug-fixes, improved sediment
calculation and improved graphics. This was uploaded on the net 5th of April 1994. Version
1.4 also included transient calculations of water flow, free surface and sediment transport,
water quality, a 2D depth-averaged water flow module and improved graphics.

SSIIM version 1.x uses a structured grid, which makes it difficult to model very complex
geometries. In the summer of 1997 the main modules of SSIIM 2.0 was made, with an
unstructured and nested grid. This was tested and enhanced during the following two years of
my post-doc study in Bristol and Trondheim.

In the summer/fall 1999 both versions of SSIIM were ported from OS2 to Windows. Version
1 was split into three executable: The grid editor, the OpenGL 3D graphics and the main pro-
gram. SSIIM 2 had one executable, with the grid editor incorporated, and no OpenGL graph-
ics. The OpenGL graphics was only supported on Windows NT, and omitting it in SSIIM
meant that the program could be run on Windows 95 and Windows 98. The main advantages
of the Windows version are more computers can run the program and the Windows version
runs roughly twice as fast as the OS/2 version, probably due to the faster compiler. In SSIIM
1.1 for Windows, the Grid Editor was again included into the main program. The OpenGL



graphics was a separate program: si3dview. In 2001, algorithms were made that printed out
filesthat could be read directly by the Tecplot program. This program is commercially availa-
ble, and has good visualization possibilities, including 3D views. The si3dview program is
therefore not planned to be updated. In the spring 2007, algorithms for writing input files for
the ParaView program was added. The ParaView program issimilar to Tecplot, but it is free-
ware. Also, algorithms to write an OpenFOAM mesh was added in the spring 2007. Open-
FOAM is ageneral-purpose CFD program that is also freeware, with available source code
and many more turbulence models than SSI1M.

In the spring 2001, the Windows versions of SSIIM was made with DLL libraries. DLL isan
abbreviation for Dynamic Link Libraries. DLLs containing numerical algorithmsfor sediment
transport and flow resistance from vegetation were made. The DLLs may be further devel oped
by cooperating research groups. In 2005, the source code for the beddll.dll file was made
available on the web.

A native Linux version of SSIIM 1 without user interface was made in 2005, and made availa-
ble on our web pages. The source code for this version is aimost identical to the Windows
source code for the computational part. It is planned that the Linux version will be updated,
but with less frequent intervals than the Windows version.

In the summer 2007, work was started on parallel versions of the SSIIM programs. |mplemen-
tation was done by using OpenMP. This enabled the utilization of multi-core capabilities of
the emerging processors. It also enabled the use of the program on high-performance clusters
with shared memory nodes. Initial work on an MPI version of SSIIM 2 was started in the fall
2012.

From 2010, the nested grid option was further developed in connection with sediment trans-
port computations. The main application was local scour. Further developments include free
surface algorithms and sand slide algorithms.

Over the last years | have been working on web pages for my research on CFD using SSIIM.
The address of the page is http://folk.ntnu.no/nilsol/cfd. News about applications, books,
SSIIM versions etc. will usually be posted there.

I would like to thank all the people who have provided me with insight into the various prob-
lems| have encountered in the development of this program. | have benefited greatly from the
knowledge of Prof. Morten Melaaen at Telemark Institute of Technology, in the science of
computational fluid dynamics. In the topics of hydraulics and sedimentation engineering |
have learned from Prof. Dagfinn Lysne at Division of Hydraulic and Environmental Engineer-
ing at the Norwegian University of Science and Technology, and from Prof. Pierre Julien,
Prof. Johannes Gessler, Prof. Ellen Wohl and Prof. Bogusz Bienkjewicz at Colorado State
University. Torulf Tjomsland and Gesta Kjellberg from the Norwegian I nstitute of Water
Research hel ped me with the biochemical modelstogether with Glen George at the I nstitute of
Freshwater Ecology, UK, Sally Heslop at University of Bristol and Richard Hedger at Univer-
sity of Edinburgh. Also thanksto Prof. Steve Chaprafor his advice and excellent book on
water quality modelling. Knut Alfredsen at the Norwegian University of Science and Technol-
ogy helped me with software and hardware problems during the work with my dissertation,



making the SSII model. VijayaK. Singh at IBM Canada helped me with the C compiler. Dave
Zenz and Suzy Deffeyes at IBM Visual Systems helped me with the OpenGL graphics. |
would also like to thank the following people for helping me test the program: Morten
Skoglund, Oscar Jimenez, Aslak Lavall, Lars Abrahamsen, Siri Stokseth, J. Chandrashekhar,
Knut Alfredsen, Hild Andreassen, Hilde Marie Kjellesvig, Md. Mahbubur Rahman, Tuva
Cathrine Daae, Anne Sintic, Atle Harby, Amirul ISlam Khan, Noor Quasim Khan, Chris Bow-
les, Catherine A. M. E. Wilson, Per-Ludvig Bjerke, Yaw Okyere, S. M. A. Azim, Ishfaq
Ahmed, Tor-Haakon Bakken, Josip Jugovic, Sebastian Palt, Thorsten Stésser, Richard Hedger,
Roland Parrot, Koen Blanchaert, Istiarto Istiarto, Ahmed Siyam, Tom Bryant, Péter Borsanyi,
Hans-Petter Fjeldstad, Chris Whitlow, Doug Booker, Mohammad Irfan, Pravin Rg Aryal,
Michael Abebe Haile, Harsha Suriyaarachchi, Tim Fischer-Antze, Lars Jensen, Susanne
Krlger, Sabine Sultzer, Felix Hermann, Beate Kohler, Faruk Bhuiyan, Philip Soar, Georg
Premstaller, Michael Tritthart, Dania Huggins, Juan Carlos Atoche, Ricardo Mantilla, Nils
Rather, Ingerid Pegg, Oral Yagci, Sandor Baranya, Nasib Man Pradan, Jagadishwar Man
Singh, Asta Gurandsrud, Jerome Molliex, Morten Stickler, Jorn Wildhagen, Rami Malki,
Aravind Kumar Agrawal, Juan Martin Viscardi, Robert Feurich, Nadine Kilsby, Hans Bihs,
Pegay Zinke, Zafer Defne, Desidlava Bal zhieva, Dejana Djordjevic, Annette Schulte-Rentrop,
Clemens Dorfmann, Mostafa Jalali, Ursula Stephan, Christine Sindelar, Christoph Ortner,
Gudrun Hillebrand, Stefan Haun, Lisa Emilie Hoven, Marc Roberts, Irina Klassen, Gabriele
Harb, Laura Nardi, Sigurd Levfall, Markus Noack, Christian Svensson, Halvor Kjaads, Sand-
eep Bomminayuni and Qing Zhang. Also thanks to Richard Hibbert, David Seed, Richard
May, LucaBarone, |sabelle Lavedrine, Norbert Jamot and Fabio Spaliviero at HR Wallingford
Ltd., U.K. for their input and evaluation reports on SSIIM. Special thanksto Prof. Wolfgang
Rodi, Prof. Gerhard Jirka, Prof. Roger Falconer, Thorsten Stésser, Catherine Wilson, Jan Wis-
sink, Dominic von Terzi, Manuel Garcia-Villalbaand Clemens Braun for advice on numerical
algorithms and other assistance for the work during my sabbatical stay in Cardiff and Karl-
sruhe 2005/2006. | am also greatful for al the assistance from staff and fellow researchers at
the Bundesanstalt fir Gewésserkunde in Koblenz, Germany, during my sabbatical in 2012/
2013.
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Nils Reidar Bge Olsen
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Chapter 1. Introduction

1.1 Disclaimer and legal matters

| disclaim al warranties with regard to this software and the information in this document,
whether expressed or implied, including without limitation, warranties of fitness and mer-
chantability. In no event shall | or my employer be liable for any special, indirect or conse-
quential damages or any damages whatsoever resulting from loss of use, data or profits,
whether in an action of contract, negligence or other tortuous action, arising out of or in con-
nection with the use or performance of this software. The program contains a number of bugs.
It is not recommended that the program be used for solving a problem whose incorrect solu-
tion could lead to injury to a person, loss of property or economical losses. If you do use the
program in such amanner, itisat your own risk. It is necessary to know that to understand and
interpret the program results properly it is required that the user have knowledge and experi-
ence in computational fluid dynamics and hydraulic engineering.

If results from SSIIM are used in a publication, this should be stated in the publication.
Provided the user complies with the above statements, the program can be used freely.

The program can be distributed freely on condition that an unchanged copy of this manual is
distributed with the program.

Nils Reidar B. Olsen

1.2 Limitations of the program and known bugs

Some of the limitations of the program are listed below.

* The program neglects non-orthogonal diffusive terms.

* The grid linesin the vertical direction have to be exactly vertical.

* Kinematic viscosity of the fluid is equivalent to water at 20 degrees Centergrade. This
is hard-coded and can not be changed.

* The program is not made for the marine environment, so all effects of density gradi-

ents due to salinity differences are not taken into account.

In computer science, avery well tested program still contains about one bug pr. 2000 lines of
source code. The SSIIM programs contains over 100 000 lines of source code, and several
modul es have not been much tested. Also, combinations of modules may not have been tested
at al. It istherefore likely that there are a number of bugsin the program. The user is advised
to take thisinto consideration when evaluating the results of the program.



If the user publish resultswhere the SSIIM model has been used, the user should includein the
publication a statement that says that the SSIIM model has been used.

Provided the user complies with the above statements, the program can be used freely. The
program can be distributed freely on condition that this disclaimer and an unchanged copy of
the User's Manual is distributed with the program.

Some problems are also described in more detail in Chapter 2.15.

If you find any serious bugs that are not mentioned above, | would appreciate if you let me
know. Please use the following address:

NilsR. Olsen

Department of Hydraulic and Environmental Engineering
The Norwegian University of Science and Technology

S. P Andersensvei 5

N-7491 Trondheim

Norway

1.3 Model purpose

SSIIM is an abbreviation for Sediment Simulation In Intakes with Multiblock option. The pro-
gram is made for use in River/Environmental/Hydraulic/Sedimentation Engineering. Initially,
the main motivation for creating the program was to simulate the sediment movementsin gen-
eral river/channel geometries. This has shown to be difficult to do in physical model studies
for fine sediments. L ater, the use of the program has been extended to other hydraulic engi-
neering topics, for example spillway modelling, head loss in tunnels, stage-discharge relation-
shipsin rivers and turbidity currents. However, the main focus of the program is to model
sediment transport in rivers, reservoirs and around hydrualic structures.

The main strength of SSIIM compared to general-purpose CFD programsis the capability of
modelling sediment transport with moveable bed in a complex geometry. Thisincludes a
number of algorithms for different sediment processesizes, including sorting, bed load and
suspended load, bed forms and effects of sloping beds. The latest modules for wetting and dry-
ing in the unstructured grid further enables complex geomorphological modelling.

Over the years, SSIIM has also been used for habitat studiesin rivers, mainly for salmon.
Free-flowing algae has also been modelled, as a part of extending the model for use in water
quality engineering. However, the main focus of our research is on sediment transport.

The program is made for teaching and research purposes. It is not as well tested as commercial
CFD programs, meaning it will have more bugs and be lessreliable.



1.4 Model overview

The SSIIM program computes the water velocities and sediment transport in rivers, channels
and reservoirs. The Navier-Stokes equations are solved with the k-¢ turbulence model on a
three-dimensional aimost general non-orthogonal grid. The velocities are used when solving
the convection-diffusion equations for different sediment sizes. This gives trap efficiency and
sediment deposition pattern. Bed changes over time can be computed, together with move-
ment of the free water surface.

As with other multi-dimensional numerical models, SSIIM is divided into three parts. A pre-
processor, a solver and a post-processor. The pre-processor includes tools to generate input
data, including the computational grid. Thereis an interactive graphical grid editor with ellip-
tic and transfinite interpolation together with a discharge editor. Grid can be generated on the
basis of measured geometry data.

The user interface of the program can present velocity vectors and scaler variablesin atwo-
dimensional view of the three-dimensional grid, in plan view, a cross-section or alongitudinal
profile. It is possible to export results to programs as Tecpl ot or ParaView for post-processing.

The results can be viewed in the SSIIM graphics during the solution of the equations. Also,
print-out of result files can be done from the menu.

New users are recommended to read Chapter 2.1 which gives more details and advice. It is
also recommended to try the tutorials described in Chapter 2.

1.5 A guideto the different SSIIM versions

Before starting to use SSIIM, a decision has to be made about which version to use. There are
two main versionsof SSIIM: SSIIM 1 and SSIIM 2. SSIIM 1 usesa structured grid and SSIIM
2 uses an unstructured grid. Each of the programsis divided in two modules: A user interface
and numerical algorithms. There are SSIIM versions both with and without the user interface.
Since the user interface is made in Windows, versions running natively on Unix are without
user interface. There are also both 32 bits and 64 bits versions of the Windows versions. The
main difference isthat 32 bits versions can only access 2 GB RAM, which means the maxi-
mum number cellsis about 2 million. The 64 bits versions do not have this limitation. From a
practical point of view, the amount of RAM in the computer limits the grid size of the 64 bits
versions.

The programs can also be compiled to run with or without DLL’s (Dynamic Link Libraries).
The DLL’s are modules where other programmers can code new algorithms and formulas, for
example aformulafor the sediment transport capacity. The DLL's only work on Windows, so
all UNIX versions are compiled without DLL’s.
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There are different versions of SSIIM for parallel computations on clusters. The web page
where the model is downloaded gives more information:

http://folk.ntnu.no/nilsol/ssiim
Sructured vs. unstructured grids

In the structured 3D grid used by SSIIM 1, each cell will have three indexes, making it easy to
identify grid locations. Thelocation of walls and inflow/outflow surfaces are then specified in
input files, where the grid indexes are included in the data set.

In the unstructured grid of SSIIM 2 thisis not possible, asthe grid cells only have one index
which isamost randomly generated. The user then hasto specify theinflow and outflow areas
by the use of agraphical discharge editor. This editor does not exist for the structured grid ver-
sions. Also, the grid editor for the unstructured grid includes the possibility of generating and
connecting multiple blocks. The structured grid editor only works on one block.

The speed of the computation will often be better for the structured grid version, asfaster solv-
ers are available. The structured grid will also use less memory pr. cell, as connections
between cells, surfaces and geometry points are ssmpler. SSIIM 2 has some water quality and
sediment transport algorithmsthat are not in SSIIM 1. The main advantage of the unstructured
version isits ability to model complex geometries and its algorithms for wetting/drying. L at-
eral movements of ariver can only be modelled with SSITM 2.

SSIIM 1 with the structured grid is easier to understand, intially. It is therefore recommended
to start using this version. SSIIM 2 is more under development than SSIIM 1, which means
SSIHIM 2 will generally have more bugs.

It ispossible to generate agrid in SSIIM 1 and transfer it to SSIIM 2 or the other way around.
See Appendix | for further details.

Asaconclusion and quick guide: Use SSIIM 1 if possible, and only use SSIIM 2 if you have a
very complex geometry and/or wetting/drying processes.
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Chapter 2. Startup using SSI M

2.1 Advice for new users

Before you use SSIIM, it is necessary to have a minumum knowledge about hydraulics, fluid
mechanics, sediment transport and numerical modelling. It is recommended that courses are
taken in these subjects at university level. Then it is advisable to start with reading this man-
ual.

A CFD computation generally consists of three steps:

1. Pre-processing
2. Computations
3. Post-processing

Pre-processing is generation of grid and input files. The SSIIM models contains grid genera-
torsto assist in making grids. Post-processing is viewing the results of the model. There are
some graphicsto do thisin the SSIIM models. But it is aso possible to use other post-process-
ing packages as Tecplot or ParaView. An introduction to the pre and post processing in SSIIM
isgiven by the tutorialsin Chapter 2.3t0 2.7.

The computationsitself can be calculations of water velocity calculations, sediment flow, bed
level changes, water level changes and/or water quality. Each calculation is done by a module
in of SSIIM. Some of the modules can be started from the program menu. The different the
calculations can be combined, for example the water flow, sediment flow and bed changes
computations. Thisis further described in Chapter 2.2.

An advice for the first-time user is to run the tutorials described later in Chapter 2 and one of
the example cases. Try to modify some of the parameters and run it again. Often the user
wants to simulate a particular case. It isthen advisable to try to find asimilar example case
and modify this step by step.

The next problem is then often regarding computational speed and convergence. The user is
recommended to read Chapter 2.12 for advice on these issues.

The SSIIM program has many input and output files. One of the most important filesis the
boogiefile, which is produced by SSIIM and contains error messages and other results. SSIIM
includes some controls for input and checking of intermediate results. If any of these controls
finds something wrong, an error message is written to the boogie file, and the program termi-
nates. Therefore, if the program suddenly stops, and the main user interface disappears, check
the boogie file for possible error messages. Also, some warning messages may be written to
the boogiefile if particular problems occur. Chapter 2.16 gives advice for finding bugs in the
program.
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The hardware requirements for running the program are sufficient amount of RAM in the
computer and the speed of the computer. In the beginning of the boogiefileit is printed how
much RAM the program allocates for the arrays. This can be added to the RAM requirement
for the program itself, about 4 MB, plus what the operating system requires. An estimate for
the amount of RAM is thereby obtained. The harddisk is used as extramemory if thereis not
sufficient RAM. The penalty is that the program runs very much slower. This situation can be
detected by observing if the system swaps to the harddisk while running only the SSIIM pro-
gram. The water flow module may take up to several days to converge for some cases, even
when there is enough RAM. The 32 bits versions of SSIIM can roughly handle 2 millon cells.
If you need more cells, you have to use the 64 bits versions of SSIIM.

When you have gotten results from SSIIM, you need to interpret these. You should then think
about:

- Possibilities of bugsin the program making errors

- Previous cases where the results have been compared with measurements
- Numerical errors, like false diffusion, grid independence, etc.

- Accuracy of input data and boundary conditions

Knowledge and experience in computational fluid dynamics and hydraulic engineering are
essential for the assessment of the validity and accuracy of the results. Chapter 2.13 gives fur-
ther assistance for interpreting the results.

2.2 Starting up: overview of steps

The SSIIM programs are made up of anumber of modules that reads files, makes grids, calcu-
lates unknown parameters, write result files etc. Some of the modules are started automati-
cally, and some need to be started by the user. The user has two options on how to start the
modules:

1. Use the menu in the graphics user interface
2. Specify which modules are to be run in an input file.

Option 1 isdescribed in Chapter 4. Option 2 requires that afile called control exist in the
directory the program is run from, and that this file contains a data set called F 2. The control
file can contain a number of data sets, most often identified with a capital letter and a number.
Then datais given after the identificators. The F 2 data set contains anumber of capital letters.
For each letter, a computing module of SSIIM is started. See Chapter 5.3 for more details
about the data sets in the control file.

Some of the SSIIM versions do not have auser interface. Then option 2 isthe only possibility
to start modules of the program. The Windows versions of SSIIM has user interfaces. It con-
sist of awindow which showsthe grid or the results of the computations. At the top, thereisa
menu. The menu can be used to for example start computaitons, read/write files, change the
view of the graphics or the parameters shown in the graphics. The first time user is recom-
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mended to start the program and try the different options to get to know the program.
1. Making/reading the grid

When the program is started, it automatically searches for the control file. If the file isfound,
it will use the datafrom thisfile. What happens afterwardsis different in SSIIM 1 and SSIIM
2.

SSIIM 1 will automatically look for the koordina file, which contains the grid. If it is not
found, adialog box will emerge and the user will be guided into making thisfile for a straight
channel. The same thing happensiif the control file is not found. The tutorials shows how this
process is done. SSIIM 1 will automatically read the control and koordina files at startup.

SSIIM 2 will not start up adialog if any of the input files are not found. In SSIIM 2, the grid
and information about inflow/outflow of water isgivenin afile called unstruc. Thisfileisnot
automatically read. The user need to make the program read the file by using the menu or the
F 2 data set in the control file. The parameter used in the F 2 data set is U, meaning the letters
F 2 U hasto be given in the control file. Of course, the grid hasto be made first. Thisis
described in the tutorials.

There might be up to 10 letters on the F 2 data set. The program will then read 10 characters
after encountering F 2 in thefile. It istherefore advisable to have a number of characters
which are not capital letters on the line after the data set. L ower-case charachtersin the control
filewill be ignored.

2. Doing computations

After the grid is made and read, the computations can be done. The question is then: What do
you want to compute? There are a number of options:

a) Compute a steady water flow with fixed water surface and fixed bed

b) Compute stationary sediment flow with afixed water surface and fixed bed

¢) Compute stationary water flow with an unknown water surface and a fixed bed

d) Compute unsteady water flow with amoving water surface and fixed bed

€) Compute unsteady water flow and sediments with a fixed water surface and moving bed

f) Compute unsteady water flow and sediments with a moving water surface and moving bed
g) Compute unsteady water flow with amoving water surface and fixed bed where thereis
wetting and drying

h) Compute unsteady water flow with a moving water surface and moving bed where thereis
wetting and drying.

Options g) and h) are only possible with SSIIM 2, as wetting and drying is not included in
SSIIM 1.

All algorithms dealing with time-dependent changes in water level or the bed level will intro-

duce uncertainties. The algorithms will also cause computational time to increase, often with
severa orders of magnitude. If some of the variables can be assumed to be stationary over
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time, thisis often atime saving option. This especially applies to the location of the bed and
water surface.

Casea), ¢) and d)

To compute the water velocities, with and without changes in the discharge or free water sur-
face, the option Compute->Waterflow is to be used in the program menu. Or usethe F 2 W
data set in the control file. In SSIIM 2, the grid has to be read first, so the data set will be

F 2 UW. To invoke algorithms changing the free water surface, more information isgiven in
Chapter 2.2.

If the user want to start the computation with apreviously computed water flow field stored in
theresult file, the file can be read first. This can be done from the menu or using an Rin the F
2 data set. The data set will then be F 2 Rw for SSIIM 1 or F 2 URW for SSIIM 2.

Caseb)

A sediment computation require information about the sediments on data sets in the control
file. The Sdata sets gives sediment size and fall velocity and the | data sets give inflow of sed-
imentsin kg/s. The N data sets gives information about different grain size distributions and
the B data sets tells where in the geometry the different distributions are. These data sets must
be given with correct parameters.

The steady sediment flow is computed by the menu or the letter Sin the F 2 data set. An ini-
tialization of the sediment flow (giving values to the concentration in al cells based on the
Hunter-Rouse distribution) isdone by using the | letter on the F 2 data set The steady sediment
flow will use apreviously computed water flow field. In other words, the water flow hasto be
computed first, and then the sediments. On the F 2 data set thiswill be F 2 W Sfor SSIIM 1 or
F 2 UWISfor SSIIM 2. However, usually the water flow computation takes much longer than
the sediment computation. Normally, one might want to do several sediment computations
with for example different transport formulas. Then one can do the water flow computation
first, and store the flow field in the result file. Instead of recomputing the water flow field, one
can read theresult file by giving an R on the F 2 data set. Thiswill then result in the following
data sets: F 2 RISfor SSIIM 1 or F 2 URISfor 2.

Note that it is also technically possible to not compute the water flow before the sediment
computation. Thiswill of course give acompletely wrong result, as the sediment computa-
tionsis based on aknown water flow field.

Casee) and f)

A time-dependent computation of water and sediment transport require more data sets in the
control file. First, the same data sets describing the sediments as given for case b) must be
included. Also atime step hasto be given, on the F 33 data set. Then the F 37 data set has to
be used, typically with an integer 1 or 2. If afree water surface isto be computed, the F 36
data set also has to be used, with the integer 2, for example. The computation itself isinvoked
by the letter Son the F 2 data set. The F 2 data set might therefore be F 2 RISfor SSIIM 1 or
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F 2 URISfor SSIIM 2. Starting with apreviously computed flow field isoptional, and so isthe
initialization of the sediment concentrations. The data set might thereforebe F 2 Sor F 2 US,

Any variation over time of the water level, water discharge or sediment inflow must be given
inthetimei file.

Caseg) and h)

Cases with wetting and drying are the most complicated problems, and can only be computed
with SSIIM 2. The main principle isto make a grid with SSIIM 2 that covers al areas, both
wetted and dry. This grid isthen stored in the unstruc file, which is used at startup of the com-
putations. Thisfile must not be overwritten later, when the grid shrinks. The file will contain
information about the bed levelsin areas that can dry up and later become wetted. If the water
level isto be changed during the computation, the reference cell number on the G 6 data set
has to be taken from this grid.

Since the unstruc file hasto cover al areas that can be wetted, the water level has to be high
during the generation of theinitial grid. If thisisthe physical situation we want to model, this
isfine. For example, a drawdown of the water level in areservoir. Algorithms has to be
invoked that moves the water level down (G 6 data set + timel file). However, sometimes the
user want to start the computationswith alower water level. An exampleisthe computation of
the formation of a meandering channel. Theinitial channel will then move sideways in areas
that were not wet at the start of the computation. To solve the problem, the following proce-
dure can be used:

When the unstruc fileiswritten, also afile called koordina.t iswritten automatically. Thisfile
issimilar to the SSIIM 1 koordina file, but it contains both the bed and the water level. The
water level isthelast floating point on each line. The file can be edited with a spreadsheet and
auser-specified water level can be givenin thisfile. Thefileisthen renamed koordina without
extension, and placed in the same directory as the unstruc file. During startup, when SSIIM 2
readsthe unstruc file, it will search for the koordina fileand if itisfound, it will automatically
use the koordina water levels asinitial values. The grid in the unstruc file must then be regen-
erated, which can be done automatically at startup by using an F 112 1 data set in the control
file. It isvery important that a new unstruc file is not written from the program after this pro-
cedure, as the information about theinitially dried up areas may then be lost.

The control file must contain the same information about the sediments as for the steady com-
putations. Also, time-varying parameters must be given in the timei file.

A couple of more advice for these type of computations. Use the following data setsin the
control file: F 64 11 or F 64 13 to get agood vertical grid distribution, F 94 with parameters
adapted to your case, F 201 1 to get smoother sides, F 113 7 to avoid unphysical velocitiesin
partially dry cells. Also, it is advisable to use the multi-grid algorithm to improve conver-
gence. Thisis specified on the F 168 and K 5 data sets. If the program crashes, look at advice
in Chapter 2.12. Chapter 2.11 gives more details about lateral grid movements.
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3. Post-processing

The most convenient way to see the resultsisin the SSIIM graphics. The grid can beseenina
plan view (Map graphics), longitudinal profile or cross-section. Also, different variables can
be chosen from the menu, for example velocity vectors, water depth etc. SSIIM will also write
afile caled result, which can be read back to the program. Using SSIIM without a user inter-
face, the result file can be moved to a Windows computer and read by a SSIIM version that
has a user interface. For sediment computations, SSIIM can produce afile called bedres,
which contains the bed levels. Thisfile can be read back by the program in asimilar way as
the result file. For time-dependent computations, a series of result and/or bedres files can be
written. The increment for when these times should be written is given on the P 10 data set.

More advanced post-processing packages are also supported: Tecplot and ParaView. The two
programs can show 2D or 3D views of the grid and the variables. They can aso be used for
making animations. Input files for these two programs can be written from the user interface
of the program or automatically for time-dependent computations. Use the F 48 data set to
specify the type of file to be written.

The ParaView program is freeware, and can be downloaded from the Internet. It is very easy
toinstall, and can do everything Tecplot can do.

2.3 Tutoria 1. Channel contraction (SSIIM 1)

Thistutorial is meant for first time users of the SSIIM program. The tutorial shows the main
features of the user interface, with the presentation graphics, animation and grid editing. The
user is not required to edit files, but some knowledge of gridsis recommended. It isimportant
to know the purpose of the control and koordina input files. During the tutorial the fileswill be
made interactively. The tutorial does not show the more advanced features of the program,
which necessitates editing of the input files.

The tutorial isdivided in four stages. During the first stage the two input files are made. Dur-
ing the second stage the presentation graphics is shown. The third stage familiarizes the user
with the grid editor. The animation graphicsis shown in the fourth stage.

First stage

In this stage the two user input files control and koordina are made.

Start SSIIM from adirectory where the files control and koordina do not exist. Thisis done by
writing c:\path\ssiimwin <CR> when you are on this directory. The "path" is the path to
where the executable program ssiimwin.exe is placed.

After this adialog box shows up on the screen, where you have to give some parameters for

the grid. Default values are present in the edit fields. Click on the edit field for number of
cross-sections. Change this value from 4 to 13. Also change the number of linesin
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cross-streamwise (lateral) direction from 4 to 9. Theinitial default grid is made is rectangular.
You can choose a grid which is 11 meters long and 6 meters wide. Change value in the edit
fields from 10.0 to 11.0 for the length and from 5.0 to 6.0 for the width. After this, push the
OK button with the mouse. The control and koordina files are then automatically made, and
written to the disk. Immediately afterwards the normal user interface for the program is shown
and the program is started.

Second stage
In this stage we will solve the flow field for the given grid, and look at the results.

The main user interface is awindow with amenu. The text in the window will show interme-
diate results from the calculations and other messages. The menu is used for graphics and
starting different sub-modules of the SSIIM program.

In the first dialog box to make the control file, you gave the waterlevel and dimension of the
geometry. A default water discharge of 1 m3/sis used, together with a Strickler-Manning’s
equation of 50. Thisis all we need to calculate the flow field with the Navier-Stokes equa-
tions. To start the solution of the Navier- Stokes equations you select the option Calculation
from the main menu. Then select Waterflow-3D from the pull-down menu. After this, push the
F 10 to see how the residuals develop. The window showsthe residual for al the six partial
differential equations that are solved for the water flow calculation. The water flow calcula-
tion is converged when all the residuals are under 1073,

After convergence, we want to see the results. Choose the View option of the main menu, and
the Map option in the pull-down menu. This gives you a graphics view of the grid as seen
from above. Choose Variable from the menu, and Ve ocity from the pull-down menu. Then
you see the velocity vectors. You can scale and move the plot by using the <Page up>, <Page
down> and arrow keys. You can also scale the velocity vectors by choosing Scale and VarEn-
large/Var Shrink. And you can see the other parameters than the vel ocity by choosing different
variables in the Graph pull-down menu.

The velocity vectors are not too exciting for this channel and to make a more complex flow
pattern, you need to change the grid. Thisis donein the third stage.

Third stage

In this stage we will concentrate about the grid editor. Start the grid editor by choosing View
from the main menu bar and GridEditor from the pull-down menu. Scale and move the win-
dow and the grid. To edit the grid, you first choose some points which will not be affected by
the interpolation routines. Thisis donein a specia mode of the editor. This mode isinvoked
by choosing Define from the menu and NoMovePoints mode from the pull-down menu. To
verify that this mode is chosen, the letters "Point mode, 0" is shown on the lower part of the
window. The integer shows how many points you have chosen. We want to choose four
points, all on the upper boundary of the grid. A point is chosen by clicking with the mouse on
agrid intersection. If successful, a blue box emerges at the grid intersection. For a further
explanation on which points to choose, see Fig. 6.2 A. After choosing the points we return to
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normal mode. Thisis done by choosing Define and Set NoMovePoint again. We observe that
this mode disappears because the text "Point mode, 4" disappears.

* * * *

Figure 5.2. The grid seen from above dur-
ing four stages of the generation, from A
toD.

A

I

Ml

Now we want to move the points. You can move any of the grid intersections by clicking on
the intersection with the mouse and dragging it to another place and then release the mouse
button. Try thiswith one of the intersections between the marked points. In the following the
four marked points are denoted 1,2,3 and 4, starting from left. Move point 2 and 3 down mid-
way into the channel. The grid should look like Fig. 6.2 B afterwards. Then choose Generate
from the menu and Boundary from the pull-down menu. This makes straight lines at the
boundary. The grid will look like Fig. 6.2 C. Now you see why we had to make the "NoMove-
Points". Then choose Generate from the menu and Elliptic from the pull-down menu. Do this
acouple of timesuntil the grid looks ok. Now you have generated an elliptic grid, which looks
something like Fig. 6.2 D.

To apply the changes from the grid editor, choose Generate from the menu and Implement
from the pull-down menu. Then view the residuals again, by choosing View->Text. Start the
water flow calculation by choosing Calculation from the main menu and Waterflow-3D from
the pull-down menu. Push F 10 repeatedly, and watch the residuals as the solution converges.
Then watch the velocity vector field by choosing View->Map from the menu.

Fourth stage
In this stage we look at the animation. Thisis done by using the OpenGL 3D Viewing pro-
gramme. Exit SSIIM and start the program. The file is called si3dview.exe. It must be started

from the same directory as we used previousdly.

After the program has started, choose File->Read result. The calculated velocity field isread.
The grid seen from above is shown. Start the animation by choosing Particle in the menu and
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Run on the pull-down menu. Change the speed of the particles by changing the timestep. This
Is done by choosing Define-> Reduce time step or Define->1ncrease time step.

2.4 Tutoria 2. Sand trap (SSIIM 1)

In thistutorial we will make a sand trap geometry, with a three-dimensional entrance region.
Three-dimensional water flow will be ssmulated in the geometry and also sediment flow
through the sand trap. The trap efficiency will be cal culated from output of the boogiefile. Itis
then necessary for the user to use an editor to see the content of thisfile, or ahard-copy can be
printed. Otherwise, editing of the koordina and control files are not necessary.

Cases similar to this has been documented with comparisons with physical model tests by
Olsen and Skoglund (1994) and Olsen and Chandrashekhar (1995).

Note that the number of grid cellsfor this case isvery small because we want the solution to
convergerapidly. For areal case simulation this grid istoo coarse, and many more cells should
be used.

First stage - generation of grid

Start the SSIIM model from an empty directory with no control or koordina files - similarly to
Tutorial 1. Inthefist dialog box use a channel length of 20 meters and a channel width of 2
meters. The water level/depth is set to 2 meters, and we use 21 cross-sections, 5 pointsin each
cross-section (lateral direction).

Then activate the GridEditor under the View choice in the main menu. Scale and move the
grid until you see the grid in the center of the window. Then four NoMovePoints have to be
inserted. These are given in the NoMovePoint mode, which is activated by choosing Set
NoMovePoint mode in the Define menu. Then use the mouse and click on the following four
grid line intersections:

31
6,1
35
6,5

These points are shown in the figure below. .
(3,5) (6,5)

(3,1) (6,1)

If you click on the wrong place, use the Delete NoMovePoint option in the Define menu to
remove the last point. After all four points have been given, set the mode back to normal by
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choosing Set NoMovePoint mode in the Define menu again

Now we want to make the inlet channel and entrance region. To do this, we need to move four
points. These are the upstream corners and the two most upstream NoMovePoints. We use the
Give coordinates in the Define menu option for this. When this menu choice is activated, a
dialog box emerges. First, we change the coordinates of the grid intersection (1,1) to
(0.0,0.5,1.0). Thisis done by clicking with the mouse on the grid intersection (1,1), and then
choosing the Give coordinates option from the Define menu option. Give 0.0 in the x-coordi-
nate edit field, 0.5 in the y-coordinate edit field and 1.0 in the z-coordinate edit field. Note that
default values are given, so that the previous values have to be deleted from the edit field
before inserting new numbers (if the defaults are not correct).

Do the same thing again, but change the line intersection (1,5) to (0.0,1.5,1.0), the line inter-
section (3,1) to (2.0,0.5,1.0) and the line intersection (3,5) to (2.0, 1.5,1.0). The two last inter-
sections correspond to the NoMovePoints.

Afterwards, first choose Boundary in the Generate menu. Then choose Transfinitel in the
Generate menu. This makes the two-dimensional grid. Then choose Implementation in the
Generate menu option to generate a new three-dimensional grid.

Second stage - calculation of water flow

Go back to the main menu and look at a plan view of the grid, by choosing Map graphics from
the View menu option. Then start the water flow calculations by choosing the Water flow-3D
option in the Cal culate menu. View the residuals by choosing Text from the View option in the
menu. Push F 10 to see the residuals while the program is cal culating the flow field. It will
take about 100 iterationsto converge. Look at the resulting velocity field by the vector map or
the longitudinal profile (Map or Profilein the View menu). Observe that the velocity vector
field is non-symmetric at the bed.

Third stage - calculation of sediment flow

We need to give input data for the sediments. In the Windows version this must be done by
giving the datain the control file. Thefileis edited using an editor, for example Notepad. Start
Notepad, and read the control file from the directory you are working in. The control file con-
tains several data sets, identified with the first letter and number on each line. The G 1 data set
isaready present in thefile. It contains four integers, where the threefirst isthe grid size. The
fourth isthe number of sediment sizes. The default is one. Change thisto 2. Then the sediment
characteristics should be given on the S data sets. These are not present initially, so you need
to add these. Add the following lines:

S10.0004 0.05
S20.0001 0.007

Thefirst index on the Sdata set is the number of the sediment fraction. The second is the

diameter in meters and the third is the fall velocity in m/s. We use 0.4 mm for size 1 and 0.1
mm for size 2. Asfall velocity, we choose 0.05 m/sfor size 1 and 0.007 m/sfor size 2.
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It isalso necessary to specify the sediment inflow. We choose to give 1 kg/s inflow for both
sizes. Theinflow is given on the | data sets as follows:

1110
1210

Savethefile, and restart SSIIM. Then first compute the water velocity again, and then choose
Sediment from the Computations menu in the main window. The sediment concentration is
calculated. The sediment concentration results can be seen in the graphics by choosing Sedi-
ment concentration from the menu.

Fourth stage - calculation of trap efficiency

Thetrap efficiency is calculated from the fluxes, which are given in the boogiefile. Thisfileis
approximately 213 lineslong for this case. It isfound in the same directory aswe started from.
It can be sent to a printer, or edited with an editor. In the middle of thisfile, wefind the follow-

ing:
*kkk*% In mrphology kkkkkkkkk*k

Bed concentration flags: 000000

Trap efficiency after 4 iter: all valuesin kg/s

I=1: Trapped: 0.973407, Fluxes (11,12,J1,J2): 1, 0.0264776, O, 0 Resid: 0.000116
[=2: Trapped: 0.317048, Fluxes (11,12,J1,J2): 1, 0.671854, 0, O Resid: 0.011098

This means that of 1 kg/second inflow, 0.97 kg is trapped of size 1 and 0.32 kg is trapped for
size 2. The total trap efficiency for both sizesis 65 %.

Note that the residual is still about 1 % for size 2. This means that the accuracy of the estimate
for the trap efficiency can be increased by increasing the convergence criteria. Thisis done by
changing the third parameter of the F 4 data set in the control file, using an editor. A value of
0.0001 or 0.00001 instead of 0.01 gives atotal trap efficiency of 62 %.

2.5 Tutoria 3. Two-block grid (SSIIM 2)

Thistutorial is meant for first time users of the SSIIM 2 program. The tutorial showsthe main
features of the user interface, with the grid editing and the presentation graphics. The user is

not required to edit files, but some knowledge of gridsisrecommended. The tutorial does not
show the more advanced features of the program, which necessitates editing of the input files.

Thetutoria isdivided in four stages. During the first stage the grid is made. The second stage

shows how to specify inflow/outflow water discharge. Then the calculations of the velocity
flow field is made in the third stage. The presentation graphics is shown in the fourth stage.
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The main user interface is awindow with a menu. Choosing Text in the View option of the
main menu, the intermediate results from the calcul ations and other messages are shown. The
menu is also used for viewing graphics and starting different modules of the SSIIM program.

First stage - generating thegrid

Start up SSIIM from adirectory where the control and koordina files do not exist. Thisis done
by writing c:\path\ssiim2w <CR> when you are on this directory. The "path" is here the path
were the executable program ssiim2wn.exe is placed.

After the main window is shown on the screen, click on the GridEditor in the View option of
the menu. This starts the grid editor, and a white area appear in the window wherethe grid is
made. Click on Add block in the Blocks option in the menu. Then click on four points on the
screen in the clockwise direction, as shown in the figure below:

2 3
4
1
Pointsin initial block Location of the two blocks

After the rectangle is made, choose Sze in the Blocks option in the menu. Click on OK in the
dialog box that emerges. This givesthefirst grid block.

Then the second grid block is made in the same way. Place the second grid block according to
the figure above.

Afterwards, choose Connect points mode in the Blocks menu. Then push the two grid intersec-
tions according to Fig. B below. Start with clicking on one grid intersection, and push it
towards the intersection it is to connect to. The connection will then be shown with ayellow
circle. If amistake is made, choose Delete last connection, from the Blocks menu.

a

L LT

Then choose Connect points mode in the Blocks menu again, to get back to normal editing
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mode. Choose Select block in the Blocks menu, and select block no. 1. Then only thisblock is
shown. Choose Boundary on the Generate menu. Then, choose Elliptic on the Generate
menu. Again, choose Select block in the Blocks menu, and select block no. 2. Choose Bound-
ary on the Generate menu. Then, choose Elliptic on the Generate menu. Finally, choose Select
block on the Blocks menu and choose All blocks. Then the two blocks are seen, connected, like
Fig. D above.

Then choose 3D Grid on the Generate menu. This generates the 3D grid. The unstruc file can
now be written from the File option of the main SSIIM 2 menu.

Second stage - specifying inflow and outflow

Start the program and read the previously generated unstruc file. Then choose View -> Dis-
chargeEditor. The grid seen from above emerges. Choose Sde Discharge -> Choose Group
-> 1. A dialog box emerges, where the water discharge is specified in m%/s. Give avalue of
0.1 for theinflow discharge. In theright editfield for the vertical cell: to: give 11. Then choose
OK. Then click on two of the sides of the cells bordering the grid, at the left side. Once
clicked, the lines change colour. Then choose Sde Discharge -> Group no. -> 2. Inthedialog
box, click on the Inflow button. This specifies an outflow of the geometry. Give avalue of 0.1
for the discharge. In the right editfield for the vertical cell: to: give in 11. Then choose OK.
Click on two grid lines bordering the upper line of the geometry. The lines change colour,
indicating outflow.

Note that it is possible to give up to 10 groups of water inflows and outflows. But the sum of
the inflows have to be equal to the sum of the outflows.

Third stage - calculating the water flow

Choose Text from the View option in the menu. To start the solution of the Navier- Stokes
equations you select the option Compute->Waterflow from the menu. After this, push F 10 to
see how the residuals develop. The window shows the residual for al the six partial differen-
tial equations that are solved for the water flow calculation. The water flow calculation is con-
verged when all the residuals are under 10°3.

Fourth stage: viewing theresults

The results are viewed by choosing one of the optionsin the View menu of the main user inter-
face. Choose the View option of the main menu, and the Map option in the pull-down menu.
This gives you a graphics view of the grid as seen from above. Choose Variable from the
menu in the map window, and Velocity vectors from the pull-down menu. Then you see the
velocity vectors. You can scale and move the plot by using the <Page up>, <Page down> and
arrow keys. You can aso scale the velocity vectors by choosing Scale and VarEnlarge/Var-
Shrink. And you can see the other parameters than the velocity by choosing different variables
in the Graph pull-down menu.
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2.6 Tutorial 4. Sand trap (SSIIM 2)

A simple geometry similar to asand trap is made, using only one block. The geometry is made
first, in Stage 1. The water dischargeis specified in Stage 2. The water flow is then calculated
in Stage 3. The sediment transport is calculated in Stage 4.

First stage: Specification of the geometry

The program is stated in a directory where there are no control or koordina files. The GridEdi-
tor isstarted first, and arectangular block is specified. It has 22 cross-sections and 6 longitudi-
nal lines.

Four NoMovePoints are added: (4,1) (4,6) (8,1) and (8,6). Thisis done by choosing Define-

> Set NoMovePoints, and then clicking on the grid intersections. The point will be coloured
blue. If awrong point is chosen, remove it immediately by choosing Define->Delete
NoMovePoint. Then the NoMovePoints and the corners of the geometry are given coordinates.
Thisisdone by first clicking with the mouse on the point, and then choosing Coordinatein the
Define option of the menu. The following coordinates are given in the emerging dialog box,
one set at atime.

i | X y z

1 1 0.0 10 06
1 6 00 20 06
4 1 4.0 10 06
4 6 40 20 06
8 1 80 00 00
8 6 80 30 00
23 1 230 00 00
23 6 230 30 00

From the menu then choose Generate->Boundary and Generate->Transfinitel. Then write the
unstruc file to the disk by choosing File->Write unstruc.

Second stage: Specification of water discharge

Start the DischargeEditor from the View option of the menu. Choose Sde discharge->Group
no.->1. Give 0.1 m3/s asinflow. Specify from level 1 to 11. Then scale the grid so that the
inflow part on the left side is seen clearly, and it is easy to choose individual grid lines for the
in. Then click on all the lines on the | eft side of the geometry. The colour will change if thisis
done successfully. If awrong line is chosen, remove it by choosing from the main menu: Sde
discharge->Remove last area. This may have to be done repeatedly.

Then specify the water outflow by choosing Sde discharge->Group no.->2. Give 0.1 m3/s as

inflow. Specify from level 1 to 11. Click on the inflow button to remove the mark. Then scale
the grid so that the inflow part on theright sideis seen clearly, and it is easy to choose individ-
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ual grid linesfor thein. Then click on al the lines on the right side of the geometry. The col-
our will change if thisis done successfully.

Save the unstruc file to the disk afterwards
Third stage: Calculation of the velocities

Choose Text from the View option in the menu. Then choose Computations->Waterflow. Push
the F 10 button on the keyboard to see how the residuals decrease and the solution converge.
After convergence, look at the velocities by choosing View->Map and Variable-> Vel ocity vec-
tors. This shows the velocities close to the bed. Push the F 12 button some times to view the
velocity vectors close to the water surface. If the velocities ook strange, choose Variable-
>Bed levels. A contour map of the bed levels emerge, and it is possible to see if awrong z
level has been given.

The result file with the velocities is automatically written to the disk after convergence.
Fourth stage: Calculation of sediment flow and bed changes

SSIIM 2 was originally made for modelling lakes and reservoirs. For stratified flows, it is
important that the grid lines in the longitudinal and lateral directions are completely horizon-
tal. Thisisnot necessary for non-stratified flow. To modify the default parameters, the control
file has to be edited. Also, to specify an inflow of sediments, the timei file hasto be used.

Start by creating an initial control file from the menu: File->Write control.new. Thefileis
edited with the Windows WordPad. Read the file, and add the following lines of data at the
end:

F 3310.010
F371
Fo6411
S0.001 0.01
[ 0.01

The F 33 data set specifies atime step of 10.0 seconds, and 10 inner iterations for each time
step. The F 37 data set specifies the use of the transient sediment cal culation algorithms.

The F 64 data set specifies agrid algorithm creating an unstructured non-orthogonal grid, that
can change dynamically over time. The Sdata set specifies the sediment data: 1 mm sediment
diameter and 1 cm/sfall velocity.

Specify the inflow concentration by adding an M data set in the control file: M 1 1 0.0001.
This specifies an inflow concentration of 0.0001 for size 1. Thisinflow will be constant over
time. If the inflow concentration varies over time, it is necessary to use aD data set in atimel
file.

Then savethefile asatext file, control.txt. Then copy thefile to control, without an extension.
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(It isnot possible to save it without an extension in this editor)

After the files are made and placed on the working directory with the unstruc file, the SSIIM
program is started again. The unstruc file isread, and using the Grid Editor, the grid is regen-
erated with the new grid algorithm. From the menu, thisis done by the menu options Gener-
ate->3D Grid. Then the DischargeEditor have to be used to specify new locations of inflow
and outflow. The old inflow/outflow surfaces has to be removed, and the new specified. This
issimilar to what was done in the second stage. Afterwards, the unstruc file should be saved
again, and the computations started. Thisis done by the menu options Calculations->\Water -
flow. Choose the profile graphics or map graphicsto watch the deposition pattern and other
variables.

2.7 Tutorial 5. Scour in acontraction (SSIIM 1)

We will compute the erosion and deposition pattern in a flume with a contraction, initially
covered with aflat sand bed. The figure below shows the flume seen from above:

B
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The flumeis 1 meter wide and 1 meter deep. The length is 6 meters. The inflow of water isin
section A, and the outflow isin C. The flume width of the contraction in B is 0.5 meters. The
water dischargeis 1.0 m?3/s, and the sediment size on the bed is 0.5 mm.

First stage: Generation of grid.

Let usinitially generate arelatively coarse grid, 60 cellsin the longitudinal direction and 10
cellsin the lateral direction. We start the program from an empty directory and a dialog box
appears. In thiswe give the following parameters:

Length of initial channel (meters) 6
Width of initial channel (meters): 1
Water depth/level (meters): 1

Number of cross-sections: 61

Number of pointsin cross-sections: 11

Then pressthe OK button and the program starts. The length of the channel is 6 metersand the
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width is 1 meter. So isthe water depth. The number of cross-sectionsis 61, one more than the
number of cells. Similarly, the number of pointsin across-section is 11, one more than the
number of cellswe chose. The cells then become 10x10 cm, which makesit easier to generate
the contraction.

We can look at the grid by choosing the menu option View->Map.
The geometry of the contraction is defined by the four points 1-4 in the figure below. To gen-

erate the contraction, we need to use the Grid Editor. Thisis started by choosing View->Grid-
Editor in the menu.

The points 1-4 have to be defined in the grid editor, and straight lines need to be generated
between them. Thisis done by first defining the four points as NoMovePoints. To do this, first
choose Define->NoMove Points Mode in the menu. Then click with the mouse on the grid
intersection close to point 1. Since point 1 is 2 meters from the entrance and the grid cells are
10 cm long, the point islocated on the 21st cross-section. When you click on the correct point,
the numbers 21,1 are shown in pink on the lower left corner of the window. If you clicked on
the wrong point, then go to the menu and choose Define->Delete last NoMove Point. And try
again. Then define point 2, located at 26,1, five cells downstream of point 1. Point 3 islocated
10 cells downstream of point 2, and point 4 islocated 5 cells downstream of point 3. The grid
intersections for the points are;

Point 1: 21,1
Point 2: 26,1
Point 3: 36,1
Point 4: 41,1

When thisis done, choose the menu option Define->NoMove Points Mode again, and it will
be possible to click on the grid without generating new NoMove Points.

Then the exact coordinates for these four points must be given. Point 1 and 4 are aready
located at the correct position. But Point 2 and 3 needs to be moved towards the center of the
channel. Thisis done by first clicking one of the points, for example Point 2. Then choose
Define->Give coordinates. A dialog box appears. Then give the coordinates. x=2.5, y=0.5,
z=0.0. Then click OK. The point is moved to the center of the channel. Then do the same with
Point 3. The coordinates of this point is x=3.5, y=0.5, z=0.0. Then choose from the menu:
Generate->Boundary and Generate->Transfinite |. Then choose Generate-> 1 mplementation.
The last choice causes the koordina file to be written, with the generated geometry, together
with a control file. It also initializes the water velocity in the geometry.
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To compute the velocity field, choose the menu option Calculation->Waterflow-3D. The com-
putation may not converge, as it may be necessary to modify the control filefirst.

Second stage: preparethe control file
Edit the control file with for example the Windows notepad. Theinitial control file only has
seven data sets. You may type atitle on thefirst T data set in thefile, but do not use capital let-

ters.

The first thing to change is the vertical grid resolution. Initially, there are only 3 cellsin the
vertical direction. We increase thisto 10. Thisis done by changing the G 3 data set to:

G 30.0 1020 304050 60 70 80 90 100

And changing the third integer in the G 1 data set from 4 to 11.

We givein an F 4 data set, with the parameters:

F 4 0.8 20 0.00001

The second number in the data set, the integer, is the number of inner iterationsin the sedi-
ment c_omputati on. The default is 500, which is too high when we only want to use one sedi-
ment size.

The F data sets are inserted between the T data set and the G 1 data set in thefile.

We want to do a time-dependent computation, and thus need to add atime step. Thisis done
by inserting an F 33 data set:

F331.020
The time step is 1.0 seconds, with 20 inner iterations for each time step.

To specify that we want to do a time-dependent sediment computation, weinsert F 37 1 in the
file.

To increase the convergence speed of the water flow computation, we use block-correction
algorithms. Insertthe K 511111 1 dataset closeto the end of the control file.

To start up the sediment computation right after we start the program, we insert
F2IS run choice
into thefile. The F 2 data set reads 10 characters. Theletters I Stells the program to initiate the

sediment computation and start the sediment calculation. Then eight more characters are read.
It istherefore necessary to have some spaces or lowercase |etters after the IS, Otherwise, the
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program will start to read the characters on the line below.

Then the sediment data are given onthe S I, N and B data sets. These data sets have to be
given after the G data setsin thefile. The sediment diameter and fall velocity isgivenonthe S
data set:

S10.002 0.01

We have here specified a diameter of 2 mm and afall velocity of 1 cm/s.

110.0

We have specified a zero inflow of sediments

NO011.0

Sieve curve 0 has 1.0 or 100 % of size 1.

BO0OOOOO

The whole bed is covered with sieve curve 0.

Save the control file.

Third stage: run the program

Start the program, and the sediment computation will start immediately dueto the F 2 data set.

Look at the results by choosing from the menu View->Map. Choose from the menu for exam-
ple Variable ->Bed changes.

The program will run for 40 000 time steps, which isthefirst integer on the K 1 data set. This
may take some time, so you may want to stop the computation and give alower value before
restarting it.

Fourth stage: parameter tests

The sediment transport computation is based on a number of empirical formulas. Some of the
parameters in the formulas can be fairly uncertain. It is therefore important to do a parameter
sengitivity test. Also, there are different numerical algorithmsin the program, which will
affect the results. These should also be included in the parameter test. The size of the grid
should also be varied.

The following parameters can be tested:

Sediment formulas:
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Use Shieldscurvefor critical shear stressinstead of agiven Shields parameter (default 0.047):
F 11 data set.

Use bed load or suspended load formulas, or both: F 84 data set
Change the parametersin van Rijn’sformulas: F 6 or F 83 data sets
Thickness of active sediment layer: F 106 data set

Include bed form effects: F 90 data set

Decrease critical shear stress on sloping beds: F 7 B data set

Water flow formulas:

Manning-Stricklers friction coefficient: W 1 data set, or the F 16 data set.

Numerical agorithms:

Time step and number of inner iterations: F 33 data set.

First order or second order upwind scheme: K 6 dataset: K61 1 1 0 0 0 recommended for sec-
ond-order upwind scheme.

Grid size: For the current tutorial, regenerate the grid with larger number of cells. Thiswill not
take much time for the current simple geometry. However, for more complex geometries, it is
possible to usethe F 7 DJ options.

2.8 Tutoria 6: Flow in abend with SSIIM 2

We will compute the water flow in a bend using
SSIIM 2. The grid of the bend is made using a
spreadsheet. The approach isto compute the coordi-
nates of the sides of the bend using the spreadsheet,
and to give these coordinatesin akoosurf file. Also,
the points on the sides are fixed defining them as
NoMovePoints.

First, we decide for the dimensions of the channel
and the grid size. We want to compute a 90 degree Figure 2.8.1 Grid
bend, with 21 grid linesin the streamwise direction
and 15 grid linesin the cross-section. The inner
radius of the bend is 3 meter and the outer radiusis
4 meters, giving a channel width of 1 meter.
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Sep 1. Making the koosurf file.

With 21 grid lines over 90 degrees, each cell will have a sector of 90/ 20 = 4.5 degrees. The x
coordinates of the grid line on the inner bank can then be computed by the following formula:

X = 3sin(a) (2.8.1)

y = 3cos(a) (2.8.2)
These formulas are then coded in the spreadsheet, where angle for each grid lineis also given.
The formulafor the angle will start with zero for the first point, and then it will be the 4.5

degrees plus the value in the cell above.

The table below shows how the spreadsheet would be. The numbers are given for the first 6
points and the last point, i=21. Eq. 2.8.1 and Eq. 2.8.2 are used to compute the x and y values.

Table 1. Spreadsheet for computing the valuesin the koosurf file

[ | X y z, bed z, surface angle,
1 1 0 3 0 1 0

2 1 0.2353 2.9907 0 1 0.078537
3 1 0.4692 2.9630 0 1 0.157075
4 1 0.7003 29171 0 1 0.235612
5 1 0.9270 2.8531 0 1 0.314150
6 1 1.1480 2.7716 0 1 0.392687

1 0 1

21 1 3 0 0 1 1.57075

The spreadsheet also needs to compute the similar coordinates for the outside bank of the
channel. Thiswill be the same asfor the inside bank, except the radius will be 4 instead of 3in
Egs. 2.8.1 and 2.8.2. And thej values will be 15 instead of 1.

After the spreadsheet is made, the content must be written to afile called “ koosurf” . This can
be done in many ways, but one way isto open the Notepad program in Windows. Mark the
areas from the spreadsheet and copy it into the Notepad. Only thei,j,X,Y,zyeq 8Nd Zgrface MUt
be copied, not the angle. Also, there must be one set of coordinates on each line, with no blank
lines in between. Make sure there are six numbers on each line, otherwise there will be some
problems | ater.

In Notepad, the file can be saved as koosurf. However, Notepad will add an extension .txt to
the file name. This must be removed.
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Sep 2. Making the control file

The next thing to do isto make SSIIM 2 see these points as fixed points. Thisis done by mak-
ing several W 6 data setsin the control file. Thisisalso most easily donein a spreadsheet. The
following text must be made and inserted into the control file. Note that the control file also
must be without extension. And at the present stage, it does not need to contain any other
information than the W 6 data sets. The file will then look like the following:

11
21
31
41
51
61

DO OoOOOO

211
115
215
315
415
515
615

T2z 2222

DO OO O

é :

6 2115

The points between i index 7 and 20 are not given above, but they have to be in the control
file. The control file will then have 42 W 6 data sets.

Sep 3. Making thegrid

Make a directory with the SSIIM 2 program and the control and koosurf file made earlier.
Then start the SSIIM 2 program. From the main menu, choose View and Grid Editor. Then
choose the menu option Blocks and Add block from koosurf. This may cause some grid lines
and blue rectangles to appear in the window. Or not, it may be necessary to do some scaling
with the Page Down button on the keyboard. The grid lineswill look confusing, since we only
have made the sides of the grid and not the grid interior. The rest of the grid is made by choos-
ing from the menu: Generate and boundary, and then Generate and Transfinitel. The grid then
looks like Fig. 2.8.1.

To save the grid, use the menu option Generate and 3D grid, and then File and Write unstruc
file. After this, it is possible to end the program and restart it reading back the unstruc file
from the menu.

Sep 4. Specifying inflow and outflow dischar ges

From the menu, choose View and Discharge Editor. The grid appears, seen from above. From
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the menu, choose Sde discharge, Group no. and 1. A dialog box appears. In the edit field for
Discharge, give in the number 1, for 1 m3s. Click on the OK button. Then from the menu,
choose Sde discharge and Add area series 100. Then scale and enlarge the grid in the Dis-
charge Editor so that it looks like the figure below. The click on the grid line pointed to with
the red arrow.

—

Figure 2.8.2
Dishcarge editor

Add mode, 0
Surf: 0 Group:1No: O

Thiswill cause the whole inflow cross-section to be coloured blue. Note that we have clicked
on the inflow side of the left bank cell. We repeat the same procedure for the outflow cross-
section. Only now we choose the Discharge Group 2 as outflow. In the dialog box, we cross
off “inflow”, meaning this will be outflow. And when we specify the outflow cross-section
graphically, we have to use the right bank cell. Instead of the left bank cell that we used for the
inflow.

If you do a mistake and only some of the cells have inflow or outflow, then go to the menu
Sde Discharge and choose Remove all areas. Then al areas in the group you are working
with are removed. The areas in the other groups will not be affected.

After the discharge is specified, save the unstruc file from the menu: File and Write unstruc.
The information about the discharges are in the unstruc file.

Sep 5. Computing the water velocities

From the menu, choose View and Map. If you see the grid, then everything is ok and you can
proceed. If you have just started the program and the grid is not made or generated, you need
to go to the menu and choose File and Read unstruc.

From the menu, choose View and Text. Then choose Compute and Water flow. Then push the F

10 button on the keyboard repeatedly. The window shows how the residuals decrease. When
they are below 0.001, the program will converge. The water velocities have then been com-
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puted.
Sep 6. Looking at the results

From the main menu, choose View and Map. Then choose Variable and Surface+ bed vectors.
Scalethe vectors with the F7 and F8 keys on the keyboard until they are of appropriate length.
Also, you can scale or move the view with the arrow keys and the keyboard keys PgUp and
PgDn. See how the secondary currents cause a deviation between the bed and surface velocity
vectors at the end of the canal.

Then from the main menu choose Sediment variable and Secondary current angle. This shows
the angle in degrees between the surface and bed vectors.

2.9 Tutorial 7. Natural river using SSIIM 2

We will compute the flow in anatura river using SSIIM 2. SSIIM 2 includes wetting and dry-
ing, and it is convenient to use this algorithm to get a grid that follows the bank of theriver as
the water level rises and sinks. This tutorial will only work directly with SSIIM 2 versions
made after 12. December 2013. Earlier versions need to start with a control file that has the F
64 11 data set.

Sep 1. Making thegrid

The geometry of a natura river is most often fairly complex. The most used way to describe
the geometry is by measuring alarge number of coordinates (x,y,z values) of pointsat the river
bed. SSIIM use these pointsin afile called geodata. Each point isgiven on onelinein thefile,
with the three floating point numbers, x,y and z. There has to be a capital E at the start of each
line, before the numbers, and the numbers must be separated by one or more spaces.

In the present tutorial, we will use ageodata file made up from avirtual case. Thefile can be
downloaded from the web page: http://folk.ntnu.no/nilsol/cases/tutorial_river/geodata.

Make a new directory on your PC, download this geodata file to the directory and also down-
load SSIIM 2 with the DLL’sto the same directory. Then start the program. In the main menu,
go to View and Grid Editor. Then go to View and geodata points. The measured points now
emerge in the window as seenin Fig. 2.9.1.

The colours of the geodata points shows the water depth. Red is high water depths and blueis
low water depths. Green isin between blue and red. Fig. 2.9.1 shows that the river isflowing
in a bend. We now assume the flow direction isfrom the top of the figure to the right in the
figure.

Thefirst thing we need to do isto make agrid block covering the river. Thisis done from the
menu, by choosing Blocks and Add block. Then you click on the four corners of a structured
grid.
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Thefirst point should be on the right bank of the upstream cross-section. The second point on
the left bank of the upstream cross-section. The third point on the left bank of the downstream
cross-section and the fourth point on the right bank of the downstream cross-section. After
clicking the second, third and fourth point, green lines emerge, which shows the border of the
structured grid. Thisisshown in Fig. 2.9.2.

The next step isto fill this areawith a structured grid.
On the menu, choose Blocks and Sze block. A dialog
box emerges, with question about the grid size. Choose
71 linesin thei-direction (streamwise) and 21 linesin
the j-direction (cross-section). Then click on OK and
the grid is made as seen in the window.

The maximum number of grid
linesini andj direction is 300 x
300 by default. If you need a
larger grid, add a G 1 data set to
the control file, specifying the
size. Thereisno limit on how
large you can make the grid in
SSIIM, only apractical limit on
how long time you want to wait
for the computations to finish.

This grid has straight sides and does not follow the
river. To make the sides more curved, it is possible to
click on agrid intersection at the sides of the grid and
drag it towards the correct location. However, if the
grid islarge, thiswill be atime-consuming process.
Instead, we select some points called NoMovePoints,
which we will drag to the sides. Then straight lines will be made between these points.

From the menu, choose Define and Set NoMovePoints mode. Then click with the mouse on
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some of the grid line intersections on the |eft side of the grid (right bank). Each timeaclick is
made, a NoMovePoint is made. These are indicated with blue squares. Make 6-7 NoMove-
Points on the |eft side of the grid. Then choose on the menu Define and Set NoMovePoints
mode again. Thisallowsyou to click on the grid and move grid intersections without creating
more NoMovePoints.
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The next step is to move the NoMovePoints to the boundary of theriver, given by the geodata
points. Thisis done by clicking on a NoMovePoint and dragging it outwards to the blue geo-
data points. Figure 2.9.3 shows this, where one NoMovePoint has been dragged.

Next, repeat the dragging of the other NoMovePoints to the bank of the river. Then from the
menu, choose Generate and Boundary. And then choose Generate and Transfinitel. Thegridis
then moves along the outer bank of the river. Repeat the same procedure with the NoMove-
Points on theinner side of the curve. Note that it may be an advantage to scalethe figurein the
window with the PgUp / PgDn buttons on the keyboard, and also use the arrow keys. If you
make a mistake, and for example put a NoMovePoint in the interior of the grid, this can be
removed with the menu option Define and Delete NoMovePoint. Then the last NoMovePoint
is deleted.

From the menu, choose Generate and Boundary, and then Generate and Transfinitel. You can
also move individual NoMovePoints and repeat the boundary and transfinite grid generation,
until you are happy with the grid. At the end, you can choose Generate and Elliptic. This usu-
ally givesthe best grid. Figure 2.9.4 shows an example of how the grid can look like.
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The grid can then be saved to the unstruc file. Thisis done by the menu options Generate and

3D grid, and then File and Write unstruc file.

Hit 36 1

30.0m

The procedure so far has given the horizontal lay-
out of the grid. The vertical extension of the grid
also need to be decided. Thisis done by using the
geodata points to determine the bed level of the
grid by interpolation. The menu option is Generate
and bed levels. After this, use the menu again with
Generate and 3D Grid. The grid should then be
saved to the unstruc file again.

The grid we have made may not be optimal. If we
end the SSIIM 2 program and restart it, and then
read the unstruc file, we can see how it looks by
choosing on the menu: View and Map. Choose on
the menu Variable and bed level. Then on the menu
choose View and Legend. Then the geometry may

A common mistake by SSIIM nov-
icesisto make theinitia grid too
fine. Then the computational timeis
long and it takes considerable time
before the mistakes are seen and the
program is learned. It is better to
start with a coarse grid. And then
make anew and finer grid once the
program is learned and all other
probles are sorted out. Usually, it
does not take too long time to make
agrid, and the second grid you make
isusually better than the first.

look like what is shown in Fig. 2.9.5. There may be holes or hills where the bed interpolation
algorithm has not done agood job. Then it is possible to go back to the Grid Editor and givein
the vertical level on individual grid intersections. Click on the grid intersection and from the
menu choose Define and Give coordinates. Then give a better z value in the dialog box.
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Repeat this for al problem areas and then from the menu choose Generate and 3D Grid, and
then save the unstruc file. Do not generate new bed levels, asthe algorithm with overwrite any
manual changes to the coordinates.

Figure 2.9.4

rggegrantine’
Eauyg i iaicut
iy L'jll;l'l'l

30.0m

Note that it is also possible to improve the grid by adding or removing geodata pointsin the
Grid Editor.

Sep 2. Specifying a water discharge

The water discharge can be specified using the Discharge Editor, as described in the earlier
tutorials. However, for ariver where there is only one block and the water is flowing into one
of the four sides and out of the opposite side, like we have in the current case, there is another
option. Thisisto specify the following data sets in the control file:

F31411

F237115

F237215

The F 337 data sets specify the water dischargein m?3/s, while the F 314 data set sets the grid
ends to inflow and outflow.

If we open SSIIM 2 again, read the unstruc file and look in the Discharge Editor, we can see
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the coloured lines from the inflow and outflow. If we look in the dialog box, we see that the
water dischargeis the same as specified in the control file.

Figure 2.9.5. Bed levels

Legend
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— 0.400000
— 0.100000

30.0 m

Bed levels, min= 0,100 m, max= 1.900 m

Sep 3. Computing the water flow

Start up SSIIM 2, read the unstruc file and from the menu choose Compute and Water flow
Push the F10 button on the keyboard and watch the residuals decrease. When they are under
0.001, the solution is converged.

On the menu, choose View and Map, and then Variable and Vel ocity vectors. Scale the vectors
with the F7 or F8 button on the keyboard until they look clear.

Sep 4. Making an initial water surface

The top of the grid made in Step 1 is horizontal and at the level of the highest geodata point.
Thisis at 2 meters with the current data. Often the geometrical points measured in the river
include the overbanks. This makes sense when modelling a flood. However, if we want to
model alower water discharge, we also want alower water level. The easiest way to lower the
water level is by specifying surface pointsin the geometry. Thisis done by first reading the
unstruc file, and then go to the Grid Editor. Then from the menu choose Define and Set sur-
facepoint. A dialog box emerges, asking for the level of the surface point. Normally, we

40



choose three surface points, all outside the geometry of the grid. The three points will form a
triangle with a defined surface. Thiswill be the new surface.

Scale the grid down with the PgDn button on the keyboard and move it to the center of the
window. Then click with the mouse outside the grid. Go back to the menu and repeat the pro-
cedure two moretimes. The three emerged surface pointswill form atriangle. The grid should
beinside thetriangle, asgivenin Fig. 2.9.6.

1.0000 m
1.0000 m
Figure 2.9.6. Surface
points around the grid.
Surface points mode: 3 points 1.0000 m

80.0m

Then go to the menu option Generate and Surface, and then Generate and 3D Grid. Then
write the unstruc file. Also, you can look at the Map in the View menu, and choose Water level
or Depth from the Variable menu option. You can see that the water surface elevation has been
reduced to 1 meter. You can now recompute the water velocities with this water level.

Note that you may choose a different level on each of the three surface points. Then asloping
water level is given.

Looking at the grid, the edges following the banks may not look too smooth. To improve the
river bank cells, the control file needsto be used. Open the file with an editor and add the data
setsF 102 1. Save thefile, restart SSIIM 2, go to the Grid Editor and choose from the menu
Generate and 3D Grid. Go back to the Map view and see how the edges are smoother, similar
to Fig. 2.9.7. Then save the unstruc file.
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I Figure 2.9.7. Grid after

7 lowering the water level
and drying taking place.
Generated with the F 102
data set in the control file.

P |

30.0 m
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When you want to compute the water flow for this grid, the solution may not converge. Thisis
because some of the grid cellswill have avery low height to length ratio, or the area between
the cellsisvery small. There are severa methods to improve convergence. Thisis further
described in Chapter 3.2. The methods involve using stabilizing procedures by adding data
setsto the control file. The first thing to do isto lower the relaxation coefficients by adding a
K 3 data set. If that doesn’t work one or more of the following additional data sets may be
used:

F940.020.1 minimum cell corner heights

F 1688 multi-block solver

F15919010 disconnecting cellsin shallow areas
F23510 triangular cell damping

F2920.1 innertimestep

K 30.30.30.30.050.20.2 lowered relaxation coefficients
K50001000 multi-block sover

The F 94 and F 159 data sets give parameters for generating the grid. This means the grid

needs to be regenerated after this data set is given in the control file. The regeneration is done
in the Grid Editor. Remember to save the unstruc file afterwards.
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Sep 5. Computing the water level more accurately

Although the chosen flat level of the water may correspond reasonably well to the real world,
it may sometimes be necessary to make a more accurate model. There are several algorithms
in SSIIM 2 for computing the water level. The most relevant ones for river modelling are
based on approximately subcritical flow, where the downstream water level is specified. The
user then has to specify a cell with agiven water level, which is unaffected by the water sur-
face computation. The reference cell must be specified on the G 6 data set in the control file.
The next step therefore involves which cell to choose and how to chooseit.

On the menu, choose View and Map. Then choose Variable and Cell numbers. Enlarge the
downstream part of the grid using the PgUp and the arrows buttons on the keyboard. You will
see something like what isgivenin Fig. 2.9.8.
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Figure 2.9.8

Cell numbers
for the down-
stream part of
the grid

Push the F12 button on the keyboard repeatedly, until the numbers don’t change any more.
Then choose one of the number in the cell where the outflow is. Typically in the middle of the
outflow region. For example 6440 in Fig. 2.9.8. Then give the following data set in the control
filee G66440000.010.1
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It isalso necessary to specify atime step and which algorithm isto be used for the free water
surface computation. To the control file, add

F 33 2.0100
F362

Then restart the program, read the unstruc file and start the water flow computations. In the
Map graphics, look at how the water level changes. Note that the water level will only be

updated if the residuals are fairly low. Lowering the time step or increasing the number of
innier iteratios on the F 33 data set may be necessary to reduce the residuals.

2.10 Examples

Example cases with input files can be downloaded from the WMAV, at one of the addresses:
http: //folk.ntnu.no/nilsol/ssiim

Some of thefiles are located in the package containing the OS/2 version of the program. This
can be downloaded at: http://folk.ntnu.no/nilsol/ssiimyssiimos2.zip.

Some of the examples are explained in the following:

Water quality with Streeter-Phelps model (SSITM 1)

The input files have extension .qua

The water quality in ariver is modelled with the Streeter-Phelps model. This has two water
quality constituents: Organic substance measured in Biologica Oxygen Demand (BOD) and
Oxygen Saturation Deficit (OSD). The convection-diffusion equation for each constituent is

solved, including source terms for biochemical reactions.

Start by calculating the water flow field using MB-Flow2D or MB-Flow3D. Afterwards, start
the water quality calculation. You may use the calculation menu.

The OpenGL 2D graphicsiswell suited to show the results.

This caseis used for testing the numerical model against an analytical solution.

Curved channe (SSITM 1)

Thefiles have extensions .svi. The channel is used for testing the programs ability to calculate
the secondary flow patternin a curved channel. It isaso used for testing the routine that recal-

culates the water surface location based on the 3D flow field. The cross-sectional slope corre-
sponds very well to theoretical solutions.



Fish farm tank (SSI1M 1)

Thefiles have extensions .kar. This case is used for demonstrating inflow and outflow at dif-
ferent locations in the geometry. Theinflow ison one side, at 45 degrees to the wall. The out-
flow is at the bottom of the tank. The case is also used for demonstration of fish habitat. It is
also suited for particle animation because the particle will movein acircular pattern. This case
is calculated by Olsen and Alfredsen (1994).

Reservair trap efficiency (SSIIM 1)

Thefileshave extension .res. Thiscaseisused for demonstration of trap efficiency calculation
inareservoir. It isamodified version of the Mae Tian reservoir calculation case from Thai-
land (Olsen, 1991 and Olsen and Melaaen, 1993). 8.3 cubic meters of water isflowing through
the reservoir. Several sediment sizes are used. The user can see the contour map of the bed
levels, colour map of the bed level changes, cross-section velocities and longitudinal profiles
of the sediment concentration.

Note that about 9000 iterations are necessary to make the water flow calculation converge.
Thistook about 2 hours on a Pentium Pro 200/512 k Cache, 32 MB RAM.

Flood wave hitting a building (SSIIM 1)

The files have extension .wav. This example shows aflood wave in a50 m long and 25 meter
wide channel hitting a square building with sides 5 meters. The upstream water surfaceis 3
meters above the bed, and awater velocity of 3 m/sisin the inflowing water. A transient free
surface routine is used to calculated the water surface. The speed and the depth of the wave
correspond well to hydraulic formulas. Forces on the building are written to the forcelog file.
The case was presented by Olsen (1994). A similar verification study with comparison with a
physical model testing was done by Loevoll et. a. (1995) and Lovoll (1996). The flood wave
case was also discussed by Sintic (1996).

The control file includes G 19 data sets to view the water surface with the 3D OpenGL graph-
ics. This can be done while the computation is running.

Also note that the forces on the obstacle is written as atime seriesto the forcelog file.

Scour in aflume (SSIIM 1)

The files have extension .sco. This shows the scour in aflume where an obstruction is placed.
To avoid excessive computational time for this case, avery coarse grid has been used. The
grid istoo coarse to resolve the flow field around the obstruction enough to simulate local
scour. However, scour because of channel contraction is simulated. Except for the coarse grid,
this case is similar to the local scour case presented by Olsen (1996).

The time step is chosen to be 1000 seconds. Thisis also to avoid excessive computation time

when running the example. This allows the user to observe how the bed evolution changes.
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The time step is however to long to give an accurate prediction of the evolution of the scour.

Note the grid extends relatively far downstream of the obstacle. For some cases this has shown
to be necessary to avoid unphysical results at the downstream boundary.

The development of the scour hole is best seen with the contour map graphics or the OpenGL
graphics, showing the bed level seen from above. Note some bugs in the contour map graphics
causes some lines not to be shown at all times.

Trap efficiency of alaboratory sand trap (SSIIM 1)

This caseis one of the first test cases for SSIIM, where the results were compared with meas-
urements from a physical model study. Both water velocities and sediment concentrations
were measured and compared with the findings of the numerical model. Detailed documenta-
tion of the caseis given by Olsen and Skoglund (1994). The input files can be downloaded
from the web: http://folk.ntnu.no/nilsol/cases/doris/. The web page also has adiscussion of the
details of the files and the results.
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Chapter 3. Advice for using SSIIM

3.1 Thegrid

Making the grid is often the most time-consuming process in the preparation of input data for
SSIIM. The general ideaisto divide the water body into cells. The size and alignment of the
cellswill strongly influence the accuracy of the calculation, the convergence and the computa-
tional time.

Thegrid used in SSIIM 2 is unstructured. This makes it easier to adapt the grid to complex
geometries without loss of accuracy or slow convergence. In the following there are given
some guidelines of how to make a good grid. Also, it isrecommended to read Chapter 4.4
first.

Here is some advice on how to shape the cells:

1 Make the grid line intersections as perpendicular as possible. It isnot advisable to have
intersections with an angle of less than 45 degrees. Non-orthogonality in the grid will
make the convergence slower. It is recommended to use the elliptic grid generator to
make the grid smoother.

2. Try to align the grid lines in the streamwise direction parallél to the velocity vectors.
Thiswill decrease false diffusion.

3. The distortion ratio should not be too great. The distortion ratio is the dimension of the
grid in one direction divided by the dimension in another direction. Some people say
this should be less than 2 (two), but other people have obtained good results for ratios
up to 10. On occasions, ratios of up to 100 have been used. This gave reasonable
results, but it required very low relaxation coefficients and an extremely large number
of iterationsto converge.

4. The size of agrid cell should not be too much larger than its neighbours. Some people
say the increase in size should not be greater than 20 %. On some occasions this value
have been over 1000 % (afactor 10). Some of these cases gave reasonable results, but
other cases gave unphysical results. A recommendation isto try to stay within 50 %,
but if much larger values are used, be aware that unphysical results may occur.
Unphysical results can be velocity vectors that point in another direction than what
seems natural, for example not paralel to walls.

Chapter 3.2 give more advice on convergence and interpretation of the results.
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3.2 Experience with convergence and stability

There are three ways SSIIM can crash:

1 The program stops calculation and there is an error message in the program window.

2. The program stops and exits, the menu and the dialog box disappear.

3 The program stops with a system error, usually floating point invalid operation, over-
flow or underflow error.

Often an error message is written to the boogie file before the crash occur. This happens par-
ticularly for type 1 and 2 of thislist above. If an error in the input files are detected, an error
message is written to the boogie file and type 2 crash occurs. If the program crashes, it is
therefore recommended to take alook at the boogiefile. If crash type 1 occurs, it is aso possi-
ble to look at the graphics to try to see where in the geometry the problem is.

Convergence

If the program does not crash, the next problem is to get a converged solution. Thisis often a
problem for many CFD cases. Some of the important factors are:

- A good grid

- Proper relaxation coefficients
- Correct boundary conditions
- A fast solver

- Stable numerical algorithms

It isaways a good thing to check the boundary conditions in case of slow convergence or
strange results. Also note that warning messages may be written to the boogiefileif particular
undesirable configurations are present. Therefore, check the boogie file if problems occur.

Experience showsthat the degree of non-orthogonality of the grid will affect the convergence.
A higher degree of non-orthogonality will give slower convergence. A slower convergence
will also be experienced where strong gradients are present. This applies for example at the
inflow of ajet from awall.

The convergence speed is strongly influenced by the choice of the solver. For most cases,
using block-correction (K 5 in the control file for SSIIM 1) will lead to much faster conver-
gence. A speed-up of one order of magnitude has been observed for some cases. SSIIM 1 has
reasonably good block-correction algorithms. The block-corrections in an unstructured grid
like for SSIIM 2 is more problematic, but a multi-grid agorithm isimplemented for usein
shallow flows (F 168 and K 500 0 10 0 0 in the control file).

For most cases|ower relaxation coefficientswill give lessinstabilities during the convergence,
but a slower convergence. Higher relaxation coefficients will give more rapid convergence if
there are no instabilities. Thisis however not always the case. Instabilities can be observed

during theiterationswhen the residual or the vel ocitiesincrease and decrease periodically. But
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for most cases of instability problem it isrecommended to lower the values on the K 3 data set
in the control file. The default valuesare 0.8 0.8 0.8 0.2 0.5 0.5. Thefirst lowering may be to
K30.40.40.40.10.20.2. If theinstabilities are still there, it ispossibleto try K 30.20.20.2
0.050.1 0.1, for example.

For afew rare cases with SSIIM 1 and steady computations, where the equation for k is slow-
est in convergence, amore rapid convergence has been achieved when changing the relaxation
coefficient for k from 0.5 to 1.0 after several iterations. However, for most cases this proce-
dure will not work.

For the convergence of the k and epsilon equations for river problems, the size of the cell clos-
est to the bed isimportant. In SSIIM 1, this can be changed by changing the second number in
the G 3 data set in the control file. This parameter also depends on the roughness of the bed.
The height of the bed cell should not bee too much smaller than the roughness of the bed. The
following formulais used to determine the roughness of the bed, given the Stricklersfriction
coefficient M (van Rijn, 1982):

26

6
d90

If the solution blows up after the first few iterations, it is possible to set the relaxation coeffi-
cients very low, and then increase the coefficients for the following iterations.

For some cases there have been problems getting the solution to converge if there are parts of

the geometry that hasrelatively low total velocity. Experience has shown that theinitial condi-
tions then may be important. If such asituation is present it isimportant to start the iterations

with very low initial velocities. Thisis done with the G 8 data sets.

An advantage with SSIIM compared with other CFD programsis that the graphicsis con-
nected directly with the computational module. This enables the user to see the results while
the program is doing the computations. If problems occur, it is recommended that the user
look at the graphicsto try to identify these. Thiswould be similar to a physical model study,
where the engineer will watch what happens during the run. Looking at velocity vectors, pres-
sure fields, bed level changes and the location of the water surface gives an idea about reasons
for crashes.

For convergence problems, SSIIM 2 has an option of showing plan view of the residualsin
2D. Thismakesit easier to identify areas of high residuals.

Transient calculations

If during steady calculations there are oscillations in the velocities, this may be asign that the
flow field has atransient character. One may then invoke the transient calculation and a peri-
odical transient solution may be observed. However, another possibility isthat the oscillations
disappear after adding transient terms. The transient terms can have a stabilizing effect on the
solution for some cases.
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Note that a steady state solution may very well emerge even though the corresponding proto-
type flow field has transient oscillations (Olsen and Melaaen, 1996). The reason for thisis
usually that the turbulence model overpredicts the eddy-viscosity, or the grid is so coarse that
false diffusion dampen out the eddies.

For very large grids (over 50 million cells) an experience with SSIIM 2 isthat atime step is
needed initially to stabilize the solution. However, after some time the decrease in the residu-
alswill bevery low. A faster convergence has then been achieved if the result fileisfirst writ-
ten and then the computations are restarted without the time step, but by first reading the result
file.

Conver gence problemswith shallow/triangular cells during wetting/drying computa-
tions

Transient computations with wetting/drying sometimes give convergence problems and
crashes at the boundary of the geometry. This situation can be identified when looking at the
Map Graphics, where large velocity vectors are observed after a crash. During computations,
the Map Graphics may show very high residulas at the side boundary. Also the velocity vec-
tors may seem to oscillate there. Thisistypically taking place in triangular cells or very shal-
low ares, often at aflow separation point on the side boundary. It is recommended to look at
the velocity vectors in the graphics when oscillations occur. Then problems may be more eas-
ily identified.

Advice for solving these kinds of problemsis to introduce stabilization algorithms by adding
data sets to the control file:

1. Lower the relaxation coefficients on the K 3 data set

2. Usethe F 235 data set. This has several algorithms for reducing the problem. OneisF 235
10, which introduces extra relaxation coefficientsin triangular cells at the boundary.

3. Introduce an inner time step with the F 292 data set in the control file. For example F 292 1
1.0, where 1.0 isthe inner time step. The inner time step should be chosen much
smaller than the time step on the F 33 data set. The inner time step will only contain
information about the flow field from the last iteration, and not from the previoustime
step. Therefore, the inner time step will act more like a relaxation factor, and dampen
changes between each inner iteration.

4. Increase the minimum depth on the F 94 data set. This is the most effective measure to
dampen the oscillations. The reason for these type of instabilities is most often an
extreme length/height ratio of the cells. If an F 94 data set is already used, then the
numbers should be increased. If the F 94 set is not used, then look in the boogiefile to
see what the default values are. Then introduce an F 94 data set with higher values.
The disadvantage of using higher values on the F 94 data set is that the most shallow
areas of the geometry will not be modelled, or modelled with only one cell in the verti-
cal direction.

5. Usethe F 159 data set to change some of the grid generation methods. For example, the sec-
ond parameter can be changed to 9, removing ridgesin the grid.
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Grid splitting

Thisinstability may occur when using afree surface algorithm in shallow areas. The water
surface changes are so large that a complete area between the inflow and outflow disappears.
The grid is then split in two, with no connection between the parts. Thisis both numerically
incorrect and an unphysical situation.

The situation will most often occur when using F 36 2 or 7. The first thing to do thenisto
lower the relaxation coefficient for the water level movements on the G 6 data set. The two
last numbers on the G 6 data set are floats, the the relaxation coefficient is thefirst of these.
The coefficient can be lowered to 0.01 from the default value of 0.1 However, the water level
will then also sink more slowly, so it should be checked if this cause a problem. If so, then the
time step hasto be lowered.

An alternative solution for the problem isto use an implicit Shallow-Water Equations solver to
compute the changes in the water levels. Thisis usually more stable than methods based on
the pressure from the Navier-Stokes equations. Then, F 36 9 is used in combination with F
323 1.

Algorithms to improve the convergence of the F 36 9 options can be given on the F 343 data
set. F 343 3 invokes a classical multigrid method, while F 343 2 invokes a block-correction
method in 1D in the streamwise direction of the geometry.

3.3 Interpretation of results

As mentioned earlier, it is advisable to have experience in computational fluid dynamicswhen
proper interpretation of the resultsis required. Some guidance is given below.

An important numerical effect that can deteriorate the resultsis false diffusion. This effect is
most noticed for first-order schemes, including the POW scheme. The effect depends on how
well the flow velocity vectors are aligned with the grid lines. For small alignment angles, the
effect is small. Maximum false diffusion will happen when the grid lines are aligned 45
degrees with the flow. The amount of false diffusion also depends on the size of the grid cells.

There are three methods to decrease the amount of false diffusion:
1. Decrease the size of the grid cells = increase the number of cells
2. Align the grid with the flow field

3. Use the Second-Order Upstream scheme

Point 2 may be difficult in a practical situation. However, the calculations should be carried
out using approach 1 and/or 3 to assess the effect of false diffusion.

Another important aspect is the boundary condition. This especially appliesto the inflowing
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boundary. If the velocity field at the inflowing boundary is not known exactly, one should try
different velocity distributionsto try to assess the effect of this parameter. For ariver running
into areservoir, it ispossible to model apart of the river upstream of the reservoir, and thereby
obtaining a better estimate for the velocity distribution where the river enters the reservoir.
The upstream boundary condition is also important for sediment cal culations, where both the
total amount of sediment inflow and the sediment grain size distribution can be varied. For the
bed boundary, it is possible to vary the roughness to investigate the effect of this parameter. It
can also sometimes be advantageous to make variations for the formulafor sediment concen-
tration close to the bed. This especially applies for sediment particles outside the range for
which the formulais applied for.

When interpreting the results from the model it is aso important to keep the accuracy of
model in mind. The k-¢ turbulence model has limitations in how accurate the turbulence field
ispredicted. Thiswill also affect the velocity field. For example, when cal culating the recircu-
lation zone for a step case, the length of the recirculation zone can often not be predicted with
any better accuracy than 10-30 %.

In some situations the water flow will be time-dependent. An example can be oscillations
behind a cylinder or in an expansion. It is possible to obtain a converged steady solution from
the model although the physical problem is unsteady (Olsen and Melaaen, 1993 and 1996).
This must be considered when interpreting the results. The effects of an unsteady solution
compared to the given solution should be assessed if thisis probable. When an unsteady case
is solved with a steady method there can be convergence problems. If the relaxation factors
have to be fairly low to get the solution to converge, this can be an indication that the flow
field may be unsteadly.

Another topic of interpretation is the resolution of the calculated flow field compared with the
size of the grid cells. Several cells are required to dissolve arecirculating zone. Flow field
characteristics smaller than about 4-7 cells may not show up in the solution. And arecircula-
tion zone with very few cells may be inaccurately calculated because a certain resolution is
required.

For some flow geometries the Navier-Stokes equations may have more than one solution. This
can for example be seen in aflume with a symmetric expanding channel, where the jet may
follow one side of the channel. If an obstacleisinserted into the side with the jet, the jet moves
to the other side of the channel. This phenomena have also been experienced in non- symmet-
rical expansions, when varying the number of grid cells caused the Navier-Stokes equations to
converge with a completely different flow field. It isthought that this problem has a higher
risk of occurrence in geometries with expansions and recirculation zones, and aso if the Sec-
ond-Order Upwind scheme is used instead of the Power-Law Scheme.

Transient sediment computations
Over the last years SSIIM has been used for several cases with transient sediment computa-

tions. The bed then changes over time in a geomorphological simulation. Some experiences
have been obtained, given in the following.
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In current SSIIM versions, the sediment transport boundary condition for the bed is based on
van Rijn’s formula. Thisformulais developed for fine uniform sedimentsin aflow with rela-
tively low water velocity and great depth. It is not certain that the formulawill produce good
results for other cases. However, it may do so. It isimportant to assess the results by compari-
sonswith laboratory experiments or field data. In van Rijn’sformula, one parameter isthe dis-
tance from the bed. In SSIIM, thisis chosen to be half the height of the cell closest to the bed.
This meansit may be possible to obtain different results for the sediment transport depending
on the magnitude of the cell closest to the bed. It istherefore advisable to include this variable
in aparameter sensitivity test. An algorithm isincluded in SSIIM to take into account unusual
values of the ratio of

a

b

where a is the distance from the bed and b is the bed form height. The algorithm is based on
the Hunter-Rouse distribution of suspended sediments. It isinvoked by using the F 60/ F 110
data sets.

Doing a sediment computation, it isimportant to use the correct shear stress at the bed. The
shear stressisafunction of the bed roughness. There are several options on how thisis com-
puted, and it isrecommended to use areasonable value. It ispossibleto let SSIIM compute the
effective roughness as a function of the sediment grain size distribution and the bed form
height. Thisis of course the most elegant solution. However, the bed form roughness is com-
puted by van Rijn’s method, which may not give accurate results for all cases. The method is
derived from uniform grain size data, giving higher bed formsthan less uniform sizes. The
default roughnessin SSIIM is 2 cm, which should not be used unless thisis areasonable
value. Determination of the roughness algorithm is done on the F 90 data set.

The numerical algorithms are approximations to exact formulas. The accuracy may therefore
be variable. It is recommended to check the sediment continuity when doing sedimentation
computation. This can be done by using the F 1 D option in the control file. Sediment continu-
ity fluxes are then written to the boogie file for each iteration. One common reason for sedi-
ment disappearing is that the solution of the equations for the sediment grain size distribution
has not converged. Thisis particularly the case for multiple sediment sizes. The convergence
criteriaand number of iterations for the solver is given on the F 4 data set. It isrecommended
to try to lower the convergence criteria and increase the numbers of iterationsiif there are sed-
iment continuity problems. Thiswill, however, lead to increased computational time, espe-
cidly if there are many sediment sizes.

Transient sediment computations are often done in connection with amoving free surface.
This may lead to stability problems. One reason may be that the water level is only updated
each 10th iteration (default). The water depth may then change a lot, and supercritical flow
may occur in some locations. The problem may be solved by reducing the time step or
decrease the number of iterations between each water surface update. Thisis done on the F
105 data set.

For transient sediment computations, some grid cells may be removed or added when wetting/
drying occur. A stepped boundary may result, which can give incorrect velocities at the
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boundary. Using the F 64 11 option instead of the F 64 8 option, the grid cells along the
boundary will change shape to give a more smooth boundary.

When wetting/drying occur, some part of the water body may form pondsin the grid, separate
from the main flow. If the ponds do not have an inflow or outflow, the coefficientsin the dis-
cretized equations will be zero. This may lead to a situation with division on avery low
number, close to zero, and instabilities may result. An agorithm to avoid the problem can
invoked by F 104 data set. The number given on the data set is added to the a, term for the
cellsthat have

The accuracy of the computation is often afunction of the number of grid cells. For the verti-
cal direction, this can be controlled by the F 87 data set. It is recommended to change the grid
resolution to see how this affects the results.

Another empirical parameter isthe minimum grid cell size. Thisis given on the F 94 data set.
Experience from the Kali Gandaki reservoir flushing case showed that values of 1 cm worked
well. The horizontal sizes of the grid cells were 10-30 cm, and the water depth was around 5
cm for this case.

3.4 Common problems

By own experience and watching students using SSII M, there are some frequent problems that
can occur.

Sequence of actions

In some example, the F 2 option is given is given in the control file, so that the computations
starts automatically. It is most often not a good idea to read input files or start new computa-
tions while the program is computing something. This can easily cause the program to crash.
If using the menu to start computations, make sure the grid is read completely before starting
for example water flow computations. And make sure the water flow computations are fin-
ished before the sediment computations are done.

SSIHIM 2 inflow/outflow specification

In SSIIM 1 it is possible to specify two or morein- or outflow regions vertically above each
other using the G 7 data sets. In SSIIM 2, the inflow and outflow are specified graphically in
the DishargeEditor. A similar specification asin SSIIM 1 can be done by giving in the vertical
levelsin the dialog box where the discharge is given. The default value of the maximum level
is set equal to the maximum number of grid cellsin the vertical direction.

Say you have a case where the maximum number of levels was for example 11, and you spec-
ified an inflow discharge between level 1 and 11 and this was stored in the unstruc file. If the
inflow/outflow region wasin ashalow area, and only 1 cell over the depth was generated, this
would still work. However, if you later increased the maximum number of grid cellsto 20in
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the control file, then the specification of 1-11 cellsin the unstruc file would be incorrect. You
would actually then only specify aninflow in the lower half of the geometry. If the inflow/out-
flow region was in a shallow are, only the top cell (no. 20) might exist. This meant that the
inflow/outflow region did not exist.

So the advice is to be careful every time you change the number of grid vertical grid cellsfor

SSIIM 2, and make sure the inflow/outflow datain the unstruc file are changed accordingly. If
you have inflow/outflow over the whole depth, give alarge integer in the “to” field of the dis-
charge editor dialog box.

It can also be useful to test that the inflow/outflow areas are correctly defined by checking the
Discharge Editor while the program is running.

Problemswith unstruc files made by program ver sions before summer 2012.

When the grid is made and the unstruc file is written, it may not look correct when it is read
back in again. Typically, some of the grid lines along the boundary will move to incorrect
coordinates, like shown on the figure below.

The reason for the problem liesin the way the geometry datais organized for the wetting and
drying computation. To make it possible for lateral erosion to take place, the wetting proce-
dure must have information about where the grid cells should be located outside the original
river. To do this, theinitial grid hasto cover also the dry areas. Thisis done by using ahigh
water level when making theinitial grid and unstruc file. The water level should then be
higher than all pointsin the bed, so that the grid will look structured when generated. The
unstruc file generated with thiswater level has always to be used later when starting the pro-
gram. To start the program with the correct, lower water level, thislower water level hasto be
given in the koordina file, together with the F 112 1 data set. However, if anew unstruc fileis
written after the program is started with alower water level, thiswill not contain the informa-
tion about the grid in the dry areas. The strange lines will therefore appear when such an
unstruc fileisread.
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Figure from the Grid Editor showing that the unstruc
filewhich isread will not have the correct coordinates
in the areas where wetting/drying has occurred. The

A .,Ih:!wmﬂlm problem i.s avoided if thg program always star'Fs With an
I,!fllliﬂﬁ'i,'n,liﬂhi:‘:l\l"i'.'lil'n'l,l"'!i'"“""l'i'ﬂ.ﬁlﬂ unstruc file generated with .a water level that is higher
R than the bed. Where no drying up has occurred.

This problem was corrected summer 2012, when also the x and y coordinates for the dry areas
were written to the unstruc file. However, using unstruc files made before this time, the prob-
lem may still occur.

3.5 Bugs and bug finding

Sometimes SSIIM will crash or give strange results. This can be dueto bugs. It can be difficult
to find bugs in computer programs with 100 000 lines of code. However, the approximate |o-
cation of abug can often be found without any access to the source code. Some guidelines are
given in the following that will be helpful in finding the bug.

1. Isthe bug reproducible? How is the bug reproduced?

2. Isthe bug only in the latest version of the program or also in older versions?

3. Are there any warning or error messages in the boogie file?

4. |sthe bug connected with any input files? If you try different input files, or omit some input
files, will the bug still be there? This applies especially to bedresfiles.

5. If the program ran well on an earlier case or asimilar other case, what is the difference be-
tween this case and the current case?
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6. Often, a bug can be related to one of the algorithms invoked by the data sets in the control
file. By removing some of the data setsin thefile, it may be possible to connect the bug to a
specific data set. Or a combination of data sets and input files.

Complex bugs

A bug can show up right away after the program startsor it can emerge after long computational
times. A bug that shows up right away isusually easy to find by debugging the source code. A
bug causing incorrect results after alonger computational time is more difficult to find. This
can be called a complex bug. Here are some advice in how to find such a bug:

1. Similar to aphysical laboratory model, you can look at the physics of the problem, observed
inthe SSIIM graphics during the computation: Isthe water surface location correct? |sthe wa-
ter depth correct? Isthe velocity field correct? Are the secondary currents correct? Isthe rough-
ness correct? Is the shear stress correct and follow patterns of depth/velocity/roughness? Does
the sediment concentration and bed changes follow the pattern of the shear stress? Isthere
enough sediments on the bed for erosion to take place? The thickness of the sedimentsis seen
in the Map graphics.

For example, if the erosion is too deep, this can be due to atoo small sediment size, to little
inflowing sediments or too high shear stress. The too high shear stress can be due to too high
velocities or too high roughness. If the velocity istoo high, this can be due to too low water
depth. Too low water depth can be due to too low pressure. By following the parametersin the
graphics, it is often possible to trace the bug to an algorithm for specific physical process. SSI-
IM often has several agorithms for the same process, for example computation of the water
level. Then other alternative algorithms for the same process can be tested.

During this testing, it can be useful to make ParaView or Tecplot animations of a number of
variables, for examplevelocities, pressure, water levels, bed levels, bed changes, roughness etc.

For sediment computations, it is useful to look at the sediment continuity. The boogie file will
provide more detailed resultsif F 1 D isgiven in the control file.

2. If the bug isin acomplex case/geometry, it can be easier to find the bug in asimpler similar
case. A typical ssimpler case isastraight channel with constant depth and velocity. Then, pa-
rameters as shear stress, sediment transport capacity and bed changes can be computed by hand
and compared with the results from SSIIM. Another ssimplification is to use one sediment size
instead of many.

3. Itisoften necessary to rerun SSIIM several times with different input parametersto find the
bug. Considerable time can then be saved by using a coarse grid instead of afine grid for the
same case. |t doesn’t matter that the coarse grid will not give accurate results, aslong asthe bug
isreproduced. It has happened that a bug was discovered after 6 weeks of computational time
onagrid with 4 million cells. If agrid with 4000 cells had been used instead and the other pa-
rameters were the same, the bug had been found after a computational time of 1 hour.
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3.6 Frequently asked questions

1. The program crashes. What do | do?

See Chapter 3.2

2.1 think thereisabugin the program. What do | do?
See Chapter 3.5

3. How istheroughness specified in SSIIM?

Roughness parameters are needed for SSIIM for two purposes.

1. Generation of the initial water surface elevation (SSIIM 1)
2. Computation of the shear stress at the boundaries, through the wall laws

For point 1, the Manning-Strickler value of the W 1 data set is used. This data set hasto be
given by the user. It isaso possibleto vary the value in different cross-sections by using the W
5 data set. None of the other roughness options will affect the initial water surface location.

The shear stress at the boundary is computed using awall law for rough boundaries. Thiswall
law includes a roughness value in meters. One roughness value is used for all the side walls.
Thisis called Xks\Wall internally in the program. For the bed, a separate valueis given for each
cell in the two-dimensional array called Xkg[i][j] in the computer program.

The default values of the roughness variables are given by converting the Manning-Strickler
value of the W 1 data set to a roughness height.

26\°
= (5)
Initsoriginal form, this formula used the dgg value instead of kg. However, by using the loga-

rithmic formulafor the vertical velocity profile and Mannings formula, it can be shown that kg
Isequal to dgp.

The user can override this value by using the F 16 data set. Then both Xks\Wall and Xkg[i][j]
will get this value. If the user wants to specify a spatially varying roughness at the bed, this
can be done by making a bedrough file. Then only the Xkq[i][j] values will be affected, and
not the XksWall value. The roughness specified in the bedrough file will override the value
specified on the F 16 data set. This means that using both a bedrough file and the F 16 data
set, the value on the F 16 data set will only be used for the walls.

The roughness given in the XksWall and Xkg[i][j] variables will not affect the location of the
initial water surface. However, the variables will affect the shear stress and thereby the pres-
sureinthe flow field. Soif the algorithm is used where the water surface is updated as a func-
tion of the pressure field, the water surface will be affected by the roughness values.
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In the time-dependent sediment computations, invoked by using the F 37 data set, it is possi-
ble to further change the roughness values in the Xkq[i][j] array. Thisis done by using the F
90 data set. Then the bed form height can be computed, and thereby also the bed roughness.
Thiswill again affect the location of the water surface, only if it is recomputed during the
computation.

If you are unsure about what the roughnessis for a given configuration of input, it is recom-
mended to start the program an look at the roughness parameter in the Map graphics.

4. How isthe free surface computed?

The free surface is computed using a fixed-lid approach, with zero gradients for all variables.
The location of the fixed lid and its movement as a function of time and the water flow field
can be computed by one of four different algorithms:

1. 1D backwater computation

2. Gravity and control volume algorithm
3. Pressure and Bernoulli algorithm

4. Shallow water equations

1D Backwater computation

The first algorithm isa 1D backwater computation. This computation is done when the pro-
gram starts, and it isinvoked automatically. It isapart of the grid generation for SSIIM 1. Itis
not used for SSIIM 2, which has a horizontal free surface asinitial default. Theinitialy gener-
ated free surface is used for the subsequent computations as afixed lid with zero gradients for
al variables, if no other free surface algorithms are specified.

Gravity and control volume algorithm

Thisalgorithm is used to compute the movement of the free surface. It isinvoked by using the
F 36 1 option. The algorithm includes the gravity term in the Navier-Stokes equations. A time
step has to be specified by the F 33 data set. The basis of the algorithm is to use the continuity
equation instead of the SIMPLE a gorithm to compute the changes in the water surface. The
algorithmisvery unstable, and avery short time step has to be used for stability reasons. This
algorithmisonly used for cases with very steep water surface gradients, for example computa-
tion of coefficient of discharge for a spillway or aflood wave with a steep front.

In 2009, this algorithm was improved a bit for the SSIIM 2 version, giving a more stable solu-
tion. The new algorithm isinvoked by F 36 15.

Pressure and Bernoulli algorithm

Thisagorithm isimplemented in both SSIIM 1 and 2. It can be used for both steady and
unsteady computations. The algorithm is based on the computed pressure field. It usesthe
Bernoulli equation along the water surface to compute the water surface location, based on
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one fixed point that does not move. The location of thispoint is given on the G 6 data set, both
for steady and unsteady computations.

For a steady computation, the algorithm isinvoked by using a small number for the second
integer on the K 1 data set. Thisinteger gives the number of iterations between each time the
water surface is updated. For an unsteady computation, F 36 2 is specified in the control file,
together with the time step on the F 33 data set. Using this algorithm, it is possible to use the
timel file to compute alocation of the water surface that varies over time.

The algorithm isfairly stable, so that it can also be used in connection with computation of
sediment transport and bed changes.

The algorithms have been further developed in SSIIM 2, and the newest versionisthe F 36 7
option.

Shallow water eqguations

Thisagorithmsis only implemented in SSIIM 2. It is used similar to the Pressure and Ber-
noulli algorithm, but the F 36 9 is specified in the control file, together with F 323 1. The
method is more stable than the pressure and Bernoulli algorithm, but probably not as accurate
for complex water surfaces. However, if the water surface is close to horizontal, which it usu-
aly is, then the accuracy may be of sufficient quality.

5. How can | convert between sediment fluxes, bed elevation changes and concentra-
tions?

The concentrationsin SSIIM is given as volume fractions. That is the volume of the sediment
particles as afraction of the total volume of the water/sediment mixture. If the density of the
sedimentsis 2.65 kg/litre, the mass fraction will be 2.65 times higher than the volume frac-
tion.Or in other words, if you have amass concentration, you need to divide by 2.65to getitin
volume concentrations. Note that concentrations in ppm are often mass concentrations.

The specific density of the sediments can be modified on the F 11 dataset in the contral file, if
you want a different specific density than 2.65.

A flux, F, of sedimentsin kg/sis obtained by the following formula:
F = p,CUA

U isthe water velocity in m/s normal to thearea Ain m?2. The sediment concentration in vol-
ume fractionsis c and pg is the density of sedimentsin kg/m?3, for example 2650 kg/mq.

Theinflow of sediments can be specified onthe | data setsin the control file, in kg/s. They can
also be specified for example in the timel file as a concentration. If a concentration isto be
given, then thisis the volume fraction. How thisis computed is most easily shown in an exam-
ple:
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L et us say we have awater inflow of 3 m?3/s and a sediment inflow of 0.1 kg/s. The sediments
will take up avolume of 0.1 kg / 2.65 kg/l = 0.03777 litres. The 3 m3/s will take up avolume
of 3000 litres. The volume fraction will then be 0.03777 litres/ 3000 litres = 1.25x10™°

The concentration value in the timei file should be 1.25e-5 or 0.0000125.

The next question is how much volume on the bed does a given amount of sediment take up?
The default sediment packing on the bed for SSIIM is 0.5, meaning that 50 % is sediment par-
ticlesand 50 % is water. This can be changed on the F 26 data set. One cubic meter of sedi-
ments on the bed therefore contains 0.5 m* sediments. Thiswill have adry mass of

0.5 m® x 2650 kg/m® = 1320 kg.
Of coursg, if the massis wet, then the 500 kg of water must also be added, giving 1820 kg.
6. How do | specify an initial grain size distribution on the bed in SSIIM 2?

Thisis done most effectively with the fracresfile. Thefile gives the layer thickness and grain
size distribution of each bed cell. The valuesfor each cell isgiven on one line. The line starts
with two integers, giving the 2D indexes for the cell. Anindication about the index for each
cell can be seen in the grid editor or the discharge editor, by choosing "View->legend” in the
menu. Thiswill givethe index for the grid intersections. The corresponding cell will bein the
direction of lower index values.

After the two indexes, then 2 x (1 + n) floats are read, where n is the number of sediment
fractions. First, the thickness of the active, top layer is given. Then n fractions are read. Then
the thickness of the inactive layer is given, and then n fractions are read for this layer.

The file can be made by using a spreadsheet.

Note that the order of the bed cellsin the fracresfile is not important. Also note that the values
for the same cell can be given multiple times. Then it isonly the last value that will be used.
This"feature" can be useful when regions of different sediments are to be described. Then the
whole geometry can be covered in one particle distribution, and then the region of different
distribution can be given afterwards. It is not necessary to remove the originally given values
before adding new ones. This can be nested as many times as necessary. The only limitationis
the length of the fracres file, which must have less lines than 20 x the number of bed cells. If
thisisaproblem, it is easy to increase the number and recompile the program.

After thefileis made, the user should read it and look at the grain size distribution and the sed-
iment thicknessin the SSIIM graphics. Then possible mistakes can be seen.

The fracres file specifies the thickness of each sediment layer, and thereby also the thickness
of the total amount of sediments on the bed. Thisinformation is also given by the difference
between the actual bed level and the limit of movable bed given in the koomin file. If the two
ways of specifying the sediment thickness differ, then theinput isundefined. In SSIIM 2, the F
310 data set modifies the values from the koomin file or the fracres file to give correspond-
ence.
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The grain size distribution on the bed is also given in the bedres file, which can be used to ini-
tiate values from an earlier run. The bedresfile is written from SSIIM 2.

Notethat the F 306 1 data set must be given for the sediment infor mation from the bedres
fileto beused. Also F 306 1 haveto be given for the fracresfileto beread.

Itisuseful to look inthe SSIIM graphics after startup of the program to see if you have the ini-
tial values of the sediment parameters you want.

7.1 get problemswith generating thegrid in SSIIM 2 when wetting/drying occurs.

See Chapter 3.4.

3.7 Lateral grid movements

This chapter describes the method to make a dynamic grid that can move in the lateral direc-
tion. Such agrid isused to model the wetting and drying process taking place in ameandering
channel, or when modelling reservoir flushing. Note that this can only be done using SSI 1M
version 2, as an unstructured grid is necessary.

Some details of the grid generation algorithms are described by Olsen (2003). The general
principleisto first generate a 2D depth-averaged grid over all the areas where the river may
flow. Thisis done by using awater level that is higher than the bed everywhere. This 2D grid
isthen used as abasisfor the 3D grid that is used to compute the water and sediment flow. The
2D grid stores information about the bed level location and sediment data. Also read Chapter
4.?.?, where more information is given.

Theinitial grid have to be given in an unstruc file, which is used when starting the program.
This unstruc file can be generated in different ways, depending on the geometry. For acom-
plex natural geometry, the Grid Editor in SSIM 2 can be used, with input from a geodata file.
Thisisdescribed previously in thismanual. Note that a high water level hasto be used, that
cover sboth thewetted and dry areas. The second method to generate the unstruc file can be
used if aregular geometry isto be modelled. Then a koordina file can be made in SSIM 1 or
in a spreadsheet, and this can be transformed to an unstruc file using the method described in
Appendix I.

The unstruc fileisusually very large. If thisis aproblem, then it is advisable to use as few
cellsin the vertical direction as possible when making the file. The number of cellsin the ver-
tical direction can then be increased later by adjusting the G 1 and G 3 data sets the control
file.

The unstruc file has to contain the water discharges at the correct locations for inflow and out-
flow. Thisis specified in the Discharge Editor.
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Note that the control file has to contain the data set F 64 11 to generate the grid. This means
that the data on the G 3 data set in the control fileis not a vertical level in meters, but percent-
age of the water depth, similar to what isgivenfor SSIM 1. Also, it isrecommended to usethe
F 102 1 data set in the control file to make the grid cells along the boundary change in shapeto
improve the smoothness of the banks. However, the F 102 1 option should never be used
before the unstruc fileis saved.

When the unstruc file is made, its water level is often higher than what the user wantsin the
start of the computation. Thisis especially the case when modelling wetting/drying situations.
To specify that alower water level is used at the start of the computation, two steps has to be
taken:

1. Make a koordina file containing the desired initial water level
2. Add the F 112 1 data set to the control file

This koordina file has to have the same coordinates for the x, y and bed levels asin theinitia
unstruc file, but it also hasto contain the water levels. A recommended procedure isto use the
file koordina.t, which is written automatically when the initial unstruc file is written from
SSIM 2. The koordina.t file has the correct values for x, y and the bed levels. However, the
water level isthe same asin the unstruc file. The koordina.t file can beimported into a spread-
sheet and the values for the water level can be changed to the desired initial values. Thenit can
be written to the working directory and named koordina, without an extension.

Note that the F 112 1 option in the control file only workswith the original unstrucfile
and the modified koordinafile. If later during the computation a new unstruc fileiswrit-
ten from the menu, then thiswill not be compatible with the modified koordinafile. Writ-
ing a new unstruc file during the computation will overwrite the original unstrucfile. In
other words, keep a safe copy of the original unstruc file and the modified koordina file.
To reduce thiscommon mistake, the unstruc file will get an extension .dry if it iswritten
when some part of the geometry hasdried up. Also, the user will not be allowed to enter
the Grid Editor or the Discharge Editor when the F 112 1 option isused in the control
file.

Thelateral movement of the grid is due to fluctuations in the bed and water levels. This means
that one or both the F 36 and F 37 data sets have to be used in the control file. Also, the timei
file hasto be used, where time-variationsin water level, water discharge and sediment inflow
can be given.

As the computation proceeds over time, intermediate results may often be required. This can
be done by using the P 10 option in the control file. A number of bedres and result files are
produced, which can beread by SSIM 2 at alater time after the program has finished. Thisis
done by removing the extensions of the files at the selected iteration and reading the results
from the menu of SSIM 2.
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3.8 Nested grids

Nested grids are used for resolving finer scale problems in some part of the geometry. The
nested grids can only be used in SSIIM 2. They are generated using the Grid Editor.

Several nested grids can be used. The numbering of the grids are important and must be kept
in mind when giving information later in the control file. Thefirst grid generated is numbered
1, second 2 etc., whether they are nested or not.

When making a system with nested grids, some decisions have to be made regarding the order
of solving equations for the different grid parts, and which equations to solve. The specifica-
tion of which grid isto have its water flow computed is determined on the G 25 data set. This
data set reads anumber of integers. The number of integers must be the same as the number of
grids. The integer gives the order of the computation. For example:

G253112

Thefirst integer on the G 25 data set says there are three working blocks. The two first blocks
are computed first, as they have number 1. The third block is computed afterwards. The third
block may be a nested block. The computation will then first be done on the main grid, and
then on the nested grid afterwards. To compute all blocks at the same time, including the
nested block, the following data set can be given:

G253111

Note that the default method isto compute all blocks at the same time, so then it is not neces-
sary to specify the G 25 data set.

If one block is not to be computed at al, a zero can be given. For example:
G253001

Then only the last grid is computed. This can be used when the bed changes only happen in
the last block, and the water flow does not change in block 1 and 2. Then the steady water
flow field is computed first, and the result file written. The result file is read before the
unsteady computation is started.

The water flow is computed using the procedure above for each time step. Afterwards, the
sediment transport may be computed. The specification of which block to compute the sedi-
ment is given on the F 188 data set. The F 188 data set only has oneinteger. If it isO (default),
sediment transport will be computed in al blocks. If the integer is a positive number, only the
block with this number is computed. If the integer is negative, al nested blocks are computed.



3.9 Displaying measured bed changesin SSIIM 2

It is possible to use the bed interpolation algorithms in SSIIM 2 for visualizing measured bed
elevation changes. The measured bed elevations at two different times are used. The values
can be exported to Tecplot or Paraview for nice 3D colour graphics. The volume of the
changes can also be computed.

The following steps must be taken:

1. First agrid has to be made of the geometry. The grid would typically be made from a geo-
datafile, taken from the assumed lowest bed levels. For example after the flushing, or before
sediment deposition. The grid isthen written to the unstruc file. When thisfileiswritten, afile
called koomin.bed is also written. Rename this file to koomin.bedl, so it is not overwritten
later. Note that a koomin file must not exist in the directory when the unstruc file is made.

2. Add an F 249 1 data set to the control file. Thiswill allow both positive and negative values
of the bed elevation changes. Make sure you are using a SSIM 2 executable made after 14.
February 2010.

3. Usethe same grid asin point 1, but now change the geodeata file to the one from the other
bed level. Use thisfile to make anew bed level with the same grid asin point 1. Make sure
there is still no koomin file in the directory. Write the unstruc file.

4. Rename the koomin.bedl1 from point 1 to koomin without an extension. Then start the pro-
gram with the unstruc file from point 3 and the koomin file from point 1.

5. The variable "sediment thickness' will now be the difference between the two bed levels
from the two geodata files. This can be displayed in the SSIIM 2 graphics, or written to the
ParaView or Tecplot files. If the variable does not show up when the Tecplot/ParaView fileis
written directly from the menu, it is necessary to add the parameter 't' on the G 24 data set and
use an F 48 option in the control file to produce the Tecplot/ParaView file when writing the
result file.

6. Theinitial water volume of the reservoir iswritten to the "boogie" file at the beginning of
each transient sediment computation. Using the two unstruc files from point 1 and 3 will give
two volumesfor thereservoir. Aslong asthe water level isthe same, the differencein volumes
will give the volume of the deposited/eroded sediments in the reservair.
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Chapter 4. User interface

4.1 The main user interface

The main user interface appears once the program is started and the input files are read or gen-
erated.

The Windows version consist of only one window with one menu. At start-up, the window
show text with information about convergence and the run, similar to the dialog box in the OY
2 version. The content of the window can be changed by choosing different sub-optionsin the
View option of the menu. Each View option will correspond to a window in the OS/2 version.
Changing the View, will aso change the main menu. The different Views are:

- Map graphics with contour plots or vectors
- Longitudinal/cross-sectional profiles

- Grid Editor

- Discharge Editor (SSIIM 2)

The options are described in more detail in Chapter 4.2-4.4. The main menu also has options
for reading and writing input/result files, starting computations or printing. A sub-option of
View decidesif colours should be used or only black lines.

In general, a SSIM run should be started by reading input files, or generating the grid using the
Grid Editor. After generation of the grid, the inflow and outflow should be specified using the
Discharge Editor. Then the data should be saved in the Unstruc/koordina files, before the
computations are started and the results are viewed.

4.2 Interactive input of parameters

Some of the most commonly used parameters can be set in dialog boxesin the OS/2 versions.
These dialog boxes are activated by the Input Edit choice in the main menu bar. The choices
are:

GridEditor: This option is described in Chapter 4.3.
DischargeEditor: This option is described in Chapter 4.4. (Only SSIIM 2)
Waterflow parameters: This gives various parameters for calculation of water flow,

which can be used when there are convergence problems and
when parameter tests are done. Some of the parameters can be
changed while the program is cal culating the water flow field.

Note that only the most commonly used parameters can be given in the dialog boxes. The
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other parameters have to be given in the control file.

Usually, it is not recommended to use the dialog boxes. When running many cases with differ-
ent input parameters, each run is usually done in a separate directory. This directory will then
contain both input files and the results. The system is more convenient for archival purposes,
when later looking at which parameters in the input files were used to create certain results.

4.3 The grid editor

The Grid Editor isinvoked from the View option in the main menu. The grid is seen from
above.

SSIIM 1.

In SSIIM 1, a structured grid is used. When starting the Grid Editor without reading a previ-
ously generated grid, arectangular grid is shown as default. The left side of this rectangular
grid isthe default water inflow. The right side isthe default water outflow. In the Windows
version of SSIIM 1, the default inflow side is coloured red. And the default outflow side is
coloured green.

When generating a grid for a natural geometry using geodata points, the inflow of water is
often not on the left side, and the outflow not often on the right side. The grid therefore hasto
be rotated initially. Thisis most easily done by moving the corners first, and then using the
menu options Sdes and Transfinite |. The menu options are described more in the following.
General:

The menu bar gives various options for generating the grid. In the following, the grid genera-
tion procedure is described first, and then the different menu options.

4.3.1 The grid editor menu

The main menu of the grid editor is made up of several options with corresponding sub-
menus. The structure of the menu depend on which version of SSIIM is used.
View

In the Windows versions of SSIIM, the View option has a sub-option Geodata points, display-
ing the points in the geodata file on the grid plot. The points are shown with acircle, and the
different colour indicate different vertical levels. Note that the points are read from thefile,
and this may take sometimeif thefileislarge.
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Move/Scale

The option Move is used to move the plot upwards, downwards or sideways. The arrow keys
can be used instead of the menu. The option Scale is used to enlarge, shrink or distort the plot.
The keys <Page Up> and <Page Down> can be used for scaling. By holding down the
<ALT> button while scaling/moving, then the changes are smaller.

Utility

The Utility option is only available in the OS/2 versions of SSIIM. In the Windows versions,
the sub-options are moved elsewhere.

The option Utility has six choices on the pull-down menu. The first choice, Show geometrical
points, displays the points in the geodata file on the grid plot. The points are shown with a cir-
cle, and the different colour indicate different vertical levels. Note that the points are read
from the file, and this may take some time if thefileislarge.

The second choice, Make bed interpolations, generates z values for the bed surface of the grid.
The bed interpolations are done in a separate thread in OS2, because the calculations may
take some time. This allows other tasks to be carried out during the interpolation.

The zvalues areinterpolated from a set of geometrical dataread from the geodata file. If there
is no geodata file present, an error message is given. The interpolation routine goes through
all the grid pointsi,j, and finds the closest pointsin the geodata filein all four quadrants where
the grid intersection (i) is the centre of the coordinate system. Then alinear interpolation
from these four pointsis made. If one of the pointsin the geodata file is closer than 5 cm from
the grid point, this z value is chosen and no interpolation is done. The outcome of the interpo-
lation islogged to the file boogie.bed. If the interpolation routine is unsuccessful in finding the
point, the z value is set to zero.

The third choice, Apply changes, sets aglobal change flag. When the waterflow routine sees
that thisflag is set, it updates the calcul ation geometry according to the grid editor geometry.

Thefifth choice, New water level and grid, isused after having changed the z values on any of
the coordinates. The grid editor only moves the grid in the layer bordering the bed. So if any
of the grid points have been moved in the vertical direction, the water level and the grid points
above the bed needs to be recalculated. Thisis done by using this option.

Define

Thisoption is used for defining different parameters. The parameters are often connected to
grid intersection points. The point that was last activated by the mouse is used as default.

The first option is Give coordinates. This gives a dialog box where the user can give numeri-
cal valuesfor x,y and z for agrid intersection.

The second option is Set NoMovePoint. Thisinvokes amode where the user can define certain
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points which will not be moved by the interpolation, called NoMovePoints. In NoMovePoint
mode it is not possible to move the grid points with the mouse. When the user clicks on agrid
intersection, a blue star emerges on the intersection asa sign that thisis chosen. Up to 19 999
NoMovePoints can be chosen. To verify that thismode is present, the letters "Point mode, 0" is
shown on the lower part of the EditWindow when the Set NoMovePoint is chosen. The integer
shows how many points you have chosen. To return to the normal mode, choose Define and
Set NoMovePoint again. It is verified that the normal mode is set because the text "Point
mode" disappears. In the normal mode the user can move al points including the NoMove-
Points.

The third option is Delete NoMovePoint. This deletes the last point set under the NoMove-
Point mode.

Thefollowing four options are setting of attraction to certain pointsor linesinthe grid. Thisis
used by the éliptic grid generator. A dialog box emerges when the choice is made, and the
user must give two integers which describes the location of the attraction point/line. Then two
attraction parameters are given. The Prop. att. value is proportional to the attraction. If nega-
tive, the grid lines are moved away instead of attracted. The &g. att. value gives an attraction
proportional to the grid line difference raised to a power of &q. att. Thisvalueis used to deter-
mine how far out in the grid the attraction works. Note that a smaller value will give larger
attractions.

Point attraction gives attraction to points, and Line attraction gives attraction to lines.
Up to 200 attraction points can be defined. The attraction points can be seen on the grid by
coloured rectangles at the grid intersections.

The last option in the Define menu is Delete last attraction. This deletes the last defined
attraction.

Generate

Thefirst choice in the pull-down menu is Boundary. This choice interpolates linearly along
the four border lines of the grid. Note that the z values are also interpolated. Thiswill create a
rectangle unless a NoMovePoint has been defined on the border. Then the interpolation will be
between the corners and the NoMovePoints.

The second choiceis Elliptic. This starts the elliptic grid generator. Note that this will not
change the z values.

The third choice is Transfinitel. Thisistransfinite interpolation in the streamwise direction.
The z values will be interpolated. IMPORTANT: In this mode the NoMovePoints will also be
moved.

The fourth choice is Transfinitel. Thisis the same as Transfinitel, except it isin the cross-
streamwise direction.

The second last choice, Bed levels/Bed interpolations, generates z values for the bed surface
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of the grid. The z values are interpolated from a set of geometrical dataread from the geodata
file. If there is no geodata file present, an error message is given. The interpolation routine
goes through all the grid points (i,j), and finds the closest points in the geodata file in al four
guadrants where the grid intersection (i) is the centre of the coordinate system. Then alinear
interpolation from these four pointsis made. If one of the points in the geodata file is closer
than 5 cm from the grid point, this z value is chosen and no interpolation is done. The outcome
of the interpolation islogged to the file boogie.bed. If the interpolation routine is unsuccessful
in finding the point, the zvalueis set to zero.

The last choice, 3D Grid/Implementation, is used after having changed the z values on any of
the coordinates. The grid editor only moves the grid in the layer bordering the bed. So if any
of the grid points have been moved in the vertical direction, the water level and the grid points
above the bed needs to be recalculated. The new grid is computed by using the 3D Grid
option.

4.3.2 Grid generation for SSIIM 2

Overview

SSIIM 2 uses two grids: one two-dimensional depth-averaged structured grid and another
three-dimensional unstructured grid. The two grids cover the same area. The 2D grid isfixed
in space over time and contain both the wetted and dry cells. The indexing of the 2D grid is
similar to SSIIM 1. The 3D grid may change over time as the water and bed elevations
change. The total number of cellsin the 3D grid will therefore also change, and also the index-
ing of the cells.

For areal-world case where a complex water body is simulated, it is necessary to start with a
geodata file, giving the coordinates of for example contour lines of the bed levels of the lake.
The grid generation procedure then starts with reading this file from the Grid Editor. The indi-
vidual pointswill then be shown in the main window, with different colours according to the
vertical elevation.

It may not be necessary to use ageodata file for demonstration and teaching purposes, or if the
geometry isfairly simple, for example a channel.

The next step isto start making a number of blocksin the Grid Editor. Each block is made up
of astructured grid, which is 2D depth-averaged. The blocks are glued together to form an
unstructured grid, covering the whole water body. The blocks can have different number of
cells, both related to other blocks and the two horizontal directions.

With the most recent wetting/drying algorithm, it may be most convenient to make asingle 2D
block of the geometry. The wetting/drying algorithm can then be used to make the complex
boundary.

When the plan view of the grid looks ok., the 3D grid can be generated. This grid is based on
the 3D grid, but has a varying number of grid cellsin the vertical direction. The 3D gridis
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generated in the Grid Editor, from the menu options Generate -> 3D grid. Afterwards, it is
advisable to save the grid from the main SSIIM menu, by writing to the unstruc file.

Note that the unstruc file will not contain the 2D grid, only the 3D grid and a connection
between the 2D grid and the 3D grid. The unstruc file should therefore only be written when
all the 3D cells are fully wetted, and no section of the 2D grid is dry.

It isalso recommended to read Chapter 6.11 to get more information about this topic.
Detailsof grid generation

For real-world cases, it isimportant to make a hand-drawn sketch of the geometry and the grid
blocks before making the grid on the PC, to determine the approximate size and number of
blocks. Note the limit of number of blocksis currently 9. It is possible to add blocks to an
already existing grid, so usualy it is advisable to start with a ssmpler grid with a couple of
blocks covering the main part of the water body, and add more detail afterwards. Also note
that it is not possible to remove already added blocks, so it may be advisable to save fileswith
the simplified grid.

The blocks are added by choosing the Add block in the Block menu. After making the choice,
the user clicks with the mouse on the four corners of the block. The four points must be added
in the clockwise direction, starting with the south-west corner, then the north-west corner, then
the north-east corner and finally the south-east corner. Note that the directions north-south-
east-west does not have to follow the true directions according to the map, but it has to be con-
sistent relative to the rest of the grid. After the four clicks are made, arectangle is seen on the
screen. The user then have to choose the number of grid cellsin the block. Thisis done by
choosing the Sze block in the Block menu, and giving the numbersin the dialog box. The grid
linesin the block then emerge. The user can now move the grid lines of the block to better fit
the boundary or other characteristics of the desired grid.

A new block is added by the repeating the same procedure, starting with Add block. Upto 19
blocks can be used.

The next step isto glue blocks together. The connection is actually made in the three-dimen-
sional generation procedure. The algorithm checksif two grid points are very close to each
other. If two grid lines at borders of two grids are very close, then the connection is made.
Note that the ends of the grid lines also have to be located at the same place, so that only one
cell from one block connectsto one cell at another block. It isnot possible to have

two cells from one block connecting to one cell in another block. Then the connection is not
made, and awall is used instead.
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Before the 2nd block is made, one should think L

about the orientation of the blocks. The new block 1€ directions of the blocks can be
will similarly to the first block have asouthiwesy ~ Checked after the grid is made using
east/north side. When the blocks are glued together, ~ the map graphics, showing the cell
the north side of one block should be glued to a numbers. The lowest number ina
south side of the other block, for example. Or the ~ Plock always starts on the south-west
east side of one block should be glued to thewest ~ COrner, and the highest in the north-
side of another block. Thereby aconsistency of the ~ €8St COrner.

direction of the total grid is maintained. All the

blocks should have the same north/east/west/south

direction.

To make the connection it is therefore necessary to locate grid corners from two blocks at the
same place. Thisis done by choosing Connect points mode in the Block menu. In thismode, it
ispossible to click on one grid corner and drag it to another grid corner in another block.
When thisisdone, the point islocked, and will not move later, similar to aNoMovePoint. This
isseenin Figure 4.3.2.1. Fig. A shows two blocks that are to be connected. Fig. B showsthe
connection of two border grid points

I\

(I
|

| 1 - -

Fig. 3.3.2.1 Procedureto glue blocks together.

It is not necessary to connect all the points along a connection, only the end points. For each
block, one can use the Generate - Boundary option to generate straight lines between corner
points, NoMovePoints and Connection points. Then the intermediate points on the connection
line will be located at the same place. Thisisdonein Fig. 4.3.2.1 C above. Note that it isonly
possible to edit one block at atime. The user choose which block to edit by the menu option
Block - Choose no.

After the blocks are made and glued together, it is usually necessary to modify each block
boundary according to the pointsin the geodata file, and also possibly to generate the initial
pointsin the block with the elliptic or transfinite grid generator. Thisis shown in Fig D above.
The user can click with the mouse on a grid intersection and drag this to a new location. The
mouse button must be pushed down while the movement is made.

When the user is satisfied with the two-dimensional grid, the grid has to be made in the third

direction. Thisisdone in the Three-dimensional grid option in the menu. It is possible to have
varying numbers of grid cellsin the vertical direction. There are basically two waysto do this.
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Either to have a stepped grid with horizontal grid lines, or using non-horizontal grid lines
including the possibility of having triangular cells. The two options are given in the figure
below:

A B S N B

Note that A isthe default option. When using this option, then the levels of the grid (in meters)
must be given on the G 3 data set. Option B can be specified using the F 64 data set. Note that
the commonly used F 64 11 and F 64 13 options has different definitions of the G 3 data set.

Then the G 3 data set is the percentage of the distance between the bed and the water surface.

The horizontal grid lines are often preferred when calculating 1akes where density stratifica-
tion is very important. Then the absence of non-orthogonal terms for a non-orthogonal grid
may causeinstabilities. Also, for alake with stratification, most of the vel ocities occur closeto
the surface, and if the grid is not exact at the bed, this may not affect the results. The non-hor-
izontal grid lines are used where avery accurate description of the bed is necessary, and where
density gradients are relatively small.

In the Three-dimensional grid -> parameters dialog box, the user chose the grid type and the
vertical distribution of grid lines.

If the user wants to create a nested grid, the menu option Add block should be chosen. The
user chooses the corners of the nested grid inside the already generated coarse grid. But
instead of choosing Block size, the option Nested block should be chosen. Then adialog box is
given, where the user choose parameters for the nested block. The nested block is automati-
cally connected to the rest of the grid in the three-dimensional generation of the grid.

I mportant notes.

1 After having edited the grid, it is advisable to write the content to the unstruc file. This
isdone in the File option of the main menu. Also note that the 3D grid first have to be
made, using Generate of the Three-dimensional grid option in the menu.

2. Using unfavourable attraction coefficients can cause the eliptic generator to crash,
which meansthat SSIIM also crashes, and the grid data are lost. It is therefore advisa-
bleto write the grid to files before starting the elliptic generation with attraction coeffi-
cients. If the program crashes, the files can be read and other attraction coefficients can
betried.

Using the latest wetting/drying algorithms of SSIIM 2, it is often best to use only one block.
Then the water level ischosen so high that it isabove the bed at al places. Additional geodata
points may be generated in areas where there are too few points. An unstruc file is generated
for the block, where no drying has taken place. This unstruc file isthen used in al following
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computations. Inflow/outflow is specified in this file. Often, the water level at the start of the
computation is below the highest water level. Then akoordina file is made with theinitial
water level, often using a spreadsheet to modify the koordina.t file. The F 112 1 data set is
used when reading the unstruc file. This causes the original unstruc file to be read first, then
the koordina file with the lower water level isread, and then the grid is regenerated to the low-
ered water level. IMPORTANT: The unstruc file must not be written after this procedure,
when the water level has been lowered. Only the original unstruc file must be used in the fol-
lowing work. Otherwise, no geometrical information will be stored for the dry areas, causing
problems | ater.

4.3.3 Digitizing maps (SSIIM 2 for Windows only)

It ispossible to use SSIIM 2 for Windows to digitize maps to generate the geodata file. A dig-
itizing table have to be used, and the drivers have to be installed properly. The digitizing table
mouse will then show a cursor moving aong the screen. SSIIM usesthe location of this mouse
to generate coordinates.

The Grid Editor in SSIIM is used. First, SSIIM is started, and the window maximized. Then
the tablet mouse is moved so that the cursor isin the lower left corner of the inside of the
SSIIM window. A pencil is used to mark this point on the tablet. This point iscalled A. Then
the tablet mouse is moved so that the screen cursor is at the upper left corner of the inside of
the SSIIM window. Thisis point B. The distance between the points on the digitizing tableis
measured using aruler. Thisiscaled D. Theinverse of the scale of the map is multiplied with
D (in meters) to obtain the number S. For example, D is 37 cm, and the scale is 1:3000, then S
1S 1110 meters.

In the working directory, an initial geodata file have to be made initially, using an editor. The
file should have three lines:

S0.00.0 1110.0 1110.0
E0.00.00.0
Z000

The two last floating point numbers on thefirst lineis S. Replace 1110.0 with the computed S
value.

Then tape the map to the digitizing table and start SSIM. Choose the GridEditor, choose View
geodata points and Define->Add geodata points. Give the level of acontour linein the dialog
box, and click on the line on the map on the digitizing table with the tablet mouse. Chose
Define-> Add geodata points again when a new contour line is digitized. Do not digitize more
than 500 points at atime, then SSIIM will crash. Before 500 is reached, the geodata file should
be saved and SSIIM ended. Then start it up again, read the geodata file and add new 499
points. This can be repeated as many times as necessary.

Note the map have to stay at the same place on the digitizing table. If it is removed, the coor-
dinate system will move, and the digitizing procedure have to be repeated.
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After the digitizing is done, the first line with the Sisremoved from the geodata file, and the
scaling/moving of the graphics will work again.

Also note it is possible to remove geodata points graphically in the grid editor.

4.3.4 Bed interpolation algorithms

The algorithms provide a method to interpolate the bed level s of the grid, given alarge number
of measured points, randomly distributed on the bed. The measured points are given in the ge-
odata file.

There are currently three algorithms implemented in SSIIM 1 for Windows:

- The default algorithm
- The minimum algorithm
- The cross-section algorithm

Only the first oneis currently implemented in SSIIM 2 and the OS/2 versions.

Inthefollowing, theindex p isgiven for the point where the algorithm computes the bed level.
The algorithm then computes z,, given X, Y, and a number of geodata points: (x;.y;,z).

The default algorithm

The default algorithm divides all the geodata pointsin four groups, according to their position
in the x-y plane. The first group has both larger x and y values than point p. The second group
haslarger x values and smaller y values. The third group has smaller x and y valuesthan p. And
the fourth group haslarger x values and smaller y values. From each group, the point closest to
p isthen chosen. Thisgivesnormally four points, all surrounding point p. A linear interpolation
of the z, value from these four points is then done, based on the inverse of the distance from
the pointsto p. The following lineis written to the boogie.bed file:

“First: 10 20 345 456 345 321"

Thetwo first integers are thei and j indexesfor point p. The four following indexes denote the
four surrounding points. The numbering follow the order of the pointsin the geodata file. The
first point in the geodata fileis 1, the second 2 etc.

Some special algorithms are used if there are no geodata pointsin one or more of the groups.
If there are no pointsin two or more groups, then the algorithm may fail. Then azero z, value
will be given to point p. Also, the following warning message will be written to the boogie.bed
file:

Warning, null value first loop for i,j=10 20
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For this example, p islocated at (10,20).

It isrecommended to check this after abed interpolation, or look at the contour map of the bed
levels. This should be checked for areas where the bed level is zero. If this occur, the z, level
should be given in the koordina file, using an editor.

Also note that if a geodata point is located within a distance of 0.05 meters from p, then the z
value of this point is used instead of the interpolation. Then the following line iswritten to the
boogie.bed file:

Using exact value for 10 20 4.567
In this case, the value for point (10,20) is 4.567 meters.
Note, the value 0.05 meters can be changed by the user, by giving it on the F 47 data set.
Theminimum algorithm
This agorithm was devel oped during the work with the Soknariver in 1994. The Soknariver
had very large stones, and a porosity approach was used to include their effect. The geodata
file contained alarge number of points for each grid cell, and the default bed interpolation al-
gorithm gave the average bed level of the surrounding measured points. For this case, we
thought thiswas atoo high value. A lower value would better enable modelling the flow close
to the bed, between the stones.
A similar procedure to the default algorithm isinitially used, where the geodata points are di-
vided into the samefour groups. Thenthe average cell size closeto piscomputed, and al points
further away from p than this are discarded. In each of the four groups then the following two

parameters are computed:

- the average bed level
- the minimum bed level

This gives altogether eight numbers in the four groups, if there are sufficient geodata points
available. The eight points are then averaged, by adding them an dividing by eight. Thisgives
the bed level in point p.

Thisagorithm gives alower bed level, and often a smoother bed.

If there are no pointsin any of the groups, the algorithm will fail. The bed level in point pis set
to zero, and the following error message is written to the boogie.bed file:

Could not use internal interpolation for i,j=10 20

If there are no pointsin one of the groups, the following warning message will be written to the
boogie.bed file:

76



Warning, using skewed value for i,j= 10 20

This algorithm will not use the exact value of one of the geodata points, if this point is very
closetop.

The cross-section algorithm

This algorithm was devel oped as an attempt to give a better bed interpolation if the geodata
points are taken from measured cross-sections. Thisis often the case, as cross-sections are tra-
ditionally measured for one-dimensional numerical models.

It is now assumed that the modelled geometry resembles ariver, and that the grid lines follow
the streamlines reasonably well. And that the cross-sections are reasonably normal to the flow
direction and the grid linesin the longitudinal/streamwise direction.

At point p, two vectors are first computed: along the grid line in the downstream direction, and
in the upstream direction. Then the vector from p to each of the geodata points are computed.
The dot product between this vector and the vector in the downstream grid direction is comput-
ed, to seeif thetwo vectors are parallel. Also, the distance to the geodata points are computed,
to select the geodata pointsin the closest cross-sections. (upstream and downstream of p). The
two points forming the smallest angle on the left and right side of the grid line vector are se-
lected. A linear interpolation between the points are done, based on the angles. This gives one
bed level for the downstream direction. Then the same is done for the upstream direction. The
two values are then linearly interpolated, based on the distance between the selected geodata
points and point p.

The algorithm basically interpolates between four geodata points. The number of these points
are written to the boogie.bed file:

Internal: 10 20 345 346 453 454
Asfor the default algorithm, the exact value of the geodata point will be selected if the pointis
within adistance 0.05 metersfrom p. The same message will then be written to the boogie.bed
file.

Using exact value for 10 20 4.567
If for example there are no cross-sections at one side of the grid point, the outcome of the algo-
rithm is not determined. If the algorithm does not find any points, zero indexes will be written
to the boogie.bed file, for example:

Internal: 10 20 0 0 453 454

Then it is advisable to check the bed levels for these points.
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4.3.5 Displaying measured bed changesin SSIIM 2 for Windows

Measured bed changes can be displayed in SSIIM 2 by using the following method:

1. First agrid has to be made of the geometry. The grid would typically be made from a geo-
data file, taken from the assumed lowest bed levels. For example after the flushing, or before
sediment deposition. The grid isthen written to the unstruc file. When thisfileiswritten, afile
called koomin.bed is also written. Rename thisfile, so it is not overwritten later.

2. Add an F 249 1 data set to the control file. Thiswill allow both positive and negative values
of the bed elevation changes. Make sure you are using a SSIIM 2 executable made after 14.
February 2010.

3. Usethe same grid asin point 1, but now change the geodeata file to the one from the other
bed level. Use thisfile to make a new bed level with the same grid asin point 1. Write the
unstruc file

4. Start the program with the unstruc file from point 3 and the koomin file from point 1. The
koomin file must now be called koomin and it must not have any extension.

5. The variable "sediment thickness' will now be the difference between the two bed levelsin
the two geodatafiles. This can be displayed in the SSIIM graphics, or written to the ParaView
or TecPlot files. If the variable does not show up when the Tecplot/ParaView file iswritten
directly from the menu, it is necessary to add the parameter 't' on the G 24 data set and use an
F 48 option in the control file to produce the Tecplot/ParaView files.

6. Theinitial water volume of the reservoir iswritten to the boogie file at the beginning of
each transient sediment computation. Using the two unstruc files from point 1 and 3 will give
two volumesfor thereservoir. Aslong asthe water level isthe same, the difference in volumes
will give the volume of the deposited/eroded sediments in the reservoir.

4.4 The Discharge Editor (SSIIM 2)

Because the grid is unstructured, it is not possible to give water discharges and flow of other
constituentsin the control file. The number of the grid lines are not easily obtained. Instead,
the discharges are given in the Discharge Editor. The values are stored in the unstruc file.

The discharge editor isinvoked from the Input Parameters option in the main menu for the
OS2 version. For the Windows version, it isinvoked from the View option in the main menu.
It is somewhat similar to the grid editor, in that the grid is shown in the main menu. The user
can choose between two types of discharges: side discharges, for example inflow from an
upstream river, or surface discharges, for example a pollutant spill in the centre of alake.
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Side discharges

The side discharges are organised in ten groups. Each group has a water discharge, and some
characteristics. Among the characteristicsisif it isan inflow or an outflow. The user first
chooses which group to give data for. Then the datais given in the dialog box emerging from
the Give values option in the menu. Afterwards, the user chooses Add surfacesto define which
surfaces belong to the discharge group. The surfaces are then added by clicking on the grid
with the mouse. If the wrong surface is added, choose Remove surface from the menu.

When adding a surface to a group, the user clicks on aline which may correspond to several
surfaces, placed vertically above one another. In the dialog box the user gives two integers
showing the lowest and highest surface number to add.

Note if side discharges are used, there must be at least two groups: one inflow group and one
outflow group. Also, the sum of the dischargesin the inflow group must be equal to the sum of
the discharges for the outflow group.

One lineiswritten to the boogie file for each discharge group above zero. This can be used to
check if the sum of the discharges are zero, and if all or too many discharge groups are used.

Surface dischar ges

The surface discharges are added in asimilar way as the side discharges. Thereis also ten sur-
face discharge groups, but they are not corresponding to the side discharge groups. Each sur-
face discharge group only has two parameters. an integer as an index for the water quality
constituent, and the amount of pollutant to add. The index correspond to the Q data setsin the
control file. The two parameters are given in an input dialog box.

4.5 Presentation graphics

There are two to three graphics modules for presentation of results. These can be invoked any
time during the calculation or afterwards. More than one module can run simultaneously for
the OS2 version. The modules are choices under the Graphics option of the main menu:

- 3D OpenGL colour graphics (not for SSIIM 2 for Windows)

- Contour Map (Contour map isincluded in Map for the Windows versions)
- Map

- Longitudinal profile

- Cross-sectional profile

- VerifyProfile

- VerifyMap

OpenGL shows an orthographic projection of grid surfaces. If no surfaces are specified on the

G 19 data set in the control file, the bed of the geometry will be shown. Several G 19 data sets
can be used to specify three-dimensional surfaces of the geometry. The figure can be rotated,
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scaled and moved. Also, the user can choose between surfaces showing colour maps or the
grid. Various options for variables can be displayed with colours. Note the more detailed
description of the menu commands given in the following.

The OpenGL graphics includes particle animation. Further description of the animation
graphicsis given in Chapter 4.7.

Map presents the geometry seen from above. It is possible to get velocity vector plots and
plots and bar plots of concentration, diffusivity, k, etc. It is aso possible to plot the grid and
change between different vertical levels. In the Windows versions, the contour map is also
given from the same menu option.

Contour map presents the variables as contour plots, seen from above. The user can give the
values of the contour lines on the L data set in the control file. If the L data set is not given,
seven contour lineswill be used. These are calculated to be within the range of the calculated
variable field. If the option Variable under Scale is chosen, the user can give the numerical
values of the lines (OS2 version). It is also possible to choose the number of lines. Note that if
more than 7 lines are chosen, al lineswill be black. Also note that if O lines are chosen in the
dialog box, the plotting will be similar to giving no L data set in the control file. The values of
the different lines are given on the colour scale at the lower |eft corner of the window. The text
gives the values of the maximum and minimum values, and there are six equal interval
between maximum and minimum values (default). The values in the contour map of the Win-
dows versionis given in the Text view.

Profile presents a longitudinal/cross-section profile of the geometry. Graphs with different
parameters as a function of depth along the longitudinal profileis obtained. It is also possible
to view the grid or the velocity vectors. It is possible to change between different longitudinal
profiles. To see where the profileislocated in the OS2 version, look at the Map Graphics and
choose Profile in the Variables option on the menu. For the Windows version, look at the cell
numbersin both the Profile and the Map graphics. The numerical valuesfor the plot are given
on the Text view in the Windows version.

VerifyProfile presents calculated profiles of concentration or velocity at |ocations specified by
the user. It also presents user-given datain the same plot. See the next chapter for more infor-
mation.

VerifyMap presents cal culated and measured velocity vectorsin the same figure. See the next
chapter for more information.

Graphics menu system
The modules use the standard GUI for OS/2 and Windows, and have approximately the same
system of menus. Starting OpenGL graphics from SSIIM is only available for the OS2 ver-

sion.

The OpenGL graphics has an option Legend. This shows the colour legend of the plot. It can
be used in presentations by using a screen-capturing tool to move one of the legends to the
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word processor. The maximum and minimum values are shown in the bar above the menu.

The OpenGL graphics has an option Rotate. This gives the choice of rotating the three- dimen-
sional view around the X,y or z axis. Instead of using the menu, it is possible to use the <F3>
and <F4> keysto rotate around the x-axis, the <F5> and <F6> keysto rotate around the y-axis
and the <F11> and <F12> keys to rotate around the z-axis.

The OpenGL graphics also has amenu called Surfaces. This option specifies which surfaces
are shown and the properties of the surfaces. There are basically two properties: the surfaces
can be shown with colour shading or the grid can be shown. There are three modesto show the
properties. All surfaces colour shaded (Filled), al surfaces shown as grids (Grid) or a mixed
mode where the user have to define which surfaces are shown as grids and which are shown as
colour shaded (User-defined grid/filled). The same menu aso defines how many surfaces are
shown in aspecified list. Thisis done by the Add and Remove last options in the menu. The
list is specified on the G 19 data sets in the control file, or defined in the dialog box, activated
by the Define option in the menu. The define dialog box is used to define new surfaces or
modify existing surfaces. The user basically decidesthe same parameters as given on the G 19
data set in the control file. Note that it is possible to store the data on the G 19 data set by writ-
ing the control.new file in the menu of the main program.

The option Move is used to move the plot upwards, downwards or sideways. The arrow keys
can be used instead of the menu.

The option Scale is used to enlarge, shrink or distort the plot. The keys <Page Up> and
<Page Down> can be used for scaling. Some of the graphs also use <CTRL> + arrows for
distorting the plot.

For the OpenGL plots, sub-menu under Scale can be used to move the colour scale to red or
blue. Thisis also visualised in the Legend view. The <F7> and <F8> keys can be used for the
same purpose.

An option in the menu bar is Graph. The pull-down menu displays different parameters that
can be shown.

An option on the menu bar of the OS/2 version is System or Save. The pull-down menu of Sys-
tem has the option Save. Thisisused for storing the plot in an OS2 metafile. The names of the
metafiles file will be mapfl000.met, longf000.met, color 000.met, conto000.met, vprof000.met,
bedfl 000.met or cross000.met, depending on which of the graphics procedures that produced
thefile. If thereis an existing file with the same name, this will not be overwritten. Instead a
new file with last characters 001 instead of 000 will be written. If thisexist, further increments
in the number in the name will be made, until number 999.

Printing from the Windows versions is done directly with the Print option in the main menu.
Importing SSIIM graphicsinto documentsin Windows

The Windows versions of SSIIM can copy most of the graphics (not OpenGL) to the Clip-
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board. Thisisakind of agraphics storage space. What isin the Clipboard can be seen with the
Clipboard Viewer. The Clipboard Viewer isa program that is included in the Windows operat-
ing system. It is also called Clipbook Viewer in some Windows versions. It can most conven-
iently be started from a command prompt. The command prompt is started from the main
Windows menu as a window. In this window, text commands can be given. Writing clipbrd
<CR> startsthe Clipboard Viewer. (<CR> means Carriage Return).

The Clipboard Viewer has two windows: aloca one and a global one. When the Clipboard
Viewer is started, the local window is often shown. This needs to be minimized. And then the
global window (the other one) is maximized. The Clipboard is then ready to view the graph-
ics. Graphicsfrom SSIIM is copied to the Clipboard using the SSIIM menu: Print -> Copy to
Clipboard. Theimage is then seen in the Clipboard Viewer.

The graphicsin the Clipboard Viewer can be saved to Clipboard files. Thisis very convenient
when storing graphics. Theimage in the Clipboard Viewer can also beimported directly into a
document, for example a Word file, using the menu File -> Import from Word.

For some unexplained reason, it was sometimes not possible to copy directly from SSIIM into
Word. It was then necessary to follow the procedure above, using the Clipboard Viewer and
save thefilesto disk first. However, this problem seems to have been solved with the newer
versions of compilers and Windows.

It isalso possible to read old Clipboard filesinto the Clipboard Viewer, and then import the

images into the Word document. Thisisvery practical when making reports and other publica-
tions.

4.6 Verify graphics

The purpose of the Verify Graphicsisto smplify comparison of the results from SS 1M with
measured values. It can conveniently be used in publications and other documentation of CFD
studies.

The measured values are given in the verify file. AlImost all measured values can be shown:
velocities, turbulent kinetic energy, turbulent diffusion, pressure, sediment concentration or a
water quality constituent. There are two types of verification plots:

- Velocity vectors, seen from above
- One or more vertical profiles

Velocity vectors

The velocity vector verify graphicsisinvoked in the Map graphics of the Windows versions.
A separate window is used in the OS2 version.

For the velocity vector verify graphics, only the first pair of valuesin each measurement point
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of the verify file will be used. These will be displayed together with the ordinary velocity vec-
tors. Care must be taken when deciding about the vertical elevation of the measuring points
compared with the elevation of the grid cells. The vertical distances should correspond. If not,
it may be possible to change the vertical distribution of the cells, on the G 3 data set. Also, the
user must choose this level when viewing the graphics. It is advisable to use a separate verify
filefor each vertical level of velocity measurements.

Verify profiles

The verify profile show the water body from the side/cross-section, where a number of points
inthe vertical have been measured at one or more locations. The profile verification showsthe
measurements with crosses, and lines for the calculated results.

The verify profileisinvoked in a separate window in the OS2 version, and in a separate View
of the Windows versions.

The following parameters can be used:

- Horizontal velocity (see below)
- Vertical velocity

- Pressure

- Turbulent Kinetic energy

- Epsilon

- Eddy-viscosity

- Sediment concentration

- A water quality constituent

Showing horizontal velocities, the x and y components can be given in the verify file. The ver-
ify profile graphics can then show comparisons of:

- the magnitude of the velocities

- the component in the x-direction

- the component in the y-direction

- the component parallel to the longitudinal profile (Windows only)
- the component parallel to the cross-section (Windows only)

The profile verify graphics shows the measured profiles and the calculated values in the cell
closest to the location of the measurements. The profiles may be taken in a cross-section or a
longitudinal profile, or any other arbitrarily aligned line in the geometry.

Separate verify files should also be made for each variable. Note the vertical velocity istreated
asascalar variable, and must be given in a separate file.
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4.7 Animation

The purpose of the animation moduleisflow visualisation. The module displaysa 3D view of
the geometry, and animates the movement of a sediment particle. The movement of the parti-
cle will depend on the flow field and the fall velocity of the particle.

The animation graphics was made using the OpenGL graphics library. The modules were
incorporated in the OS2 .exefiles. This was not possible for the Windows version running
Windows 95 or Windows 98. The Windows versions of SSIM therefore does not have anima-
tion graphics. A separate program with only OpenGL graphics was made to run on Windows
NT. Thisonly worksfor SSIIM 1 files.

The animation is a part of the OpenGL graphics. In the OS2 versions, the menu options will
refer to the Particle option in the OpenGL menu.

The main ideaisto release a number of particles simultaneously from the inflow regions of
the geometry. Thisis done when the user chooses Release in the menu. The default number of
particlesis equivalent to the number of cellsin theinflow area. Thereis one particle for each
cell. The user can change this by choosing a different number in the Space direction option in
the menu. Space direction 2 means that every other cell will have a particle etc.

The module will guess acertain time step, and move the particles accordingly. Sometimesthis
will be too slow or too fast for the visualisation. The user can adjust the speed by choosing
Double Speed or Half Soeed in the menu. This can be repeated.

A model to take turbulence into account is also implemented. Thisisfairly crude, and gives a
random movement according to the turbulent kinetic energy of the flow. The random move-
ment is isotropic. Including turbulence or not is determined by the options No Turbulence and
Include Turbulence in the menu.

When the particles hit the boundary, there are two options: the particles can stick, or be
reflected. Thisis given by the user in the Boundary choice in the menu.

Thefall velocity of the particles can aso be given by the user in the Fall velocity option of the
menu. Sedimentation can thereby be visualised.



Chapter 5. Input/result files

5.1 Thefile structure

The OS/2 and Windows versions use the same input files and produce the same resullt files.
The files can be interchanged between the versions.

A flowchart describing the various files are given below. Note that most of the files are only
used for special purposes and they are normally not required. Some of the files are output
files. The program can produce many of the input files. For ssmpler cases all the necessary
input files can be generated by the program.

koosurf  |<a—p| control
koordina |<— result
SSIIM 1.0
geodata |a—» timel
e
boogie |g | compres
Interpol > Interres
unstruc  |<a—» control
koordina |<— result
SSIIM 2.0
geodata |a—» timel
e
boogie |g | compres
Interpol > Interres
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All thefilesare ASCII files. Note that the names of the files can not be changed. The best way
to run different simulations is therefore to create a sub-directory for each case.

The two main input files are the control file and the koordina file for SSIIM 1. The koordina
file contain the grid geometry. The control file contain many of the other parameters. Thefiles
have to be present when the program starts. If not, adialog box will emerge and the user is
prompted for the main parameters. The program then generates default files. The control file
can then be edited afterwards, using a standard editor. The koordina file may also be generated
by a spreadsheet.

For SSIIM 2, the unstruc file contains the grid and water discharges. Asit can only be pro-
duced by SSIIM 2, it is not necessary to be present when the program starts. SSIIM 2 also
need the control file, but default values will be used if it isnot present at the start of the calcu-
lation. The control filefor SSIIM 1 and SSIIM 2 are similar, and much of the content is the
same for the two versions. However, there are some data sets that are unique to SSIIM 1 or
SSIIM 2.

In the following, each file is described.

5.2 The boogiefile

Thisisafilethat shows aprint-out of intermediate results from the calculations. It al'so shows
parameters as average water velocity, shear stress and water depth in the initialisation. Trap
efficiency and sediment grain size distribution is also written here. If errors occur, an explana-
tion is also often written to this file before the program stops. Thefile containsthe datathat is
normally written to the screen in a DOS program.

The option D on the F 1 data set will give additional print-out to thefile.

Initiadly in thefileit iswritten how much memory that is occupied by the arrays that are
dynamically alocated. To estimate the total recommended memory requirement for SSIIM,
add the size of the SSIIM executable to this value.

A table then follows, which shows the cross-sectional area, hydraulic radius, average velocity
and water level at the cross-sections that have been used for initializing the water surface. If
the option D on the F 1 data set is used, thisinformation iswritten for al the cross-sections
additionally. Then atable of waterlevelsfor al cross-sectionsfollows. An exampleisgiven
below:

Loopl,iter,area,radius,velocity,waterlevel: 12 1.002389e+ 00 1.002389e+ 00 9.976163e-01
1.002390e+00

Loopl,iter,area,radius,vel ocity,waterlevel: 11 1.001588e+00 1.001588e+ 00 9.984146e-01
1.001589e+ 00

Waterlevel = 1.000398 meters for cross-sectioni = 10

Waterlevel = 1.000797 meters for cross-sectioni = 9
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Waterlevel = 1.001195 meters for cross-sectioni = 8

If the MB-flow module is used, the residual norms are written. Then follows a sequence of
two linesfor each iteration of MB-flow. An example with four iterations is shown below:

Iter: 5, Resid: 1.69e-05 4.10e-06 2.73e-05 1.17e-04 1.38e-02 1.13e-02
Cont: 9.23e-08, DefMax: 1.65e-03, U,V,\W(96,7,20): 6.40e-01 -5.14e-03 5.76e-02
Iter: 6, Resid: 1.62e-05 3.85e-06 2.62e-05 1.10e-04 1.31e-02 1.08e-02
Cont: 9.23e-08, DefMax: 1.56e-03, U,V,W(96,7,20): 6.40e-01 -5.14e-03 5.76e-02
Iter: 7, Resid: 1.57e-05 3.65e-06 2.50e-05 1.04e-04 1.25e-02 1.03e-02
Cont: 9.23e-08, DefMax: 1.48e-03, U,V,W(96,7,20): 6.40e-01 -5.14e-03 5.76e-02
Iter: 8, Resid: 1.51e-05 3.46e-06 2.38e-05 9.86e-05 1.18e-02 9.77e-03
Cont: 9.23e-08, DefMax: 1.41e-03, U,V,\W(96,7,20): 6.40e-01 -5.14e-03 5.76e-02

Thefirst line has the word "Iter" at first. Then an integer follows, which shows the number of
the iteration. In the example above this runs from iteration number 5 to 9. Then the residuals
for the six equations are shown. The x,y and z velocity equations are first, then the pressure
equation and the k and e equation follow. All these must be under 10-3 before the solution has
converged.

The second line starts with the word " Cont:". Then afloating point value is shown. Thisisthe
sum of all the water inflow and outflow in the geometry. This should be avery low value, typ-
icaly under 10-7. If alarger valueis given, check the boundary conditions. Then the word
"DefMax" iswritten. Theresidual for the cell with largest water continuity defect isthen writ-
ten. Theindexesfor this cell are then written, with the velocitiesin the three directions for this
cell. Initeration 9 for the example above, the maximum water continuity defect was 1.41e-3
kg/sfor cell i=96, j=7, k=20. The velocity in the x-direction for this cell was 0.64 m/s, the
velocity in they direction was -5.14 mm/s and the velocity in the vertical direction was5.76
cm/s.

5.3 The control file

The control file gives most of the parameters the model needs. The main parameters are the
size of the arrays used for the program. To generate the water surface it is necessary to know a
downstream water level, together with the water discharge and the Manning-Strickler’sfric-
tion factor. These parameters are given on the G 1 and the W 1 data set in the control file. If the
control file does not exist, the user is prompted for these parameters in adialog box. The user
can then later choose Write control in the File option of the main menu, and get a control file
written to the disk (as control.new). This can then be edited according to the user's needs. Note
that only the most used parameters are written to the control.new file.

During the water flow calculations there are several parameters that can be varied. These
parameters affect the accuracy and the convergence of the solution. Some of the parameters
can be modified while the water flow field is being calculated. A dialog box with the parame-
tersisinvoked by choosing Waterflow parameters from the Input Editor choice in the main
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menu.

The control file contains most of the other data necessary for the program. SSIIM reads each
character of the file one by one, and stopsif acapital letter is encountered. Then adataset is
read, depending on the letter. A data set is here defined as one or more numbers or letters that
the program uses. This can for example be the water discharge, or the Manning-Strickler’s
friction coefficient. It is possible to use lower-case | etters between the data sets, and it is possi-
ble to have more than one data set on each line. Not all data sets are required, but some are.
Default values are given when a non-required data set is missing. SSIIM checks the data sets
in the control file to a certain degree, and if an error isfound, a message is written to the
boogie file and the program is terminated. Note that if more than one numbers are needed on a
data set, these are separated by a space, and not by any other character.

Important note: The F and G data sets should be given before any other data sets. These
data sets should also be ordered according to their number. Thisis because the data may be
checked against the size of the grid.

In the following the data sets for the control file is described:

5.3.1 TheF data sets

F1 Debugging option. If the character that followsisaD, onewill get amore extensive
printout to the boogiefile. If the character is a C, the coefficients in the discretized
equations will be printed to the boogiefile.

For SSIIM 1, if the character is Q, then the program will allow a grid with negative
areas. Otherwise, the program will stop when negative areas occur. The Q option can
be useful when making a complex grid.

If the character is a P, then time-stamps are written to the boogie file from different
parts of the program. The purpose isto find parts of the program where improvements
can be made in the parallelization.

If the character isan A, then the grid is checked for possible errors, and error messages
are written to the boogiefile.

F2  Automatic execution possibility. Some parts of the program will be executed directly
after theinitialisation if a character is placed in thisfield. The modules will be exe-
cuted in the order they are given. The possibilities are:

Read the result file

Initialize sediment concentration computation

Calculate sediment concentration

Start the water flow computation

Read the unstruc file (only SSIIM 2)

Read the XCYC file (only SSIIM 1)

Compute water quality (SSIIM 1)

Compute water quality (SSIIM 2)

Write the results from the water quality computation (SSIIM 2 only)
Read the results from the water quality computation (SSIIM 2 only)

OMOOXCSEW—

88



Fa

F6

F7

End the program and exit (SSIIM 1)

End the program and exit (SSIIM 2)

Write the result file

Write the unstruc file (SSIIM 2)

Regenerate the grid (SSIIM 2)

Interpolate the bed levels from the geodatafile (SSIIM 2)

(SSIIM 2) Compute bed roughness from the geodata file and write
bedrough.new file

AL<KIZIX>»

Examplel: F 2WSA

The program will first compute the water flow, then compute the sediment flow and
then exit. Thisisfor SSIIM 1.

Example2: F 2URIS

The program will first read the unstruc file, and then read an initial water flow field
from the results file. Then the sediment concentration field isinitialized and the sedi-
ment transport is computed. This combination is often used for time-dependent mor-
phological computations. The unstruc fileisonly read in SSIIM 2. For SSIIM 1, theU
Is omitted.

Note that there must only be spaces between the number 2 and the letters on the data
sets. If tabs are used, the letters may not be read.

Relaxation factor for second order interpolation of bed concentration, maximum itera-
tions for concentration cal culations and convergence criteriafor suspended sediment
calculation. The convergence criteriais given as allowable flux deficit as part of
inflowing sediments.

Note that this data set has changed from SSIIM version 1.1
Defaults: relaxation: 0.5, iterations: 500, convergence criteria: 0.01.

Coefficients for formulafor bed concentration. Default is van Rijn's coefficients:
0.015, 1.5 and 0.3. If one uses this option, the sediment transport formula given in
dataset F 10 must be R, which means that van Rijn's formulais used.

Run options. read 10 characters. If the following capital letters are included this will
mean:

D: Double the number of grid cellsin streamwise direction in comparison to what
isgiven inthekoordinafile. Each cell isdivided in two equal parts. When this
option is used for the whole geometry, the number of grid linesin the stream-
wise direction (on the G 1 data set) must be multiplied with 2 and 1 must be
subtracted. SSITM 1 only.

J. Double the number of grid cellsin the cross-streamwise direction. The same
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F9

F 10

F11

F12

procedure for the linesin the cross-streamwise direction (G 1 data set) is
required.SSI1M 1 only.
Inflowing velocities in the y-direction are set to zero. SSIIM 1 only.

Diffusion for sediment calculations in non-vertical direction is set to zero.
SSIIM 1only.

B: Correction for sloping bed is used when calculating bed sediment concentra-
tion.

G: Cell walls at outblocked areais not changed when there are changesin the cells
outside the block. SSIIM 1 only.

V: 90 degree turning of the plot seen from above (map). Only SSIIM 1 for OS/2.

Z: Vertical distribution of inflowing sediment is uniform. SSIIM 1 only.

E: Activate aroutine that changes the flux on the wall if ap=0.

P Use porosity calculation and the porosity file. SSITM 1 only.

Note that there must only be spaces between the number 2 and the letters on the data
sets. If tabs are used, the letters will not be read.

SSIIM 1 only. Factor that is used to change the turbulent viscosity of the inflowing
water. The factor is proportional to the turbulent viscosity. Default: 1.0.

Which sediment transport formulais used to calculate the concentration at the bed.
The following options are given:

van Rijn's formula
Engelund/Hansen's formula
Ackers/White's formula
Yang's streampower formula
Shen/Hung's formula
Einstein’s bed |oad formula

—wnw<r>rma3an

Default: R.

It isonly recommended to use the R option. If adifferent sediment transport formulais
wanted, then it should be coded in the beddll. Alternatively, the Wu formulaisinvoked
by using the F 84 3 option.

Density of sediments and Shield's coefficient of critical bed shear for movement of a
sediment particle.

Default: F 11 2.65 0.047 (SSIIM 1) and F 11 2.65 -0.047 (SSIIM2).

If anegative Shield's coefficient is given, the program will calculate it according to a
parameterization of the original curve.

Schmidt's coefficient, which is a correction factor for deviation between the turbulent

diffusivity and the eddy-viscosity. The factor will affect both the water velocity and the
sediment concentration computations. Default: 1.0
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F 15

F 16

F 18

F 20

F21

F 24

If multiple sediment sizes are to be modelled, it is possible to give multiple Schmidt
numbers. Example for three sizes:

Example: F121.01.21.3

An integer giving a choice between several algorithms for wall laws. The choices are
different in SSIIM 1 and SSIIM 2.

SSIIM 1: If thevalueis 1 and therearetwo wallsin acell, only the closest (usually the
bed) will be used. If theinteger is 0, both wallswill be used. Note that the 1 option will
only work with the k-epsilon model. If the integer 3 is specified, wall shear will be
used in the source terms of the Navier-Stokes equations, and zero gradients used for k
and epsilon on the side walls. If the integer is 4, an algorithm similar to option 3 is
used, but only if the cell isbelow alevel equal to the roughness height. Above this
height, normal wall functions will be used for al variables. If the integer is 5, smooth
wall laws will be used. If theinteger is 11, arough wall law formulation by Rodi
(1980) will be used for k.

SSIIM 2: Zerois normal rough wall laws. A value of 8 will use a combination of
rough and smooth wall laws if the roughnessis small. A value of 19 will use smooth
wall laws on the sides and rough on the bed.

Default; F 150

Roughness coefficient which is used on the side walls and the bed. If not set, the coef-
ficient is calculated from the Manning-Strickler's friction coefficient (van Rijn, 1982).
Vauesin the bedrough file overrides this value for the bed cells.

Density current source. A float isread, and if it is above 10-6, the sediment density
term in the Navier-Stokes equation is added. The float is multiplied with the density
term, so avalue of 1.0 isrecommended when thisterm is needed. Default 0.0 (the term
is not used). Note that this option has not yet been tested.

SSIIM 1 only. Repesated calculation option. An integer is read, and the calculation
sequence on the F 2 data set will be repeated this many times. Note that the graphical
view of the bed level changes (only OS/2 version) will only appear on the last iteration
when sediment calculations are done. Also note that if aresult fileisread in the F2
data set, it isonly read during the first iteration.

Relaxation coefficient for the Rhie and Chow interpolation. Normally a value between
0.0 and 1.0 isused. When 0.0 is used the Rhie and Chow interpolation will have no
effect. When 1.0 is used the Rhie and Chow interpolation will be used normally.
Default 1.0.

Turbulence model. An integer isread, which corresponds to the following models:
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F 25

F 26

F 33

F 36

0: standard k-¢ model (default)

1: k- model with some RNG extensions

3: local k-€ model based on water velocity

4: constant isotropic eddy-viscosity model, value given on F 72 data set. Only SSIIM 2

5: local k-¢ model based on wind shear

6: constant non-istotropic eddy-viscosity model, vertical and horizontal values
given on the F 77 data set

7: eddy viscosity = 0.11 * depth * shear velocity (Keefer, 1971)

10: zero-equation used in shallow areas only, k-epsilon elsewhere. Only SSIIM 2

14: Spalart-Almaras model, only for SSIIM1, not fully implemented

15: K-omega model with Wilcox'swall laws, only for SSIIM 1, not tested

16: K-omega model with k-epsilon wall laws, only for SSIIM 1.

Note that not all models are implemented in both SSIIM versions.

Porosity parameters. Four floats and one integer are read. Thefirst float is the mini-
mum porosity. The second float is arelaxation factor for the porosity computation. The
third and fourth floats are roughness values used in the porosity computation. The last
number, the integer, is an index giving which algorithm to use for the computation of
the diameter in the equation.

Default: F250.352.00.50.85

Fraction of compacted sedimentsin bed deposits. Or 1.0-water content of sediments at
bed.

Default: F 26 0.5 (50 % water)

Transient water flow parameters. A float and an integer isread. Thefloat is the time
step. Theinteger isthe number of inner iterations for each iteration. Transient terms
will beincluded in the equationsiif this data set is present.

Computation of the vertical elevation of the water surface. Aninteger isread. If itis2,
the water surface will be updated based on the computed pressure field. The cell given
on the G 6 data set will be kept fixed as areference level.

For SSIIM 1:

If the integer is 1, the gravity will be included in the solution of the Navier-Stokes
equations, and the water level will be computed based on the computed water deficit/
surplusin the cells close to the water surface. This algorithm is very unstable, and a
very short time step needs to be used. The algorithm is only used when computing
coefficient of discharge for a spillway, or flood waves with steep fronts.

For SSIIM 2:

More algorithms can be used: F 36 3: the initial water surface is moved up/down
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F 37

F 38

F 40

F 41

F 42

F 47

equally in all cells according to downstream changes in water surface specified in the
timei file. F 36 4: the water surface elevation is computed solving apartial differential
equation for the local slope as a function of the pressure gradients to the four neigh-
bour cells. F 36 8. Same as F 36 4, but the eight closest neighbour cells are used. The
algorithm invoked by F 36 7 is described by Olsen and Haun (2010). Note that some
variations of this algorithm are invoked by the F 278 data set.

An algorithm with gravity has also been developed for SSIIM 2. It isimproved from
the algorithm in SSIIM 1 and it seems much more stable. The algorithm isinvoked by
F 36 15. One of the example cases on the SSIIM web page uses this option.

Default: F36 0

Transient sediment computation. An integer isread. If thisis 1, the transient sediment
computation (TSC) algorithmswill be used. This option is always used when doing
time-dependent computations of sediment transport, and a'ways when computing
changesin bed levels. If the integer is 2, then a different algorithm is used for the bed
cells, where the sediment concentration formulais converted into an entrainment rate.
This can give dlightly smaller bed movements where the bed sediment concentration is
not in equilibrium.

Default: F 370

SSIIM 2 only: If theinteger is 3, then an agorithm is invoked where more than two
bed layers can be used. (active + inactive layer = 2 layersfor F 37 1 and 2).

Residual limit for when warning messages are written to the boogie file.
Default: F 38 107

Turbidity current parameter. If thisis unity the extraterm in the Navier-Stokes Equa-
tion are taken in that takes into account the effect of gravitational forces on water that
have higher density because of high sediment concentration. If thisis above 0.001, the
term is still incorporated but relaxed with the factor on the data set. Default 0.0.

SSIHIM 2 only. Sediment thicknessin meters. Default value is the maximum size of the
sediments given on the Sdata sets.

SSIIM 2 only. Level of non-erodible material. This data set can be used instead of the
koomin file.

Bed interpolation parameter in meters. Onefloat isread, which isused in the bed inter-
polation routine that are called from the Grid Editor. If the points given in the geodata
file are located a horizontal distance under the interpolation limit, than the interpola-
tion routine will use the exact value of the geodata point instead of interpolating from
surrounding points. Default: 0.05 m.

93



F 48

F 50

F 51

F 52

Parameter for print-out of specia files and interpolation of results. An integer is read.
If O, then anormal result filewill be written when thisroutineisinvoked. If higher val-
ues are given, the program will not write the result file. It will search for the interpol
fileand usethisfileto write other files. If theinteger isbetween 1 and 4 aninterresfile
iswritten. If the value on the F 48 data set is 4, the bed levels will be written to the
interresfile. If 2, the velocities, k and epsilon will be written to thefile. If 3, then water
quality parameters will be written.

Default 0. See Chapter 5.12 for more details.

If theinteger is 8, afile named tecplot.dat will be written. Thisfile contains the coordi-
nates, the velocities, pressure, k and epsilon for each cell. Thefile can beimported into
the Tecplot program.

If theinteger is 5, the habitat file will be written.

SSIIM 1only: If theinteger is 19, atime will also be read from the interpol file. The
print-out to the interresfile will then only happen at thistime. If the integer is9, a2D
plan view Tecplot file will be written. If the integer is 20, afile called sumforce is writ-
ten. The file contains the pressure forces at the upstream and downstream boundary,
together with bed shear forcesin alongitudinal profile.

SSIIM 2 only: If theinteger iS5, the water velocities in the surface cell iswritten to
theinterresfile. If theinteger is 14, the value of the average velocity timesthe depthis
written to the interresfile. If the integer is 10, athree-dimensiona ParaView fileis
written. If theinteger is 12, atwo-dimensional ParaView file iswritten from the cross-
section defined in the interpol file, with the water velocities normal to the surface. If
theinteger is 18, 2D tecplot files are written for both the coarse and the nested grid. If
the integer is 19, 2D paraview files are written for both the coarse and the nested grid.
The options 88, 89, 91 and 92 will do the same asoptions 8, 9, 11 and 12, respectively,
but the result and bedres files will not be written simultaneously.

Number of water quality constituents. Default F 50 O.

Coriolis parameter.

Example: F 51 0.0001263 (lakesin South Norway)

Wind forces on the surface of the lake. Three floats are read. Thefirst float is the mag-
nitude of the wind speed in meters/sec.10 meters above the water level. The second and
third floats are components of the unity vector in the x and y direction. Note that the
vector sum must be unity.

Example: F 524.0-1.00.0

Note for time-varying wind, the valuesin the timel file overrides the values on this
data set.
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F 53

F 54

F 56

F 58

Print iterations. Four integers are read, which gives the interval for when printout to
filesare done. Thefirst integer applies to the residual printout to the boogie file. The
second integer appliesto writing the result file. The third integer appliesto writing data
to the forcelog file. The fourth integer applies to when datais written to the timeo file.

Default: F 531001001 1

This means that for example the result file is written each 100th iteration.

A float isread, which isalimit for the residual during the transient calculation. When
the maximum residual goes below this value, the inner iterations end, and a new time
step starts. Thisis recommended when doing transient computations. Default 107
Sand dlide algorithm. Aninteger and afloat isread. The float istan(angle of repose).
The integer isthe number of iterations the algorithm will go through the whole grid. If
200 is chosen, a particular algorithm is used which has given better results than the
other ones.

Default: F 56 0 1.0 (not used)

Typical valuesif used: F 56 200 0.62

Note that the angle of repose for the sedimentsis lower for sediments submerged in
water than in air. The algorithm does not work properly for more than one sediment
size.

SSIIM 1 only. Parameters for the Transient Free Surface (TFS) algorithm. The TFS
algorithm is used when including F 36 1 in the control file. Four integers and six floats
areread:

F58i1i2i3i4f1f2f3f4f5f6

Default: F5810010.022.02.00.01.00.0

i1: If thisinteger is 1, the transient terms are included in the equations. If it is zero, the
transient terms are not included

i2: If theinteger is 1, the pressure will always be positive

13: If the integer is 1, the side walls will not move vertically

i4: 1f theinteger is 1, an upwind algorithm is used to transfer the water level movement
from the center of the cell to the corners. If the integer is zero, the movement will be

equal in all directions.

f1: Parameter in the upwind algorithm for transferring the water level movementsfrom
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F 59

F 60

F 62

F 63

the center of the cell to the corner. If the parameter is zero, all the movement will take
placein the downstream direction. A very large parameter will give equal movementin
all directions.

f2: Parameter to dampen the water movement at thewalls. If the parameter is 2.0, there
will be no damping. A value of 1.0 will dampen the movement to half the non-damp-
ened value. A value of 0.0 will dampen the movement completely, so no movement
will take place at the wall.

f3: Parameter to dampen the water movement at obstructions. The numbers are the
same as for parameter f2.

f4: When the water level movesin atime step, the water surface will get a vertical
velocity, W. An algorithm isused, where the velocity in thetop cell, w, isaffected by W,
using the following formula: w = f4 W + (1-f4) w.

5: Parameter for including the acceleration of the water movement in the vertical
component of the Navier-Stokes equation. If it is 1.0, the full acceleration termis
included. If the parameter is zero, the acceleration term is not included. A value
between 0.0 and 1.0 will take the term into account, multiplied with the parameter.

f6: A factor for smoothing the water levels. If it is zero, no smoothing will be used. A
higher, positive value will give more smoothing.

Number of iterations in the Gauss-Seidel procedure. Thisis an integer which will
affect the convergence and speed of the program. A lower value will increase the
number of iterations pr. time, while slowing the relative convergence pr. iteration. For
some cases, alower value has given decreased computational time. Note that if the
TDMA solver (K 10 data set) is used, then the F 59 data set will have no effect.
Default: 10.

Correction of van Rijn’sformulafor distance from the center of the bed cell to the bed.
The data set is used to invoke inclusion of the extrapolation of the Hunter-Rouse sedi-
ment distribution when the vertical height of the center of the bed cell is different from
what van Rijn subscribed.

Default: F 60 0 0 (no use of the extrapolation)
Example: F 60 1 O (the extrapolation is used)

Integer to invoke time-dependent calculation of water quality parameters, if 1.
Default: F 62 0
Second-order upwind scheme for water quality constituents if the integer 1 follows.

Default: F 630
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F64 SSIIM 2 only. Choice of algorithm to generate the grid linesin the longitudinal and
lateral direction. Aninteger isread. If it isO, completely horizontal grid lineswill be
generated. Thisistypically used when modelling lakes, especially with density gradi-
ents.

Example: F 64 1

The F 64 1 option will also create horizontal grid lines, but the bed cellswill not be
horizontal. Tetrahedral cellsand hexahedra cellswith non-horizontal lineswill be used
along the bed.

The F 64 2 option will be similar to F 64 1, but all the non-vertical grid lines may be
non-horizontal. An example is shown in the figure bel ow.
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Example: F 64 2

-

For sediment transport computationsin rivers, the most tested option isF 64 11. This
will give abody-fitted grid with priority to hexahedral cells close to the bed. The hexa-
hedral cellswill give superior performance compared to tetrahedral cells. Since most
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of the sediment is transported close to the bed, it isimportant that the bed cells are hex-
ahedral in sediment computations.

The option 13 issimilar to 11, but has different generation criteriafor wetting and dry-
ing. The two values on the F 94 data set is then used. If the F 64 13 data set is used,
then the cells will be generated initially just like using the F 64 11 option. However,
cellswill not be generated in areas that were dry in the previous iteration, unless the
cell depths are above 0.0 meters. The value 0.0 meters can be changed by giving a dif-
ferent number on the F 162 data set.

Z

Example:
F6411
Default: F 640

F 65

F 67

See also Chapter 4.3.2 for generation of grids.

SSIIM 2 only. Grid size for the unstructured grid. SSIIM 2 hasto allocate the arrays
before the grid isread. Because it is possible to expand the grid after it isread, it is nec-
essary to givethe grid array sizesin theinput file.

Fiveintegers are read. The first integer is the maximum number of grid cellsin the
grid. The second integer is the maximum number of surfacesin the grid. The third
integer is the maximum number of grid corner points. The fourth integer is the maxi-
mum number of surfaces in connection between blocks. The sixth integer is the maxi-
mum number of connection points, used in the Grid Editor.

Default: F 65 50000 80000 50000 10000 1000

If the grid has been made, and the grid size will not increase later, it is possible to read
the sizein the unstruc file, and modify the F 65 data set so that the program does not
allocate more memory than necessary.

SSIIM 2 only. Temperature calculation with feedback from water density on the water

flow calculation if it the integer 1 follows.
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F 68

F 70

F71

F72

F73

F 76

Default: F 670
Parameter for choice of water flow computation. An integer is read.
Default: F 680

If the parameter is 2, the transient sediment computation will not re-compute the water
flow field after an update of the bed. This means a quasi-steady situation is modelled.

For SSIIM 2: If the parameter is 1, the three-dimensional calculation of the water
flow will be done using the hydrostatic pressure assumption. This means that the
Navier-Stokes solutions will not be solved in the vertical direction, and vertical veloc-
itieswill be found by the continuity equation. This option causes an extragrid block to
be made. The extrablock isthelast block and is adepth-averaged version of the whole
grid. Note that this parameter have to be the same when cal cul ations are done as when
the grid was created.

SSIIM 2 only. Wall laws removal option. Aninteger isread. If 1, thewall lawswill be
removed from the side surfaces. If 2, the wall laws will be removed from the side and
the bed surfaces.

Default: F 700

Turbulence decrease because of density stratification. An integer isread. If 1, the tur-
bulent eddy-viscosity is decrease according to the Richardson number and the proce-
dure given by Rodi (1980).

Default: F 710

Minimum turbulent eddy-viscosity. A float isread. The eddy-viscosity for water flow,
turbulent kinetic energy and water quality constituent calculations will not be
decreased below this value.

Default: F 72 0.001

Choice of wind friction formula. This formula gives the shear stress of the water sur-
face as afunction of the wind. The options are:

0: van Dorn (1953), cp = 1.0x10°3 under 5.6 m/s, increases over 5.6 m/s

1: Bengtsson (1973), cp = 1.1x10°3

2: Wu (1969), three non-continous bands of ¢y as a function of wind speed

Default: F 730

SSIIM 2 only. Turbulence reduction factors. Three floats are read. The two first floats

are multiplied with the eddy-viscosity in the horizontal and the vertical direction
respectively, thereby reducing and possibly creating a non-isotropic eddy-viscosity.
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F77

F 78

F 81

F 82

F 83

F 84

The third float is related to the decreased eddy-viscosity because of density stratifica

tion. If itis zero, the eddy-viscosity decrease factor will be applied isotropicaly. If itis
unity, the factor will only be applied to the vertical eddy-viscosity. For values between
zero and unity, the factor will partly be applied only vertically and partly isotropically,
creating a more or less non-isotropic eddy-viscosity.

Default: F 76 1.0 1.0 0.0

SSIIM 2 only. Constant non-isotropic turbulent eddy-viscosity. Two floats are read,
the horizontal and the vertical eddy-viscosity. Note that the F 24 data set must have the
parameter 6 for this data set to be used.

Default: F 77 1.0 1.0

Bed load vector parameters. An integer and afloat is read. The bed load on atrans-
verse sloping bed may not move in the direction of the water velocity close to the bed.
If theinteger is 1, an algorithm taking thisinto account is used. Note that thisisfairly
untested yet, especially for SSIIM 2.

In SSIIM 2, an integer 10 can be given as the first integer. The algorithm will then use
the average sediment diameter instead of the diameter of each size. In SSIIM 2, thisis
the only option for using the algorithm with multiple sediment sizes.

Number of time stepsin thetimei file. An integer isread.

Default: F 81 200

Parameters to decrease the eddy-viscosity as a function of the water density gradients
and the Richardson number. In the formula, the alpha and beta are constants. This data
set gives the alpha and the beta for the velocity and the temperature/other constituents.
Four floats are read.

Default: F 82-0.510.0-1.53.33

Coefficientsin van Rijn’s formulafor bed load sediment transport. Four floats are
read.

Default: F 830.0532.10.31.5

Flag to indicate the sediment transport formula. An integer isread:
0: Suspended load formula by van Rijn

1: Bed load formula by van Rijn

2: Both suspended and bed load formulas by van Rjin

3: Wu'sformula
5: Meyer-Peter and Mllers formula (SSIIM 2 only)
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F 85

F 86

F 87

F 90

F 92

Default: F 840

SSIIM 2 only. Flag indicating that the computation should not stop if water continuity
isnot satisfied. Thisisinvoked if 1isgiven.

Default: F850

SSIIM 2 only. Minimum grid corner height. Thisis used to prevent very small grid
cell heights. If the corner grid cell islower than thisvalue, it is set to zero. Note that
this only works for the F 64 5/11/13 options.

Default: F 86 0.001 (1 mm)

Thisinformation can alternatively be given on the F 94 data set. Then the parameter on
the F 86 data set will be equivalent to the second data set on the F 94 data set. Thefirst
parameter on the F 94 data set will be set to 1/4 of the F 86 value.

SSIIM 2 only. Parameter for number of grid cells, n, in the vertical direction asafunc-
tion of water depth, y. The value is the p parameter in the following formula:
Y )P

n = nmax(ym

The Ny, Number is the third integer on the G 1 data set.
Default: F 87 0.6

Roughness option. An integer isread, giving several options how the roughnessin the
wall laws should be cal cul ated:

0: Thevalueonthe W 1 or F 16 data set is used.

1: The bedrough file isused (SSIIM 1 only)

2: Theroughnessiis calculated from the bed grain size distribution (dgg)

3: Theroughnessis calculated from dgg and the bed form height

4: Same as 3, but the critical shear stress for sediment movement is reduced so that
only the grain roughness effect is taken into account.

Default: F900

SSIIM 2 only. Algorithms to reduce velocity in cells with small depths. An integer is
read:

1: Wall laws are used in more than one cell
2: A drag formulais used for velocities where the roughness is higher than the cells

Default: F 92 0 (Algorithm is not invoked)
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F 94

F 99

F 100

F 102

F 104

F 105

F 106

SSIHIM 2 only. Minimum grid corner height and maximum grid corner height for gen-
eration of one cell. Two floats are read. The first float is used to prevent very small
grid cell heights. If the corner grid cell islower than thisvalue, it is set to zero. The
second float gives the depth of having only one cell in the vertical direction -> 2D cal-
culation. Note that this only worksfor the F 64 11 and 13 options.

Example: F 94 0.001 0.01 (default)
Grid cellsunder 1 mm will not be generated, and all cellsunder 1 cm will be 2D.

SSIIM 2 only. Integer to determine how often the grid is regenerated for time-depend-
ent sediment flow cal culations with moveable bed.

Default: F 991
Example: F 99 10
The grid will only be regenerated for every 10th time step.

Sometimesit isnecessary to use F 99 1 to be able to read the bedresfile together with
the other files, when starting from a previous computation.

SSIIM 1 only. Integer to determine if the second term of the Boussinesg equation is
included. If theinteger is 1, it isincluded.

Default: F 1000

SSIIM 2 only. Integer to invoke an agorithm to change the shape of the grid cells
close to the boundary. If the integer is 1, the algorithm isincluded. Thisalgorithmis
recommended for wetting/drying computations.

Default: F 102 0

SSIHIM 2 only. Integer invoking an agorithm to prevent crashes when asingle cell is
formed. The algorithm is only invoked if the integer is above zero. The algorithm will
add avalueto the a, coefficient in the pressure-correction equation of SIMPLE. This
will only be used in the cells that have no neighbour cells. The value added is the inte-
ger multiplied with the volume of the cell.

Default: F 104 0

SSIHIM 2 only. Aninteger isread, giving the number of iterations between each update
of the water surface elevation for time-dependent cal culations.

Default: F 105 10

A float isread, giving the thickness of the upper active sediment layer. The default
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F 107

F 108

F 109

F 110

F111

F 112

valueis equal to the maximum sediment grain size diameter on the Sdata sets.

SSIIM 1 only. Upstream water elevation in the TFS algorithm. Aninteger isread. If it
is 1, the TFS algorithm will compute the water level of the most upstream cross-sec-
tion using a 1D backwater algorithm, from the second most upstream cross-section.
Thisisdone automatically if G 7 data sets are not used, so then this data set is not nec-
essary.

Default: F 107 0
SSIIM 1 only. A minimum water depth used by the TFS agorithm.
Default: F 108 0.02

Parameter in Brook’s formulafor reduction of the critical sediment particle shear
stress when the bed slopes.

Default: F 109 1.23 0.78 0.2

The two first floats are the inverse of tan(0) for uphill and downhill slopes, where 6 is
akind of angle of repose for the sediments. 0 is actually an empirical parameter based
on flume studies. The third float is a minimum value for the reduction factor.

SSIIM 2 only. Parametersfor limiting the effect of the Hunter-Rouse extrapolation for
sediment concentration computed in areference level different from what van Rijn
subscribed. The parameter will only have effect when used with the F 60 data set.

Default: F 110 2.0 0.01

BEDDLL parameter. Aninteger isread. If it is 1, the sediment transport algorithmsin
the beddll.dll file are used instead of the default algorithms.

SSIIM 2 only. Aninteger isread. If it is 1, the program will regenerate the grid auto-
matically right after it has read the unstruc file. The regeneration will be made from
the water levels given in the koordina file. The option is used when computing wet-
ting/drying in asituation wheretheinitial water level islower than what it will be | ater.
In other words, the program is started with dry cells. The program needs to know the
grid layout of the areas that will be wetted, so the unstruc file needs to cover the whole
geometry. If theinitial computational domain will expand horizontally at alater time,
than theinitial water level can be given in the koordina file, and the program will start
with a grid based on this.

Note that if the G 6 option is used in this case, the indexes refer to the grid in the orig-
inal unstruc file, and not on the regeneration after the koordina fileis used. Also, the
inflow/outflow specification is done on the grid in the original unstruc file.

One of the most common problemsfor new SSIIM 2 users has been that they write the
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F 113

F 114

F 115

F 116

F 117

F 118

F 119

unstruc file with dry cells. The latest versions of SSIIM 2 will therefore not allow the
Grid Editor or the Discharge Editor to open if the F 112 data set is used in the control
file.

SSIIM 2 only. Algorithms to stabilize the solution in very shallow regions close to the
side walls. The algorithms use different interpolation algorithms from the center of the
cellsto the cell surfaces. Different algorithms have been tested, using integers from 1
to7.

3,4: Using second-order interpolation instead of third-order interpolations for pressure
gradients

5: Setting the Rhie and Chow term to zero for 2D cellsin shallow areas. Shallow
defined as depths below the values given on the first value of the F 94 data set.

7: Flux-limiter: the extra term from the Rhie and Chow interpolation should not be
more than 20 % of the linear interpolation term.

Note that these algorithms are not tested extensively
Default: F 113 0 (algorithms not used)

SSIIM 2 only. Aninteger isread. If itis 9, 10 or 20, special algorithmsto compute the
pressure gradients are used. This can give a more stable solution where there are very
shallow areasinside the main grid. A similar routine is also used on the pressure-cor-

rection gradients in the SIMPLE method if the integer is 10.

Default: F 114 0 (algorithms not used)

VEGDLL parameter. Aninteger isread. If it is 1, the algorithmsin the vegdil.dll fileto
compute the effect of plants/large stones on the water flow are used instead of the
default algorithms.

SSIIM 2 only. TFSDLL parameter. Aninteger isread. If itis1 or 2, the free surface
algorithms in the sfdifdll.dll file are used instead of the default algorithms. If 1, an
implicit procedure is used to find the water surface. If theinteger is 2, an explicit pro-
cedure is used.

IODLL parameter. Aninteger isread. If it is above zero, the free output algorithmsin
theioldll.dll file are used instead of the default algorithms. ThisDLL isnot yet imple-
mented.

COFDLL parameter. Aninteger isread. If it is above zero, the discretization algo-
rithms for the convective terms given in the cofdll.dll file are used instead of the
default algorithms. ThisDLL is not yet implemented.

PRESDLL parameter. Aninteger isread. If it is above zero, the pressure gradient algo-

rithmsin the presdil.dll file are used instead of the default algorithms. ThisDLL isnot
yet implemented.
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F 120

F 121

F 125

F 128

F 130

F 131

F 132

F 133

F 134

F 136

F 137

WALLSDLL parameter. An integer isread. If it is above zero, the wall lawsin the
walldll.dll file are used instead of the default algorithms. ThisDLL is not yet imple-
mented.

TURBDLL parameter. Aninteger isread. If it is above zero, the turbulence algorithms
in the turbdll.dll file are used instead of the default algorithms. ThisDLL is not yet
implemented.

SSIIM 2 only. TSCDLL parameter. An integer isread. If it is above zero, the transient
sediment computation algorithms in thetsc2dll.dll file are used instead of the default
algorithms.

SSIIM 2 only. Setting the pressure field to zero in the TSC algorithm to prevent insta-
bilities. An integer, n, isread. The pressure is set to zero for each n’th time step. The
algorithm has not been very successful in testing.

SSIIM 2 only. Four integers giving the indexes defining an area of the first block
where adenser grid isto be generated. Not tested yet.

SSIIM 2 only. Cohesive parameters. And integer and afloat isread. The integer deter-
mines the sediment size. The float is a critical shear stress for erosion of each particle
size. Multiple F 131 data sets are given for multiple sediment sizes. Default: 0.0 for all
sizes. Note that this number is only used to determine the critical shear stress for ero-
sion of aparticle. It isnot used in the sediment transport formulas.

SSIIM 2 only. Maximum Froude number for update of water surface. A float is read.
Thisis a stabilizing depth-limiter algorithm for the water surface computation. The
water level islimited in size so that high Froude numbers do not emerge. The critical
Froude number is given on the float. Default: 0.0, meaning the algorithm is not used.
Note that this algorithm may introduce unphysical water levels, with corresponding
instabilities.

SSIIM 1 only. Special solver for grids with fairly large porous areas. A float and an
integer areread. Thefloat is aporosity limit for when the algorithm is used. The inte-
ger isthe number of iterations in the algorithm. This algorithm is not fully imple-
mented yet.

SSIHIM 2 only. Number of bed layers. Thisis used in an algorithm using several sedi-
ment layers under the bed. The purpose is to compute for example sediment composi-
tion in adelta. Thisalgorithm is not fully implemented yet.

SSIHIM 2 only. Maximum pressure gradient. A float isread. This algorithm has not
been successful.

SSIHIM 2 only. QNgrid algorithm. The algorithm generates hexaheadral cellswith
more than six neighbours. The algorithm is not implemented yet.
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F 138

F 139

F 141

F 142

F 143

F 144

F 145

F 146

F 147

F 148

SSIzloM 2 only. Minimum value of the turbulent kinetic energy. A float isread. Default:
104,

SSIHM 2 only. Minimum value of u+ inthe wall laws for the velocity and turbulent
Kinetic energy (default 1.0).

SSIIM 2 only. A limiter for epsilon. A float isread. Thisis the maximum value epsi-
lon will get. Default: 100.0. (Minimum value for epsilon is hard-coded to 10716)

SSIIM 1 only. Convergence criteriafor update of the water surface. A float is read.
Default: F 142 0.001.

SSIIM 2 only. Water surface computation algorithm. An integer isread. If itis 2, then
the program will use the average pressure over the last iterations for computing the
water surface. If itis 1, then the program will do alinear regression analysis over the
last iterations to estimate the water surface location. This option is tested and did not
give very good results.

Bed form smoothing algorithm. An algorithm isinvoked to smooth the bed as a func-
tion of the bed form characteristics. An integer and afloat is read. The smoothing is
used if the integer is above 0. The default value is 0.

SSIIM 1 only. Integer to invoke the roughm1.dll DLL file. In thisfile, the bed rough-
ness or the vegetation parameters can be modified by the user. The DLL fileisused if
the integer is above zero.

SSIIM 1 only. Integer to invoke an agorithm adding a source term to the velocity
equationsif the flow is supercritical. Thisisdone if the integer is above 0. Default F
146 0. The algorithm was intended to be used to improve results for supercritical flow
computationsin coarse grids, but it has not been successful yet.

SSIIM 2 only. Parameters for use in extrapolation of initial values to newly wetted
cells. Default: F14720010.21.01.0. Thefirst integer gives how many iterationsthe
extrapolation algorithm should be used. This should be larger than the number of cells
in one direction in the wetted area. The second integer determines which of two inter-
polation algorithms are used when transferring variables between two grids. The
default algorithm (0) uses alinear interpolation based on the vertical elevation of the
cells. An aternative algorithm (1) uses the cell indexes. The third integer invokes the
part of the algorithm that extrapolates over multiple cells for each wetting situation.
The fourth number, afloat, gives arelaxation factor for the velocity values. The fifth
and sixth number, both floats, give relaxation factors for k and epsilon. During initial
testing, we have not found any improvements in the results by using values different
than the default.

SSIHIM 2 only. Maximum slope of the water surface. A float isread. If the number is
above zero, an algorithm isinvoked that prevents the water surface to be steeper than
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F 149

F 150

F 151

F 154

the value given. Default -0.1 (algorithm not used).

Non-isotropic turbulence parameters. Two floats are read. Thefirst float is multiplied
with the isotropic diffusion to produce the vertical diffusion used by the program. The
second parameter does the same in the horizontal direction.

Default: F 1491.0 1.0.

SSITM 1 only. Option with modified wall laws. Two integers areread. Thefirst integer
modifies the wall laws for high roughness/water depth ratios. Option 1 uses a three-
layer model where the middle layer is when the bed form height is higher than the
roughness. Option 2 uses atwo-layer model where the middle layer isnot used. The
inner layer isalinear function. Option 0O is the function used previously. The second
integer will use akappaof 0.4 if theinteger is 1. If it iszero, it will modify kappa
according to the bed concentration, using Einstein’'s formula.

Default: F 15000
This data set is not much tested.

SSIIM 1 only. Parameters for special algorithmsfor very shallow flows. An integer
and afloat isread. Thefloat is the minimum water depth in the grid in meters. The
default is 3 % of the average grid cell length. The integer is a choice of combination of
different parameters. The algorithms are used if the bed level rises above the minimum
water depth. The following options can be used:

A: A sink term in the Navier-Stokes equations are used in the shallow areas
B: The SIMPLE corrections are not used in the shallow areas

C: An algorithm setting a,, to zero in the shallow areas

The options for the integer are:

0 special algorithms are used (default)

Smoothing algorithm for the water surface. An integer and afloat is read. Smoothing
isdone if the integer is 1. The smoothing is done by taking the average of the four
neighbour values and multiplying this with the float parameter on the data set. Then,
(1- the parameter) is multiplied with the old value and added. This gives the new
value.

In SSIM 1, the averaging is done on the pressure at the water surface, before the sur-
face changes are done. In SSIM 2, the averaging is done on the water levels directly.
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F 156

F 159

SSIIM 2 only: If the integer is 3, dry areas will not be smoothed. If theinteger is 1,
also dry areas will be smoothed. Integers 2 and 4 will give the sameas 1 and 3, respec-
tively, but the boundary will also be smoothed.

SSIIM 2 only. Option to pause the program during a computation. This is used for
debugging purposes. An integer isread. The following options are possible:

1. Before the start of regenerating the grid

2. After the regeneration of the grid

3. Before the velocity and flux correctionsin the SIMPLE algorithm

4. After the velocity and flux corrections in the SIMPLE algorithm

5. Before interpolating the variables to the new grid

6. After interpolating the variables to the new grid

7. At the end of atime step computing the bed level changes (F 37 1/2)

The option can be used in combination of the Pause option in the Compute menu of
the program.

SSIIM 2 only. Algorithms to improve stability by avoiding grid problems. Five inte-
gersareread, for five different algorithms. The algorithms are invoked if the integer is
1, and it isnot invoked if the integer is 0. The algorithms are only used when the
parameter on the F 64 data set is equal to 8, 11, 13, 38 or greater than 100.

Thefirst algorithm tries to remove dead-end channels that are only one cell wide. A
maximum of 30 cells can be removed.

The second integer invokes different algorithms dealing with the problem of ridges
between wet cells. Some algorithms try to give better connection between two neigh-
bour column of cellsthat are separated by a high ridge. Thisis done by increasing the
water depth. Several algorithms are used with different depths. Aninteger of 1 setsthe
depth to 80 % of the first parameter of the F 94 data set. An integer of 2 or 3 setsthe
water depth to minimum the value of the first parameter on the F 94 data set. An inte-
ger of 4 does the same as 1, but uses a value of 200 % of the first F 94 parameter,
instead of 80 %. An integer of 3 sets the number of vertical grid linesin the corners
between the cellsto 1 if one of the corners have a negative depth and the sum of the
two cornersis smaller than 10 % of the first parameter on the F 94 data set. An integer
of 7 doesthe same thing as 1, but uses 100 % of the second parameter on the F 94 data
set instead of 80 % of the first. Other algorithms setsinternal wallsin theridges. The
integer isthen set to 9 or 10.

The third algorithm will try to remove holesin the grid, where there is only one cell
with no connections to side neighbours, only with its neighbours below and above.
Thisisin awetted area, where in 2D, the neighbours exist.

The fourth algorithm will remove single wet cells with only dry neighboursin 2D.

The fifth integer invokes different algorithms to increase the water depth in partially
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F 160

F 162

F 163

F 164

F 165

F 166

dry cells, by lowering the bed levels. So far, none of these algorithms have been suc-
cessful. Aninteger of 1 lowersthe bed level to the first value given on the F 94 data
set. Thisalso happensif theinteger is 2, but then multiple cellsin the vertical direction
isallowed, also on sidewalls. If theinteger is 3, then the depth isincreased so that the
bed slopeis not above 20 degrees. If the integer is 5, then neighbours are disconnected
if the area between them is smaller than a small number.

Default: F 15910010

SSIIM 2 only. Flag to decide which algorithm is used to compute the available sedi-
ment at the bed when deciding the limits of sediment concentration. An integer isread.
If itisO, the available sediments will be equal to the bed cell areatimes the depth of
the sediments. If the integer is 1, then also neighbour cells will be included.

Default: F 160 0.

SSIIM 2 only. Vaue to determine whether a cell is generated or not in regions where
the bed was dry in the previous time step. Default 0.0 meters. The parameter only
works in connection with the F 64 13 option.

SSIIM 2 only. Flag to decide which algorithms are to be used to limit the movement of
the bed. Aninteger isread. Three options are possible:

0. The bed level will not be allowed to move below the movable bed, but it will be
allowed to move above the water surface.

1. The bed level will not be allowed to move above the water surface or below the limit
of the movable bed.

2. The bed level may move above the water level or below the limit of the movable
bed.

SSIIM 2 only. Different versions of OpenM P multi-core solvers. An integer isread,
specifying the number of the solution algorithm.

SSIIM 2 only. Grid numbering direction. When the unstructured grid is made, the
indexing of the cells start at the lower left corner, or the first point marked in the Grid
Editor. Oneinteger isread on thisdataset. If theinteger is 1, then the cell indexing will
start on the corner diagonal opposite in the block. Thisis mostly useful for debugging
pUrposes.

Default: F 165 0
SSIIM 2 only. Regeneration of grid after water surface update. An integer isread. If it
is 1, then the grid will be regenerated after each time the water surface is updated, also

if time-dependent sediment transport is computed. Thisisusualy not done, as the bed
changes are normally recomputed more frequently than the water surface changes, and
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the grid is aways regenerated after each bed change.

Default: F 166 0

F 168 SSIIM 2 only. Multi-grid solver for the pressure-correction equation. An integer is

F 169

F 173

F174

F 178

F 179

read, and thisis the number of levelsin the grid nesting. If the integersis 0, the algo-
rithm is not used.

Default: F 168 0

Hiding/exposure parameters. An integer and afloat isread. The integer decides which
algorithm isto be used. The two parameters are passed on to the beddll.dll where they
can be used in the sediment transport formulas. The beddll made by Rither uses the
following agorithms:

First integer is 1. Ergiazaroff’s method

First integer is 2: Buffington and Montgomery’s method
First integer is 3: Vollmers method

First integer is 4. Wu’'s (2000) method

First integer is 5: Kleinhans' method

Options 2 and 4 is coded in the main SSIIM programs (not the beddll), for both SSITM
land 2.

SSIIM 1 only. Bed shear stress gradients at inflow/outflow boundary. An integer is
read. If 1, the bed shear stressin the boundary cell will not be larger than the neighbour
cell in the direction of the interior domain.

SSIIM 1 only. Cyclic boundary conditions. Two integers are read. The first integer
applies to the water flow computation, and the second to the sediment concentration
computation. If theinteger is positive, say for example 500, then the inflow boundary
values will be set equal to the outflow values for each 500th iteration. If a negative
number is given, say -8, then the program will run to convergence, then update the
inflow boundary condition and restart the computation. Thiswill be repeated 8 times.

Default F 174 0 0 (no cyclic boundary condition used)

SSIHM 2 only. Smoothing agorithms for the free surface, used for the F 36 parameter
being 1 or between 11 and 39. An integer is read, which can be between 1 and 4. Each
integer corresponds to a different smoothing algorithm.

Default: F 178 0 (algorithm not used)

SSITM 2 only. Upwind function used for the F 36 parameter being 1 or between 11 and

39. Two integers areread. The algorithmisinvoked if thefirst integer is 1. The second
integer will cause areduction the upwind effect if itis 1.
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F 182

F 185

F 187

Default: F 17900 (algorithm not used)

SSIIM 2 only. Reduction of critical bed shear stress due to sloping bed. An integer is
read. If itis 1, the same algorithm as F 7 B is used (Brooks, 1963). If the integer is 2,
then the algorithm is only used for cells that have a dry neighbour. If the integer is 3,
then the lateral slope in the formulawill be the maximum slope. The same formulais
used only for the side cells if the integer is 4. If the integer is 5, the empirical formula
by Dey (2003) isused. It isonly used for the side cellsif the integer is 6. The formula
by Lane (1955) isused if the integer is 7 or 8. If the integer is 8, the formulawill only
be applied to the border cells.

Default: F 1820

SSIIM 1 only. Damping of turbulence close to the water surface. An integer and a
float isread. If theinteger is 1, aformulasimilar to the wall laws will be used for the
epsilon equation. Thiswill give increased values of epsilon at the water surface and
turbulence damping. The float is an empirical coefficient in the damping function.
Typical values: 0.0046-0.43.

SSIIM 2 only. An algorithm to reduce the water level gradients at the borders of the
geometry. The algorithm is used in connection with F 36 2, 4, 7, 8, 9. An integer is
read. If itis 1, the algorithm is used.

Default: F 187 0.

F 188 SSIIM 2 only. Integer determining which block is to be computed for sediment trans-

F 189

F 190

port. Options:

0: All blocks (default)
-1: only nested blocks
n: only block no. n.

Example: F 188 3 : Only compute sediment transport for block no. 3.

Default: F 188 0 (all blocks)

SSIIM 1 only. Large roughness algorithms. Special algorithms designed for situations
where the bed roughness is larger than the vertical grid cell size close to the bed. An
integer and afloat isread. The integer determines which algorithm is used, and the
float is a parameter in the algorithm.

Several algorithms and approaches have been tested, but not extensively. Currently,
the most promising algorithm seems to be an immersed boundary method with alinear
velocity profile: F 189 5 0.5, but much more work needs to be done.

SSIIM 1 only: Algorithm to decide if to use cohesive forces or not for the sediments.

Aninteger isread. If it iszero, the cohesive forces from the F 131 data set will only be
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F 191

F 192

F 194

F 195

F 198

F 200

F 201

F 202

used if the bed level isbelow the original level. If the bed level is above the original
level, the cohesive forces are not used.

SSIHIM 2 only. When connecting blocks in the GridEditor, the graphics pointer have to
be placed within a certain accuracy. The default is 0.01 mm. For large geometries, this
value may be raised to get a successful connection.

SSIIM 2 only: Ratio of :

number of cellsin the vertical direction for the nested grid
to

number of cellsin the coarse grid

Default: 1.0

SSIIM 1 only: Empirical parameter in aformulafor adding turbulent eddy-viscosity
in areas of vegetation. Default value: 0.0 (no additional turbulence). Values may bein
the order of 0.067-0.11.

SSIIM 1 only: Roughness on side walls. Two floats are read. The first float isthe
roughness on the side wall where j=2. The second float is the roughness on the other
sidewall.

Sand dide dll. Aninteger isread. If it is above zero, the algorithms in the slideldll.dll
or slide2dll.dll files are used. The two files are made for SSIM 1 and SSIM 2 respec-
tively.

Residual normsfor k and epsilon. An integer and two floats are read. Thefirst float is
the residual norm for k and the second is the residual norm for epsilon. The values are
used instead of the average inflow valuesif the integer is above zero.

SSIIM 2 only: Parametersfor the vegdata file. Threeintegersareread. Thefirst isthe
number of variablesin the vegdata file. The second is the number of vertical eleva-
tions. The third is the number of time stepsin thefile.

This data set has to be present in the control file if values for multiple times are to be
used in the vegdata file.

Default: F201141

SSIIM 2 only. Logarithmic inflow velocity profile. An integer and afloat are read. If
theinteger isabove zero, then the inflow sectionswith have alogarithmic profilein the
vertical direction. Thefloat is the roughness value that will be used in generating the
logarithmic profiles. Note that all inflow profiles will be logarithmic if thisdataset is
used.
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F 206

F 207

Maximum number of processors used for the parallel versions of SSIIM. An integer is
read, which gives the maximum number of processors. If it is above the number of
processors available on the computer, then the maximum available processors are
used. The actual number of processors used is written to the boogie file.

Default: F 206 0 (paralélized algorithms not used)

Note this data set will only work on parallel versions of SSIIM.

SSIIM 1 only. Algebraic stressmodel DLL. Two integers are read. If thefirst oneis
above zero, then the algebraic stress model in the stress1dll.dll file will be used instead

of the other turbulence modelsin SSIIM 1. The second integer isthe size of the array
sent to the DLL from the main program.

F 208 SSIIM 1 only. Order of the discretization of the time-term. Aninteger isread. If thisis

F 209

F 211

F 212

1, then a second-order backwards scheme is used for the time term. Default value: 0,
meaning afirst-order backward Euler method is used. This data set is usually only
used if modelling large eddies (URANYS).

SSIIM 2 only. Scaling depth for grid generation. The default value isthe largest depth
in the geometry. The value is used for deciding how many grid cells there will be over
the depth for a given location in the geometry.

SSIIM 1 only. Convergence criteriafor the water flow computations.
Default: F 211 0.001

Specia post-processing print-out. An integer is read. Depending on the value and
which SSIIM version, varying extra print-out is given. The print-out is done when the
result fileiswritten.

1. Worksonly with SSIIM 1. The average bed velocity vector in the grid direction and
normal to the grid direction is printed to the boogie file. The grid direction is here
defined as parallel to the grid linesin thei-direction, which in the default configuration
isin the main flow direction.:

2. Worksonly with SSIIM 1. Writesthe average velocity vector for all grid cellsto the
boogie file. Also writes the average bed shear stress.

3. Works only with SSITM 1. Writes afile innflow.t, which has the same format as the
innflow file. The valuesin the file correspond to the last cross-section of the grid. This
enables the user to take the values from the last cross-section and give them into the
first cross-section.

4. Works only with SSIIM 1. Writes afile koordina.in, which has the same size asthe

koordinafile, but it is made up of only cross-sections similar to the first cross-section.
Together with the 3 option, this enables the user to compute values for the upstream
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F 218

F 219

F 221

F 222

F 224

F 225

F 233

profile

12. Works only with SSITM 2. Writes afile cellvol. Thisfile uses the geodata file and
the grid to specify how much of the cell volume islocated at given levels. 100 values
of levelsin meters and volume are written to the file.

SSIHIM 2 only. Debug information. Two integers are read. When the program has done
as many iterations as the first integer, alarge number of debug information will be
written to the boogie file from the cell which has the same number as the second inte-
ger.

SSIIM 2 only. Parameter to invoke an automatic restart after the program has
crashed. The relaxation parameters are lowered before the restart. The integer tells
how many times the procedure should be repeated. Maximum 4 times.

SSIIM 2 only. Convergence stopping of the program. In a steady Situation, the pro-
gram stops when the residuals are below 0.001. In atime-dependent case, the program
will not stop if the residuals are below 0.001. However, if time-terms are used to
improve convergence of a steady situation, the program should still stop.

Aninteger isread. If itis O, the program will not stop in time-dependent computations,
when the residual is below 0.001. If theinteger is 1, the program will stop.

Default: F 221 0

SSIIM 2 only. Downstream depth algorithm. An integer isread, which can be O or 1.
If 1, an algorithm isinvoked to try to prevent the downstream bed level toriseto
heights where it will block the outflow.

Default: F 222 1 (the algorithm is used by default)

SSIIM 2 only. Onefloat is read. In atime-dependent water flow computation with a
free surface, the free surface will only be updated if the residuals for the Navier-Stokes
equations are below 100.0. Using this data set, the value can be changed asthe float is
used instead of 100.0.

SSIHIM 2 only. Two floats are read, which are used to scale the values in the geodata
file. Thefirst valueis afactor, which is multiplied with al the values. The second
value is added to al the values.

Note that the scaling is done only when reading the values. When editing the geodata
pointsin the Grid Editor, and then writing a new geodata file, the scaled values are
written. Reading the newly generated geodata file back in again and keeping the F 225
data set, gives a double scaling of the points.

Algorithm to use a depth-averaged pressure field to compute the water surface eleva-
tion changes instead of the pressure in the surface cells. Aninteger 6 can be used for
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F 234

F 235

F 237

F 238

F 239

F 242

F 243

F 244

both SSIIM 1 and SSIIM 2. In SSIIM 2 an integer 7 will use an algorithm similar to 6,
but with smaller elevation changes due to the inclination of the surface of the cell.

SSIHIM 2 only. Algorithm to modify the downstream boundary condition when using a
free surface algorithm with gravity, for example F 36 15. Aninteger isread. If 1, a
hydrostatic pressure is used. If 2, the fluxes at the downstream boundary are set to
zero.

SSIIM 2 only. Algorithmsto reduce instabilitiesin triangular cells. Aninteger isread,
and depending on its value, anumber of different algorithms can be chosen. One of the
most successful algorithmsis 10, giving extrarelaxation in the triangular cells. The
relaxation factors can be modified on the F 244 data set.

Default: F 2350 (not used)

SSIIM 2 only. The data set can be used to change the water dischargesinstead of mod-
ifying the values in the unstruc file. An integer and a floating point number is read.
The integer isan index for the discharge group. The floating point is the discharge.
Multiple F 237 data sets can be used for multiple discharge groups.

SSIIM 2 only. Parametersin the nested grid algorithms. Aninteger and afloat isread.
If theinteger is 1, thetop of the nested grid will get the value of thefloat. If the integer
is 2, the bottom of the nested grid will get the value of the float. If the integer is 3, the
water level in the nested grid isinterpolated from the coarse grid. If the integer is4, the
pressure in the nested grid so that the water level is on average approximately the same
in the nested and the coarse grid. The algorithm isonly implemented for F 64 8, 11 and
13.

Default: F 23800.0

SSIIM 2 only. Two integers are read, giving the maximum number of iterationsin the
algorithm for the free surface. Thefirst integer isused for the F 36 7,8,9 and 10
options. The second integer is used for the F 36 4 option.

Default: F 239 50 350.

Number of maximum loops in bed change algorithm to distribute bed changes to cor-
ners.

Default: F 242 1000 (SSIIM 1), F 242 100 (SSIIM 2)
SSIIM 1 only. Integer to invoke the bgraddll.dil function. It is used to compute the
concentration in abed cell asafunction of the max. potential concentration, fluxes, fall

velocity, areas, grain size distributions, sediment thickness etc.

SSIIM 2 only. Two relaxation factors used in the algorithms to reduce instabilities in
triangular cells. Thefirst floating point is used for the velocitiesin the cells, in the F
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F 246

F 249

F 251

F 252

235 10 algorithm. The second integer is used for the fluxes on the cell surfaces, if F
235 is between 8 and 23.

Default: F 244 0.5 0.8

SSIIM 2 only. Algorithms to stabilize the free surface algorithm F 36 7. Three integers
and afloat are read. The algorithm works on the connection between the cell that isto
be computed and each of itsfour or eight neighbours.

If thefirst integer is 1 and the water is coming into the cell, or theinteger is2, alimiter
will beinvoked on the water depth in each cell. Different types of limiters can be used,
depending on what the third integer is.

If the second integer is 1, the a, term in the equation isincreased if the Froude number
is between 0.9 and 1.1. Around supercritical flow the above a,, term sometimes can be
closeto zero, causing a crash. If the second integer is 2, the a, term will never be
below 1.0. If the second integer is 3, the a, term will be increased if the Froude
number is between 0.5 and 1.5.

The third integer decides the magnitude and conditions of the depth limiter invoked by
thefirst integer. If the integer is above zero, the limiting value is decided by aformula
in the sfdifdll.dll file, which can be coded by the user. Negative values indicate differ-
ent alternative hard-coded formulas, not in the DLL. The following options for the
limiter are:

-1: the depth if the Froude number is above 1

-2: the depth * 1.1 if the Froude number is above 1

-3: the depth * the Froude number if the Froude number is above 1

-4: the depth if the Froude number is above 0.9

-5: same as option -3, except the Froude number is taken as the maximum of the cell
and its neigbours

-6: the depth if the Froude number is above 0.5

Thefloat isalimiter on the allowable surface slope used in the determination of the
an, coefficients for the F 36 7 algorithm.

Default: F2461100.1

SSIIM 2 only. Aninteger isread. If 1, then negative sediment thicknesses are allowed.
The feature is used to present measured bed elevation changes.

SSIIM 2 only. Different Shields curves. An integer isread. If non-zero, alower or
higher Shields curve will be used.

SSIHIM 2 only. A relaxation factor for the outflow discharge, if a zero-gradient
(update) boundary condition is used.
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F 256

F 260

F 261

F 264

F 267

F 268

F 272

F 274

F 275

Default: F 252 0.9
SSIIM 2 only. Maximum sediment concentration at the bed. Default 0.1

Flocculation DLL. Aninteger isread. If it isabove zero, the flocdll.dll filewill be used
to compute flocculation of the sediments. Note that thiswill only work if the F 37 2
option is used.

SSIIM 2 only. Nested grid algorithm. An integer and afloat isread. If theinteger is1,
the nested domain will be coupled with the coarse grid when computing water flow. If
the integer is 2, the coupling will also be applied for the sediment concentrations. The
float is arelaxation coefficient for the interpolation. Its value is between 0 and 1.

SSIIM 2 only. Variable bed sediment density algorithms. An integer isread. If itis
above 0, then it will be used by the functionsin the vdmidil.dll file, computing varia-
tionsin the bed sediment density. If it is-1, then a hard-coded algorithm is used.

Default F 264 0

Note that these algorithmswill only be used if the F 37 dataset is set to 3 (multiple bed
layers).

SSIIM 2 only. Faster display of map graphics. Aninteger isread. If it is 1, then quad-
rilaterals will be used instead of contoursin displaying the Map graphics. This may
give faster graphicsfor large grids.

Default: F 267 0.

SSIIM 2 only. Decision about the nested blocks being printed to the Result/Tecpl ot/
Paraview files. Aninteger isread. If it is O (default), al the blocks are printed. If 1,
then only the coarse grid is printed. If theinteger is 2, then only the nested blocks are
printed.

SSIIM 2 only: Alternative algorithm to compute the production of turbulent kinetic
energy, Pk, as proposed by Kato and Launder (1993). Thisisinvoked if the integer
read on the data set is 1.

Default: F 272 0.

SSIIM 2 only. Bed angle parameters. An integer isread. If it islarger than zero then
the program will try to read the bedanglefile.

Default: F 2740

SSIHIM 2 only. Modifications of the epsilon constants. Two floating point numbers are
read, which gives two of the epsilon constants in the k-epsilon model.
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F 277

F 278

F 279

F 281

F 283

F 285

Default: F 275 1.441.92

SSIIM 2 only. Option to display a graphic view of the sediment continuity defects.
Thisisdoneif an integer above zero is read. Then the continuity defect is seen when
choosing Debug information in the graphics.

Default: F 2770

SSIIM 2 only. Variations of the F 36 7 algorithm. Not tested much. The F 278 6 and 7
variations seemed promising.

Default; F 278 0

SSIIM 2 only. Variations in computing the bed shear stress. Can not be used with the
beddll. Aninteger isread. The following options are:

1: The shear stress is computed from the maximum kinetic energy in the bed cell and
in the cell above the bed cell.

2: The bed shear stress is computed from the maximum of the shear in the bed cell and
the neighbour cells, if the cell corners have been moved inwards (F 102 1)

Default: F 279 0: Normal bed shear computation from the kinetic energy in the bed
cell.

SSIIM 2 only. Increase in the vertical eddy-viscosity due to dunes. An integer and a
float areread. If theinteger isread, the vertical eddy-viscosity isincreased by adding a
value proportional to the float and the bed form height.

Default: F 281 0 (algorithm not used):

SSIIM 2 only. Extra damping in the changes of the water surface elevations for the F
36 7 algorithm, if the Froude number isabove 1. Aninteger isread. If it is 1, then the
algorithm is used.

Default: F 283 0 (algorithm not used)

SSIIM 2 only. Parameters for the choice of function in the beddll. Two integers are
read. If the first integer is 1, the function computeBedConcentrationl will be called
instead of computeBedConcentration, which is default (integer is 0). The two beddll
functions have different parameters.

The second integer does the same for the beddll functions computeBedS opeCorrec-
tion and computeBedS opeCorrectionl.

Default: F 28500
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F 286

F 287

F 292

F 293

F 294

F 295

F 297

SSIIM 1 only. The parameter ¢, in the k- turbulence model is given.
Default: F 286 0.09

SSIIM 2 only. Algorithm that triesto estimate the outflow water flux from areservoir,
given the inflow and the changes in the water surface elevation of the reservoir. An
integer isread. The algorithm isinvoked if theinteger is 2. The computed outflow flux
will override the specified outflow in the timei file. If the integer is 3, the computed
outflow flux will be checked against the value specified in the timei file, and not be
allowed to go below this.

If the integer is 5, the outflow will then be limited to be between 0.5 and 2.0 times the
dischargein thetimel file. If the integer is 6, the same limitation procedure will be
used, but then two floats are read after the integer. These two floats will then be used
instead of 0.5 and 2.0.

Default: F 287 0 (algorithm not used)

SSIIM 2 only. Inner time step. An integer and afloat isread. If the integer is 1, the
float is used in an inner time step. This means the time step is used for each inner iter-
ation. The purposeisto prevent instabilities, and the method seem to be more effective
then most of the earlier methods. This especially applies to velocity instabilities in tri-
angular cells.

Default: F 292 00.0 (algorithm not used)

SSIIM 2 only. A file where only residuals are written for each iteration. Thefileis
called sigurd. It makes it easier to make graphics of the residuals in a spreadsheet.

SSIIM 2 only. Aninteger isread, giving the number of time steps in the time-depend-
ent inspacefile.

SSIIM 2 only. A float isread the float is multiplied with the average vertical distance
between the geodata points an the bed level, to produce the roughness val ues.

Default: F 295 1.0

SSIIM 2 only. An integer is read, indicating which version of the unstruc fileisto be
written. Default after 11. June 2012: 3. Default before 11. June 2012: 2. The difference
between version 2 and 3 isthat version 3 contains geometry information also for dry
areas, making it possible to start a computation with a dried up areawithout using a
koordina/koosurf file. Version 3 also contains more accurate information for the differ-
ent blocks, making it possible to increase the G 1 data set parameters and still use the
same unstruc file. These two features were not possible in version 2.

Thereisaso aversion 4 of the unstruc file, which only contains the 2D grid and not
the 3D grid. Thiswill be much smaller than version 3, but may produce different
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F 300

F 301

F 302

F 305

F 306

number of 3D cells on different computers.

SSIIM 1 only. Two integers are read, which are used in the sediment concentration
solver. Thefirst integer isthe number of iterations. The second integer determinesif
block-correctionsisto be used. If the integer is 1, block-correction is used.

Default: F30011

SSIIM 2 only. A float isread. It isthe maximum residual defining a crash of the pro-
gram.

Default F 301 1.0el0.

SSIIM 1 only. Aninteger isread. If itis 1, the program will not do the test if the values
in the koomin file are higher than the bed level.

Default; F 3020

SSIIM 2 only. Alternative function for the wall laws. Aninteger isread. If itis1, the
aternative function isused. Thisis only implemented for F 150, 8 and 15.

SSIIM 2 only. Use of the grain size distribution in the bedresfile. An integer isread. If
itis 1, the sediment grain size distribution in the bedres file will be used instead of the
fracres or the N data sets when starting a new computation.

Default F 306 O

F 308 SSIIM 2 only. MPI option. An integer isread. If it isabove 0, MPI algorithms will be

F 310

F 314

F 321

used. Not tested yet.

SSIHIM 2 only. Algorithms to adjust the sediment thickness. The sediment thickness
can be given in two ways: The koomin file in combination with the unstruc/koordina
file. And the fracres/bedres files. The algorithms deal with the situation where the sed-
iment thickness is not the same in the two approaches. An integer isread. If 1, the
koomin values are used. If theinteger is 2, the fracres/bedres values are used.

Default: F 310 0 (thismay give wrong answers if the user has not specified the input
data correctly)

SSIIM 2 only. Automatic setting of inflow/outflow areas. Two integers areread. If the
first integer is 1, then the inflow area in Discharge Group 1 will cover the whole
upstream cross-section of the first block and be an inflow area. If the second integer is
1, then the whole downstream cross-section of the first block will be defined in Dis-
charge Group 2 to be outflow. The data set can be used instead of using the Discharge
Editor.

SSIIM 2 only. New surface function. Aninteger isread. If it is 1, anew surface func-
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F 322

F 323

F 325

F 328

F 329

F 335

F 337

tion isused instead of the old. The new surface function includes the Shallow Water
equation option.

SSIIM 2 only. Shallow Water Equation parameters. Two integers are read. If the first
oneis 1, the time step source termswill be included in the solution. If the second is 1,
the convective term in the Shallow Water Equation are included in the solution. Note
that thisis only for the computation of the free surface, with F 36 9 and F 321 1.

Default: F 32200

SSIIM 2 only. New free surface function. An integer is read, and the new function is
used instead of the old one of the integer is 1.

Default: F 3230

SSIHIM 2 only. Sediment slide algorithm. Aninteger isread. If itisabove 0, a sediment
dlide algorithm isinvoked based on Bingham theory and viscous movement of the
dlide by solving the Navier-Stokes equations.

SSIIM 2 only. New function for the water flow computation. An integer isread. If itis
1, the new function is used.

SSIIM 2 only. Print-out options. A series of up to 19 integers are read. Each integer
specifies afile that can be printed out each time the P 10 iteration is reached. The fol-
lowing list gives the options:

1st  resultfile

2nd  bedresfile

3rd  Tecplot 2D

4th  Tecplot 2D - nested version

5th  Tecplot 3D

6th  ParaView 3D

7th  ParaView 2D

8th  ParaView 2D written to multiple blocks

o9th  NagelPtk file

10th beddata.sim: x,y and z values of bed cells

11th aparamerter isread which tells what type of interresfileiswritten: similar to
the F 48 data set

12th Halvor file: 2D depth-averaged boundary of the geometry

13th habitat file

Default: F3291100000000000

SSIIM 2 only. An ending time for the computations. A float is read, which isthe time
in seconds when a transient sediment computation stops.

SSIIM 2 version with MPI only. Discharges for the MPI computation. Two integers
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F 343

F 343

and onefloat isread. Thefirst integer isthe block number. The second integer isthe
discharge group number. The float is the actual discharge, in m3/s.

SSIIM 2 only. Vector display interval. Aninteger isread. If itis 2, only every second
velocity vector is shown in the Map graphics. If it is 10, only every 10th vector is
shown. Since SSIIM 2 uses an unstructured grid, the vectors may show up in arandom
pattern in Map graphics. However, if the number of cellsin the vertical directionisthe
same in an area, the vectors may form a pattern there, depending on the value on the
data set.

SSIIM 2 only. Convergence improvement algorithms. Aninteger isread. If itis 2,
then ablock-correction algorithm is used along the main axis of the grid. If the integer
is 3 then a classical multi-grid method is used.

Note that the convergence acceleration algorithms may give less stability for large
time steps.

5.3.2The G data sets

G1

G3

Four integers are read, called xnumber, ynumber, znumber and Inumber.

For SSIIM 1, this gives the number of cross-sections, grid linesin the streamwise
direction, and vertical direction, respectively, for a structured grid. The last integer,
Inumber, isthe number of sediment sizes. This data set must be present in the control
file. The program will read these values and allocate space for the arrays accordingly.

For SSIIM 2, the unstructured grid will also use structured arrays for connecting the
different blocks. The blocks will be put beside each other in the cross-streamwise
direction of the grid. The default grid sizeis 300x300 cells. If the grid sizeissmaller, it
may be an advantage of using smaller numbers on this data set, to reduce the memory
requirement. If the length of one block (number of cross-sections) islarger than 300,
this data set must be changed accordingly. If the number of blocks timesitswidthsis
larger than 300, this data set must also be changed accordingly. The third integer,
znumber, will be the maximum number of grid lines in the vertical direction. The last
integer, Inumber, is the number of sediment sizes.

For SSIIM 1: Vertical distribution of grid cells. Thisis further explained in the figure
below, where an example is given. This data set must be present in the file.
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G6
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The values are given as a percentage of the depth only with the grid options F 64 2 and
F645. For F64 0and F 64 1, the values are level in meters, and the longitudinal and
lateral grid lines are completely horizontal.

For SSIIM 2: The same distribution as described for SSIIM 1lisusedif F 64 2 and F
64 5 isused in the control file. For F 64 0 (default) and F 64 1, the valueson the G 3
data set are level in meters, and the longitudinal and lateral grid lines are completely

horizontal.

SSIIM 1 only. Sediment sources. Six integers and Inumber floats are read. The inte-
gersindicate aregion of the grid. Thefirst two are in the streamwise direction, the fol-
lowing two are in the cross-stream direction and the two last integersindicate the
vertical direction. The following floats gives the sediment concentration in volume
fractions. Only one G 5 data set can be used.

Example: Sediment concentration 0.001 flows into the top of the geometry in an area
given by the following cells: j=2 to j=4 and i=3 to i=5. It is assumed that there are 11
grid linesin the vertical direction. This gives the following data set:
G5352411110.001

Note that a volume concentration of 0.001 with a specific sediment density of 2.65is
equivalent to a concentration of 0.001 x 2.65 x 1 000 000 = 2650 ppm

Data set for calculating water surface elevation with an adaptive grid. Three integers
and two floats are read:

iSurf
jSurf
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kSurf
RelaxSurface
ConvSurface

The RelaxSurface variable is afloat relaxing the estimation of the increment to the
new recal cul ated water surface. Use low values if you experience instabilities.

The ConvSurface variable is afloat setting the limit for when the water surface should
be recalculated. The water surface will be updated when the maximum residual of the
equations are below this parameter. Recommended value: 0.01 - 1.0

Thefirst three integers are interpreted differently in SSIIM 1 and SSIIM 2.
SSIM 1:
Note: The G 6 dataset isnot used if F 36 1isused in the control file.

Thethree integersiSurf, jSurf, kSurf indicate a cell in the grid. The water surfacein
this cell is not moved. In the present implementation, kSurf have to be equal to znum-
ber + 1. This meansthe cell hasto be on the water surface. If not, awarning messageis
sent to the boogie file, and kSurf is set to znumber + 1. The computations continue
afterwards.

Example: G631790.10.1

Seen from above, the water elevation in cell (31,7) will not move during the computa-
tion of the free surface.

SSIHM 2:

In SSIIM 2 the grid isunstructured, so it is only necessary with one index to reference
acell. Thefirst index, iSurf, isthen used to point to this cell. The water level abovethis
cell will not be moved during the computations. Normally, the other two variables,
jSurf and kSurf should be set to zero. However, it is also possible to use two reference
cellsthat do not move. Thisis not correct from a hydraulic point of view, but it can be
done to improve stability. The number of the second cell is then given as the second
integer, jurf. The third integer, kSurf, is normally zero. However, if the water level is
changed at only one location, for example the downstream boundary, the kSurf integer
can be set equal to the number of the discharge group at the outlet, given in the Dis-
chargeEditor. Thiswill then cause the water level over the whole outlet cross-section
to be lowered simultaneously and in a horizontal line, instead of being lowered at one
point.

Selecting the surface index is usually done in the map graphics, where the cell indexes
are seen. Note that a dynamically changing grid must not be computed during this pro-
cedure, and the F 112 data set must not be used in the control file when finding the
number. The F 112 data set can be re-inserted into the control file after the G 6 num-
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G7

bers are found.

When the grid cell indexes change for a dynamic grid, the location of the cellsin the
initial grid is used.

Example: G 6 3531043673 00.10.1

The water surface above cells 35310 and 43673 is fixed during the movement of the
water surface.

For SSIIM 2, also see the G 62 data set.
SSIIM 1 only. Thisdata set specifies water inflow on geometry sides, bed or top. Each
inflow/outflow location is given on one G 7 dataset. It is possibleto haveupto 19 G 7
datasets. When the G 7 data sets are used, the default inflow/outflow discharges are not
used. Therefore, it isthen necessary to use at least two G 7 data setsif they are used.
On each dataset, eight integers and four floats are read. The names of the variables are:
G 7 typesideal a2 bl b2 parallel update discharge Xdir Ydir Zdir
Each variable is explained in the following:
type: 1. outflow, O: inflow.
side: 1. upstream inflow cross-section when not using G 7 data sets

-1: downstream outflow cross-section when not using G 7 data sets

2: along the right bank when not using G 7 data sets

-2: along the left bank when not using G 7 data sets

3: discharge through the channel bed

-3: discharge through the water surface boundary

al,a2,bl,b2: four integers that determine the limits of the surface, by the indexes of
the cells. Thisisfurther described in the figure below.
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(a2,b2)

(al,bl)

Figure 3 Part of surface determination

parallel: direction of the flow:
0: normal to surface
1: paraldl to grid lines normal to surface
2: direction is specified (vector directions)

update: O for not update, 1 for update.
(only partly implemented)

discharge:water dischargein m?3/s. Note that the sign of the discharge must correspond
with the direction of the desired flow velocity. Positive discharges indicate velocities
in direction of increasing grid line numbers.

Xdir: direction vector in x-direction
Ydir: direction vector in y-direction
Zdir: direction vector in z-direction

Example: G7012112110032.01.00.00.0

This example specifies inflow in the most upstream cross-section. The inflow areais
from cell no. 2to cell no. 11 in both cross-streamwise and vertical direction. The flow
direction is normal to the cross-section. The discharge is 32 m3/s

Remember to define the walls of the boundary when this data set is used. Thewalls
with no inflow must be closed with the W 4 data set. If inflow through aside set aswall
is specified with the G 7 data set, the wall laws must be removed using the W 4 data
set. The default walls are on the sides of the channel. Thefirst and last cross-sections
have the inflow and outflow by default.
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G8

Gl

G13

Also notethat it is not possible to have inflow through the free water surface. If such a
caseisto be simulated, it is necessary to model aclosed conduit (K 2 0 0, + addition to
koordinafile), and then to open a hole in the roof.

If the G 7 data sets are not coded correctly, there will be a continuity error. It isthen
advisableto look at the velocity vectorsin the SSIIM graphicsto seeif the vectors
computed in the first iterations gives a picture that looks reasonable. Remember the
red lines shows solid walls and blue lines show inflow/outflow. The vectors close to
inflow/outflow regions should point roughly in the right direction after the first itera-
tion.

For SSIIM 2, the data set is not used. Instead, the inflow/outflow is specified in the
Discharge Editor. The information is stored in the unstruc file.

SSIIM 1 only. Valuesfor initial velocities. Up to 19 G 8 data sets can be used. Six
integers are read first to specify the volumethat is being set. Then three floats are read,
which gives the velocities in the three directions.

G8ili2jlj2kikk UV W
SSIIM 1 only. Source termsfor the velocity equations. Six integers and two floats.
11i2j1j2 k1 k2 source relax

Thefirst six integers are indexes for the cells that are influenced by the source term.
The source variable is the form factor times a diameter of a cylinder in the cell times
how many stems there are in one cell. The relaxation variable is recommended set
between 1.0 and 2.0

Outblocking option that is used when aregion of the geometry is blocked out by a
solid object. Aninteger isread first, which determines which sides the wall laws will
be applied on. The following options are possible:

0: No wall laws are specified

1: Wall laws are used on the sides of the block

2: Wall laws are used on the sides and the top of the block

3: Wall laws are used on the sides, the top and the bottom of the block

Sixintegersarethenread: 111212 k1 k2. These integers define the cells of the block.
Thetwo first integers are the first and the last cell in the i-direction. The next two inte-
gers arethe first and the last cell in the j-direction. The last two integers are the first
and the last cell in the vertical direction.

When making blocks, note that there must be at least two free cells (not blocked out)

between each block or to thewall. It is recommended to use more free cells than two,
to resolve the flow pattern between the blocks.
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G114

G 16

G 18

G 19

Up to 49 G 13 data sets can be used.

For SSIIM 2, the first and the two last integers are not used, but numbers must be
given in anyway. The data set will then only have an effect when given to the control
file before the grid is generated.

SSIIM 1 only. Debug dump option, where avariable in acell is written to the boogie
file. Four integers are read. The first integer indicate which equation. Velocitiesin x,y
and z directions are denoted 1,2 and 3, respectively. 5 and 6 are used for k and €,
respectively.

The next three integers are cell indexesi,j and k.

Example: G 14 1 3 4 6 causes velocity in x-direction for cell i=3, j=4 and k=6 to be
written to the boogie file for each iteration.

Up to 29 G 14 data sets can be used.

SSIIM 1 only. Local vertical distribution of grid cells. This data set can be used when
adifferent distribution of grid cells than what is given on the G 3 data set iswanted in
some parts of the geometry. Four integers are read first. These tells which area are
affected by the changed distribution. Then znumber floats areread, similarly towhat is
on the G 3 data set.

Example: G 16 2314 0.0 50.0 75.0 100.0 when znumber is 4, gives the new distribu-
tion for the eight vertical linesi=2toi=3 and j=1to j=4.

Up to 500 G 16 data sets can be used.

SSIIM 1 only. Boundary inflow specification for water quality calculation. Six inte-
gers are read first, specifying the location of the inflow. Then another integer is read,
specifying the variable. The integer correspond to the value on the Q data set. Then a
float isread, which isthe value of the variable. The last two numbers are floats, which
gives the starting and ending time for the variable to flow into the geometry (in sec-
onds).

Example: G1811242500.01 100.0 200.0

Thisgivesan inflow at the upstream boundary (i=1) in cell j=2to 4 (lateral) and k=2 to
5 (vertical). Thisisvariable no. 0, and avalue of 0.01 is specified after calculated time
100.0 seconds. The inflow ends after 200.0 seconds

Up to 100 G 18 data sets can be used.

SSIIM 1 only. OpenGL 3D surfaces parameters. One surface is described on each G
19 data set. Up to 50 G 19 data sets can be used.

128



G20

G21

Each dataset consist of eight integers. Thefirst integer specifiesthe number of thegrid
line. The second integer is an index showing the main direction of the grid surface.
The following options are possible:

1: cross-section
2: longitudinal profile
3: plan view

Thefollowing four integer defines the corners of the surface. The last two integers are
presently not used for anything, but they must be given.

Example: G19113252600

This gives a surface along the grid surface k=11, from i=2to 5, and j=2 to 6.

If no G 19 data sets are given, adefault data set is used thisis:

G 191 32 xnumber 2 ynumber 00

Thiswill give the bed of the geometry. The parameters xnumber and ynumber are
given on the G 1 data set, and are the number of cross-sections and linesin the stream-

wise direction, respectively.

SSITM 1 only. Sediment sources. This data set is used for inserting sediment into other
areas than what is defined on the | data set.

The data consist of seven integers and afloat. Thefirst six integers define a surface, by
giving indexes for streamwise, cross-streamwise and vertical direction. The seventh
integer isan index for the sediment size. The float islast, and it is the sediment con-
centration.

Examplel: G20210112710.001

A concentration of 0.001 (by volume) isgiven for size 1. The concentration isgiven on
the right side wall of the volume (j=1to 1, repeated indexes). The surface areais
within the indexesi=2 to 10 and k=2 to 7.

Examplell: G202102412 12 30.002

A concentration of 0.001 (by volume) isgiven for size 3. The concentration isgiven on
the water surface, asthere are 11 cellsin the vertical direction. The surface areaiis
within the indexesi=2 to 10 and j=2 to 4.

Up to 50 G 20 data sets can be used.

SSIIM 1 only. Thisdata set isused for determining fluxes through special parts of the
geometry. As adefault, the boogie file will only give the fluxes through the four sides
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G 22

of the geometry. Additional surfaces can be specified on this dataset.

Six integers are read. Thefirst integer specifiesif the surface is a cross-section (1), a
longitudinal section (2) or a horizontal section (3). The second number specifies the
section number. The following four integers specifies the surface area.

Example:

G2118329221
G211832926

The two data sets specifies two cross-sectional surfaces, located at node i=83. Both
surfaces coversj=2 to j=9, but the first surface is from k=2 to k=21, while the second
surface is from k=2 to k=6.

The effect of the data setsisthat an extraline iswritten to the boogie file for each data
set. The example above gives the following print-out in the boogie file. The bold text
is specific for the G 21 data sets.

Trap efficiency after 49 iter: all valuesin kg/s

|=1: Trapped: 0.0510563, Fluxes (11,12,J1,J2): 1, 0.948, 0, 0 Resid: 0.0008
Flux 1 =0.948952

Flux 2 = 0.881389

The numbering of the surfaces follows the grid lines, which is different from the num-
bering of the cells. If the water isflowing in adirection of decreasing grid cell num-
bers, then the sediment flux will be equal to the concentration in acell multiplied with
the water flux in the cell side with the cell number minus one. To take thisinto
account, the user can specify anegative sign for the integer indicating the direction.
For example -1 instead of 1 for a cross-section where the water is flowing into the
geometry at the last cross-section, or out of the geometry at the first cross-section.

Up to 20 G 21 data sets can be used.

SSIIM 2 only. Data set to model horizontal constructions, for example bridges. Four
integers and three floats are read. Thefirst four integers, i1,i2,j1,j2 are indexes describ-
ing an area of cellsin the 2D depth-averaged grid. Thisis where the construction isto
be placed. Thefirst float isthe lowest elevation of the structure. The second float isthe
highest elevation of the structure. Thethird float is avelocity reduction coefficient. For
solid objects, it can have avalue of 1.0 or more. Higher values will give more reduc-
tion and lower velocity. For porous objects, the value can be lower than 1.0. If the
valueis lower than 0.7, then the velocity reduction formulais changed into a porous
drag formula, where the velocity reduction coefficient is the solid volume fraction of
the object.

The program automatically finds which of the vertical cells are within the area of the
construction. Thisis useful when the grid moves vertically.
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G23

G24

G 40

G4l

Up to 19 G 22 data sets can be used.

SSIIM 1 only. Data set to model scour around submerged structures. If this data set is
not used, the position of the grid intersection will move vertically as the grid changes.
Thisdata set fixesone grid surface. Fiveintegersareread. Thefirst two areindexesfor
thefirst and last cross-section of the surface. The next two are the first and last index
of the grid line numbersin the lateral direction. The last and fifth integer is an index
for the vertical level.

Example: G2331451186

Surface number 6 from the bed isfixed in the region between cross-sections no. 31 and
45 and between the right bank and grid line j=18.

Up to 500 G 23 data sets can be used, if there are multiple submerged structures.

The data set is mostly used in combination with blocking out aregion of the flow. This
isdone by using the G 13 data set.

Data set to determine which variables are written to the Tecplot files. First, an integer
isread giving the number of variables on the data set. Then, for each variable, a char-
acter and two integers are read. The character indicates the name of the variable, as
detailed in Chapter 5.19. The first integer gives the level above the bed. The second
integer gives the sediment size. For some variables, thisinformation is not relevant.
Integers still have to be given, but they are then not used.

Example: G243ul1l0p20cl?2

Initial vertical distribution of temperature. An integer, n, isread, which givesthe
number of pointsin the profile. Then n pairs of floats are read, the first float being a
vertical level in meters, and the second float is the corresponding temperature in
degrees Centergrade.

Example: G 402 101.0 20.088.0 17.0

At the start of the calculation, the temperature is 20 degrees Centergrade at level 101.0
metersand 17 degrees at level 88.0. There islinear variation between the given levels.

The highest levels must be first in the data set.

Initial vertical distribution of awater quality parameter. Two integers are first read,
where the first integer is the number of the water quality parameter. This corresponds
to the Q data sets. The second integer is the number of data points, n, in the vertical
direction. Then n pairs of floats are read, the first float being a vertical level in meters,
and the second float is the corresponding temperature in degrees Centergrade.

Example: G 4142 101.020.088.017.0
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G 42

G50

G 62

At the start of the calculation, the water quality parameter no. 4 is 20 at level 101
meters and 17 level 88.0. Thereislinear variation between the given levels.

The highest levels must be first in the data set.

SSIIM 2 only. Multiple vertical surfaces for the OpenGL graphics. A surfaceisgive
on each G 42 data set, and up t 20 G 42 data sets can be given. For each data set, two
integers are read. The first integer is a grid node number. Thisindicates the starting
point of the surface. The second integer is aflag indicating the direction of the surface.
A zeroisinonedirection, and 1 isthe other. It is necessary with atrial and error run to
get the second parameter right.

OpenMP parallelization parameters. Ten integers are read. Each integer can be O or
1. The agorithmsin SSIIM has two versions: One parallel and one non-parallel. If F
206 is above zero, the parallel versions are used. With the G 50 data set, the user can
force acombination of serial and parallel algorithms.

Default: G500000000000

If one of theintegers on the G 50 data set is 1, then the serial algorithm will be used for
this part, even though F 206 > 0 isused and parallel versions of all the other algo-
rithms are used.

The purpose of the data set is debugging. If the parallel version and the serial version
do not give the same result, the G 50 data set can be used to see which algorithms
cause the problem.

The different algorithms used are for SSIIM 2:

1st: coefficient generation for the Navier-Stokes equation, the Power-law scheme
2nd: computation of eddy-viscosity, setting a,,, coefficients to zero, computing the
water flux and making the coefficients for the second-order upwind scheme

3rd: wall laws and source term for the pressure equation

4th: water fluxes computation for the pressure-correction equation

5th: SIMPLE corrections

6th: turbulence computations, wall laws and coefficient generation for k

7th: turbulence computations, wall laws and coefficient generation for epsilon
8th: computation of residuals

oth: solver

10th: time step and residual for k

SSIIM 2 only. Data set for calculating water surface elevation with an adaptive grid.
Four integers and two floats are read:

iSurf
jSurf
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kSurf

kSurf2
RelaxSurface
Conv&urface

The data set isidentical with the G 6 data set, except that four integers are read instead
of three. The fourth integer, kSurf2, is the number of the discharge group that has the
cell number in the second integer, jSurf.

If jurf2 is non-zero, the water level over the whole cross-section of the discharge
group is changed simultaneously and in a horizontal line, instead of being lowered at
one point.

5.3.3Thel data set

SSIIM 1 only. Inflow of sediments at the upstream cross-section. An integer is read
first, giving the number of the size fraction. Then the sediment inflow in kg/sis given.

Example: 1 1 3.2
124.8

Thereis 3.2 kg/s sediment inflow of size 1 and 4.8 kg/s of size 2.
Note that this data set only applies for the upstream cross-section. If sediments flow
into another surface, the G 20 data set can be used.

5.3.4TheK data sets

K1

K2

K3

K4

K5

Number of iterations for flow procedure and number that determines the minimum
iterations between updates of water surface. Two integers.

Default: K 1 40000 50000

Two integers that indicate if laws of the wall are being used for the water flow compu-
tation. If O, wall laws are used, and if 1, zero-gradients are used. The first integer
appliesto the side walls. The second integer applies for the surface. Wall laws are
always used for the bed, if not changed by the W 4 data set. Default: K2 0 1.
Relaxation factors. Six floats. For the three velocity equations, the pressure correction
equation and the k and e equation. For further description of the relaxation factors, see
Chapter 3.

Default: K30.80.80.80.20.50.5

Number of iteration for each equation. Six integers. Default: K4111511

Block-correction. Six integers are read, one for each of the six water flow equations. If
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K6

K9

K 10

theinteger is 1, block-correction is used. For the TSC agorithm in SSIIM 2 for Win-
dows, the integer 2 indicates that the block-correction is only used in the first of the
inner iterations in each time step. For SSIIM 2, the integer 10 used in connection with
F 168 will invoke a multi-grid algorithm.

Default: K5000000

Six integers are read, one for each of the six water flow equations. The integers deter-
mines which discretization schemeisto be used for the convective termsin the Navier-
Stokes equations. Different schemes are implemented in the two SSIIM versions:

SSIIM 1:

O: first-order power-law (POW) scheme
1: second-order upwind (SOU) scheme
2: central scheme

3: QUICK scheme

SSIIM 2:

O: first-order power-law (POW) scheme
1: second-order upwind (SOU) scheme
10: QUICK scheme

11: Cubic upwind scheme

12: SMART scheme

13: H-QUICK scheme

14: van Leer scheme

15: Superbee scheme

16: Minmod scheme

Note that the different options only applies to the velocity and turbulence equations.
Options 10 and above only applies to the velocity equations. The pressure-correction
equation will use a different approach for the discretization. This means that the value
of the fourth integer will not affect the computations.

Default: K6000000

Also note that using a different scheme than the first-order upwind scheme for the tur-
bulence equations usually lead to stability problems.

SSIHHIM 1 only. A character isread. If itisY, then the SIMPLEC method is used
instead of the SIMPLE method.

SSIIM 1 only. Solver: Usualy, aTDMA solver isused. However, if the K 10 Yis
given in the control file, a Gauss-Seidel solver isused instead.
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5.35Thel data set

L Specification of isoline values for ContourMap plot. First, an integer isread,
which gives the number of isolines. Then, this number of floats are read. The floats
specify the isolines. Example:

L 6 55.056.057.058.059.0 60.0

If the geometry has bed levels between 55 and 60 meters, and the user chooses bed lev-
elsfrom the graphics options, a contour map of the bed levelswill be displayed. There
will be contour lines for each meter, from 55 to 60 meters.

Default: The program finds the maximum and minimum value of the variable in the
field, and uses 7 lines |ocated between the values.

If morethan 7 lines are displayed, all lineswill be black. Otherwise each line will have
different colour.

Note that sometimes there may be errors in the contouring, if the contour line and the
value areidentical. This can often be the case for plotting bed levels. To avoid this
problem, add a very small value to the values on the L data set. For example, if the
above data set is used and there is a problem for the 57.0 contour line because the bed
level at one of the grid intersections are 57.0, change the data set to:

L 6 55.0 56.0 57.0001 58.0 59.9 60.0

Note that the values can be changed by the user from the Values option in the Scale
menu of the Contour map plot.

536 TheM dataset (SSIIM 2 only)

The M data set specifiesinflow of awater quality constituent or sediments. A maximum of 9
groups of M data sets can be used. Each group corresponds to an inflow section, specified in
the DischargeEditor. Two integers are read first. The first integer is an index for the group.
Thefirst group has index zero. The second integer is an index for the water quality constitu-
ent/sediment size. Zero isthe smallest number possible. After the two integers, afloat isread.
Thisisthe value of the inflow concentration of this parameter.

Example: M 0 2 0.001

If sediments are computed: In inflow section 0, the concentration of size 2 is 0.001.

For example, if there are three inflow sections, and five water quality constituents, it will
make sense to have 15 M data sets. If no M data set is given for a particular inflow section and

water quality parameter, the inflow is zero. M data sets given for sections with water outflow
has no effect on the computation, and should not be used.
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The values of the M data set does not change over time, unless atered by using M data setsin
thetimei file. Thisisthe recommended procedure to model time-varying inflow of water qual-
ity components.

It isrecommended to model time-varying inflow of sediment concentration by specifying the
concentrationsin the timei file, without using M data sets in the control file.

5.3.7 The N data set

The N data set composes the size fractions of different groups of sediments. Two integers and
onefloat isread. Thefirst integer isan index for the group. The second integer is an index for
the sediment size, similar to the first index on the Sand | data sets. The float is the fraction of
the size in the group.

The first group hasindex O (zero).

Normally, multiple N data sets are used for making a group. For example if there are three
groups and five sediment sizes, there should be 15 N data sets.

The different sediment groups are distributed in the geometry by using the B data sets.
Note that more than one sediment group can only be used in SSIIM 1. In SSIIM 2, only group

zero isused over the whole geometry. To use a spatial variationinthe grain sizedistribution in
SSIIM 2, the fracresfile has to be used.

5.3.8 The B data set

The B data set distributes different sediment groupsto different locations of the geometry. The
groups are made using the N data set.

Fiveintegers are read. The first integer is an index for the group number, similar to the first
integer on the N data set. The second and third integer are indexes for the cell numbersin the
streamwise direction. The fourth and fifth integer are indexes for the cell numbersin the lat-
eral direction.

Examplee B02629
Sediment group no. Oisplaced inthe cellsfromi=2to i=6 and j=2 to |=9, wherei isan integer
for the streamwise cell number and j is an integer for the cell numbering in the lateral direc-

tion.

If only one group is used, it is possibleto give B 0 0 0 0 O, which indicates that this group is
distributed in all the cells.

5.3.9 The P data sets
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P2

P3

P4

P6

P 10

P11

P14

Five floating points that give scaling for the graphical presentation. The first three
gives scales in streamwise, cross-streamwise and vertical direction. The fourth and
fifth give movementsin left-right and vertical direction. Defaults: 1.0 for the scales,
and 0.0 for the movements.

Four integers that giveinitial location of the graphical plotsin streamwise, cross-
streamwise and vertical direction, and sediment fraction number.

A character that indicatesinitial type of plot. "g" givesthe grid, "v" gives velocity
lines, "V" gives velocity vectors, "c" gives concentration.

Minimum and maximum values for blue and red coloursin the OpenGL graphics. Two
floats are read.

Integer for the number of global iterations between printing results for time-dependent
computations. In SSIIM 2, the result and bedres files are printed, with an increasing
number extension. These files can be renamed to have no extension, and read by Tec-
plot to show the results at a specific time.

SSIIM 2 only. Extra print-out to the boogie file for each time step. An integer is read.
Depending on the integer, different information is printed.

1: Total amount of water quality constituent 1 for the whole grid
2: Average value of water quality constituent 1 in the surface cells
4: Total number of grid cells, surfaces and points.

Default P 11 0 (no extra print-out)

A float isread, which gives atimeinterval for when a graphic file is automatically
saved in the profile and contour plot. The graphic window have to be open and the
timer has to be running. This only works for time-dependent calculations. The time
interval is given in seconds.

5.3.10 The Q data sets

QO

There aretwo types of Q data sets. Oneisthe Q 0 data set, which gives the name of the
variable. The other type specifies the variables and constants in the source termsin the
convection-diffusion equations.

Aninteger isfirst read, corresponding to the equation number. Then atext string of up
to 15 character is given. The text is the name of the variable in the equation.

Q (1-..)All other Q data sets have the following in common:

Thefirst integer specifies which source term is used. If the integer is below 1000 or
above 3000, the sourcetermisapplied for all the cells. If the integer is above 1000, but
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Q1

Q2

Q3

Qu

Q42

below 2000, the source term is only applied to the cells closest to the water surface.
These terms can typically be used for specification of fluxes across the water surface.
If the integer is above 2000 but under 3000, the source term only appliesto the cells
closest to the bed.

The second integer after the Q isan index equal to the number of the equation the
source term is applied to.

In the following, note that thisis not repeated, and the two fist integers are not
described further.

The second number is afloat, giving the value of a constant source.

The second number is an integer. Thisisan index for the variable in the source term.
The third number isafloat, giving a coefficient which is multiplied with the variable.

Example: Q 212 0.05

This means that a source term for equation 1 is used, and the source term is 0.05 multi-
plied with the value of variable 2.

The second number is an integer. Thisisan index for the first variable in the source
term. The third number isan integer, giving the second variable in the source term. The
fourth number is afloat, which is multiplied with both variables.

Examples Q31210.04

This means that a source term for equation 1 is used, and the source term is 0.04 multi-
plied with the value of variable 2, multiplied with the value of variable 1 (the same
variable as calculated for this source term).

Fall velocity data set. Thisis aspecia data set to include the effect of the fall velocity
of awater quality constituent, for example sediments or algae. A constant fall velocity
isgiven. Note that calculating algae with variable fall velocity as a function of light
irradiance, for example the Q 151 / Q 221 data sets can be used instead.

The second parameter isafloat, whichisthe fall velocity in meters/second. A positive
number denotes arise velocity, while a negative number denotes afall velocity in
downwards direction.

Example: Q 11 2 -0.0001

Variable no. 2 has afall velocity of 0.1 mm/second.

SSIIM 2 only. Specia data set to calculate algae growth where there is only one spe-

ciesof algae, and thisisonly growth-limited by light. Four floats are read. The first
two floats are constants in the regression formula for the vertical attenuation coeffi-
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Q51

Q113

Q121

Q 122

Q123

cient asafunction of the algae concentration. The last two floats are the coefficients cO
and cl in the formulafor algae growth.

SSIIM 2 only. Special data set for fall velocity for dinoflagellates as afunction of irra-
diance. Fivefloats are read after the control integer. Thetwo first are coefficientsin the
formulafor the light attenuation coefficients. The third isthe optimum irradiance. The
fourth is the maximum fall/rise velocity in m/s. The fifth is the difference between
optimum and actual irradiance when the fall/rise velocity is maximum.

Example: Q 511 0.45 4.8 100.0 0.01 100.0
The algae concentration isin variable number 1.

SSIIM 2 only. Special data set to calculate light history, if more than one algae species
or sediment variable contribute to the light shading:

integer 1: pointer to irradiance variable
float 1: averaging time period in seconds

SSIIM 2 only. Special data set to calcul ate predatation. This data set must be used for
both the phytoplankton and the zooplankton.If phytoplankton is cal culated, the grazing
rate is negative. If zooplankton is calculated, the grazing rate is positive.Note that if
zooplankton is calculated, the coefficient also includes the grazing efficiency and pos-
sible conversion between phytoplankton and zooplankton units.

Example: Q 12124 -0.01 1.067

Algaeis calculated as variable no. 2, zooplankton as variable no. 4. The grazing rateis
0.01 and the temperature coefficient is 1.067.

SSIIM 2 only. Special data set for reduction of patogens from light. One integer and
two floats are read. The second integer is a pointer to the irradiance variable. Thefirst
float isthe proportionality constant for decrease of patogens. The second float is atem-
perature constant.

Example: Q 122 1 3-0.001 1.067

Pathogens are calculated as variable no. 1 and irradiance as variable no. 3. The propor-
tionality constant is-0.001 and the temperature coefficient is 1.067.

SSIIM 2 only. Special data set for sorption, containing one integer and two floats. The
integer isan index to the sediment variable. Thefirst float isthe absorption coefficient.
The second float is the fall velocity of the sediment.

Example: Q 123 24 0.1 0.005

Variable no. 2 is adsorped to variable no. 4, with the adsorption coefficient 0.1.
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Thefall velocity of variable 4 is 5 mm/second.

Q 131 SSIIM 2 only. Special data set for calculation of algae fall velocity from density
variable

integer 1: pointer to algae density

float 1: algae diameter in meters, from Q 221

float 2: form resistance (around 1.0-1.15), from Q 221
float 3: temperature in degree Centergrade

Q 132 SSIIM 2 only. Special data set for calculation of light history from one species of
algae. Thelight history is calculated by aformula and fixed.

integer 1: pointer to algae concentration

float 1: a- regression constant in formulafor specific vertical attenuation coefficient,
asQ42

float 2: b - regression constant in formulafor specific vertical attenuation coefficient,
asQ42

float 3: averaging period in seconds, for example: 86400.0 for 24 hours

Q 133 SSIIM 2 only. Special data set for calculation of light history from one species of
algae. Thelight history is calculated as a passive contaminant.

integer 1: pointer to algae concentration

float 1: a- regression constant in formula for specific vertical attenuation coefficient,
asQ42

float 2: b - regression constant in formulafor specific vertical attenuation coefficient,
asQ42

float 3: averaging period in seconds, for example: 86400.0 for 24 hours

Q 151 SSIIM 2 only. Thisisaspecia data set to calculate the density of algaein alake. The
second number is an integer, which is an index for the variable number which isthe
algae concentration. The algae concentration is used when calculating the light trans-
mission. After the second integer, five floats are read. Thefirst float is the light trans-
missivity. The second, third and fourth float are coefficients c1,c2 and c3 in the
formulafor agae density. Thefifth float isthe half-saturation irradiance for maximum
rate of density increase. Thisis also used in the density formula.

Note that the convection-diffusion equation is not solved for the algae density, but
from auser point of view, thisvariable is similar to other variables.

Example: Q15112 1.02.03.04.05.0
Algal density isin variable no. 1, and algae concentration isin variable no. 2. The light
transmissivity is 1.0, and the coefficientsin the density equations are: ¢1 = 2.0, c2 =

3.0, c3 =4.0. The half-saturation irradiance coefficient is 5.0. Note that these numbers
are arbitrarily chosen, and may be unphysical.
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Q 161

Q221

Q 252

Also notethat if aQ 151 data set is present in the control file, and the timel fileisread
for time-dependent calculations, an extrafloat is read as the last number of each line.
Thefloat isthe irradiance.

SSIIM 2 only. Specia data set to calculate algal density for cyanobacteria. The second
number is an integer, which isan index for the variable number which is the algae con-
centration. The algae concentration is used when calculating the light transmission.
After the second integer, five floats are read. Thefirst float is the light transmissivity.
The second, third and fourth float are coefficients c1,c2 and c3 in the formulafor algae
density. Thefifth float is the half-saturation irradiance for maximum rate of density
increase. Thisis also used in the density formula.

Note that the convection-diffusion equation is not solved for the algae density, but
from auser point of view, thisvariable is similar to other variables.

Example: Q 16112 0.67 0.087 2.03.04.05.0

Algal density isin variable no. 1, and algae concentration isin variable no. 2. The
coefficients in the equation for light transmissivity are 0.67 and 0.087, and the coeffi-
cientsin the density equationsare: c1 = 2.0, c2 = 3.0, c3=4.0. The half-saturation irra-
diance coefficient is 5.0. Note that these numbers are arbitrarily chosen, and may be
unphysical.

Also notethat if aQ 161 data set is present in the control file, and the timel fileisread
for time-dependent calculations, an extrafloat is read as the last number of each line.
Thefloat istheirradiance.

SSIIM 2 only. Thisaspecial data set that calculatesthe fall velocity of algaein alake.
The second and third number are integers. The second number points to the variable
number of the algae density. The third integer points to the variable number of the tem-
perature. Then two floats follow. The first float is the al gae diameter in metres. The
second float is a form resistance coefficient, usually around 1.0.

Example: Q221210 0.00001 1.0

The algae concentration is variable no. 2, the algae density is variable no. 1, and the
temperature is variable no. 0. The algae diameter is 0.00001 meters and the form
resistance coefficient is 1.0.

SSIIM 2 only. Special data set to calculate algae growth in case of only one nutrient +
irradiance limiting the growth:

integer 1: integer pointing to algae concentration
integer 2: pointer to light irradiance variable
integer 3: pointer to nutrient variable

float 1: cO - formulafor growth rate, k, irradiance.
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Q 261

Q 281

Q 282

float 2: cl - formulafor growth rate, k, irradiance.
float 3: kmax - maximum growth rate

float 4: Ks constant for nutrient

float 5: temperature coefficient

SSIIM 2 only. Specia data set for nutrient depletion from algae growth, for multiple
algae species limiting the light, and one nutrient. Three integers and seven floats are
read:

integer 1. integer pointing to nutrient variable
integer 2: integer pointing to light variable

integer 3: integer pointing to algae variable

float 1: cO - formulafor growth rate, k, irradiance.
float 2: cl1 - formulafor growth rate, k, irradiance.
float 3: kmax - maximum growth rate

float 4: Ks constant for the nutrient being cal culated
float 5: temperature coefficient

float 6: fraction of nutrient in agae growth

SSIIM 2 only. Special data set for algae growth, with phosphorus, nitrogen and light
asthe limiting variables:

integer 1: integer pointing to algae variable

integer 2: integer pointing to phosphorous variable

integer 3: integer pointing to nitrogen variable

float 1: a - regression constant in formulafor specific vertica attenuation coefficient
float 2: b - regression constant in formula for specific vertical attenuation coefficient
float 3: cO - formulafor growth rate, k, irradiance.

float 4: cl - formulafor growth rate, k, irradiance.

float 5: kmax - maximum growth rate

float 6: Ks constant for phosphorous

float 7: Ks constant for nitrogen

float 8: temperature coefficient, Kt

Thefirst four floats are similar to the Q 42 data set.

SSIIM 2 only. Special data set for calculation of algae density from one species of
algae:

integer 1. integer pointing to algae density

integer 2: pointer to algae concentration

integer 3: pointer to light history

float 1: a - regression constant in formula for specific vertical attenuation coefficient,
asQ42

float 2: b - regression constant in formula for specific vertical attenuation coefficient,
asQ42

float 3: c1 - formula’5, SCUM, as Q 151
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Q 201

Q 361

Q371

float 4: c2 - formula5, SCUM, as Q 151

float 5: ¢3 - formula’, SCUM, as Q 151

float 6: Ki - half-saturation irradiance, formula’5, SCUM, as Q 151
float 7: minimum algae density

float 8: maximum algae density

SSIIM 2 only. Specia data set for nutrient depletion from algae growth, for two
nutrients and one algae shading the light. Two integers and nine floats are read:

integer 1. integer pointing to nutrient parameter

integer 2: integer pointing to algae variable

integer 3: integer pointing to the other nutrient variable

float 1. a - regression constant in formula for specific vertical attenuation coefficient
float 2: b - regression constant in formulafor specific vertica attenuation coefficient
float 3: cO - formulafor growth rate, k, irradiance.

float 4: cl - formulafor growth rate, Kk, irradiance.

float 5: kmax - maximum growth rate

float 6: Ks constant for the nutrient being cal culated

float 7: Ks constant for the other nutrient

float 8: temperature coefficient

float 9: fraction of nutrient in agae growth

The data set is used for both nitrogen and phosphorous. It issimilar to Q 281, but the
last float is the fraction of the algae growth.

SSIIM 2 only. Special data set to calculate algae growth in case of two nutrients+light
l[imiting the growth:

integer 1: integer pointing to algae concentration
integer 2: pointer to light irradiance variable
integer 3: pointer to phosphorous variable

integer 4: pointer to nitrogen variable

float 1: cO - formulafor growth rate, Kk, irradiance.
float 2: cl - formulafor growth rate, Kk, irradiance.
float 3: kmax - maximum growth rate

float 4: Ks constant for phosphorous

float 5: Ks constant for nitrogen

float 6: temperature coefficient

SSIIM 2 only. Special data set for nutrient depletion from algae growth, for multiple
algae species limiting the light, and two nutrients. Three integers and seven floats are
read:

integer 1: integer pointing to nutrient parameter

integer 2: integer pointing to light variable

integer 3: integer pointing to algae variable

integer 4: integer pointing to the other nutrient variable
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float 1: cO - formulafor growth rate, k, irradiance.
float 2: c1 - formulafor growth rate, k, irradiance.
float 3: kmax - maximum growth rate

float 4: Ks constant for the nutrient being cal culated
float 5: Ks constant for the other nutrient

float 6: temperature coefficient

float 7: fraction of nutrient in algae growth

The dataset issimilar to Q 291, except for the extrainteger pointing to the light irradi-
ance, and the omission of the attenuation coefficients.

Q 1001  The second number isafloat, giving the value of a constant source.

Q 1002  The second and third numbers are floats. The source term is:
Source = floatl * (float2 - variable)
Example: Q 2 1 0.0005 20.0
Sourcel = 0.0005 * (20.0 - variablel )
Thisterm can be used for calculation of temperature fluxes across the water surface,
where the first float is the heat exchange coefficient for the water surface and the sec-
ond float is the air temperature.

Q 1003  The second number isan integer. Thisisanindex for the first variable in the source
term. Thethird number isan integer, giving the second variable in the sourceterm. The
fourth number is afloat, which is multiplied with both variables.

Example: Q 3100121 0.04

Thismeansthat a source term for equation 1 isused, and the source term is 0.04 multi-
plied with the value of variable 2, multiplied with the value of variable 1 (the same
variable as calculated for this source term)

Q1012 The second number is an integer. Thisisan index for the variable in the source
term. The third number is afloat, giving a coefficient which is multiplied with the var-
iable.

Example: Q 1012 1 2 0.05

This means that a source term for equation 1 is used, and the source term is 0.05 multi-
plied with the value of variable 2.

Q 1060  Specid data set to calculate temperature flux at the water surface. Six floats are
read:
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float 1. multiplication factor, B, for irradiance from the timei file (1.0)
float 2: acoefficient, A, for light attenuation (0.5-0.7)

float 3: air vapour pressure, ey, (MMHQ)

float 4 reflection coefficient, RL (0.03)

float 5: water emissivity, e (0.97)

float 6: Bowen's coefficient, c1 (0.47 mmHg/C)

Q 1102  Special data set to calculate gas transfer at the water surface. The data set has two
floats as parameters: c,;, and a coefficient, r, which is multiplied with the eddy-viscos-
ity to give the effective diffusion. The data set is only applied to the cells bordering the
water surface.

Q 2001 The second number is afloat, giving the value of a constant source.

Q 2002 The second number is an integer. Thisisan index for the variable in the source
term. The third number is afloat, giving a coefficient which is multiplied with the var-
iable.

Q 2003  Thesecond number isan integer. Thisisan index for thefirst variable in the source
term. The third number isan integer, giving the second variable in the source term. The
fourth number is afloat, which is multiplied with both variables.

Q 2030  Specia data set to calculate resuspension, where three floats are read. The first
float isthe critical shear stress for initiation of resuspension. The second integer isthe
coefficient ain the resuspension equation, being proportional to the shear stress sur-
plus raised to the third coefficient. The critical shear stressis given in Pascal.

Example: Q 20303 0.30.11.5

The resuspension is calculated for variable no. 3, and the critical shear stressis 0.3 Pa.
Q6100 SSIIM 2 only. Special data set for calculating irradiance when there are more than

one algae species or sediment concentration. The data set reads six integers and ten

floats. Thefirst integer isthe number of algae species. The following integers are

indexes for the variable numbers of the algae. Then ten floats are read, which are pairs

of coefficientsfor the light attenuation curve.

Example: Q 61009256000 0.07 0.20.06 0.230.00.00.00.00.00.0

Here, variable no. 9 isthelight irradiance. Two species of algae is used: variable no. 5

and no. 6. The light transmissivity coefficients are 0.07 and 0.2 for the first agae spe-

ciesand 0.06 and 0.23 for the second algae species.

Note that the component reducing the light does not have to be an algae. It is also pos-
sible to specify for example an inorganic sediment.

5.3.11 The Sdata set
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The S data sets gives the size and fall velocity of the sediments. Aninteger isfirst read, indi-
cating the size group. Then the diameter in meters are given and then the fall velocity in m/s.

Example: S1 0.001 0.06

Sediment size 1 has adiameter of 1 mm, and afall velocity of 6 cm/s.

Note that the coarsest sediment size should be number 1, and then thefiner sizes should follow
with the finest size having the highest index.

5.3.12 TheT data set

T Titlefield. The following 30 characters are used in the graphics.

5.3.13 The W data sets

w1

Stricklers number, discharge and downstream water level. This data set must be
present in the file. The parameters given here are used to generate the water level for
the calculations using a standard backwater calculation.

Default valuesfor SSIIM 2: W1 50.0 1.0 1.0
Note that the Strickler value M is 1.0/n, where n is the Manning's number.
Integers identifying which cross-sections are used in theinitial backwater water sur-
face computation. First, an integer isread, giving the number of cross-sections. Then,
the number of each cross-section is given.
For example, if the grid has 20 cross-sections, and three sections are used: the first
(number 1), the last (number 20) and one in the middle (number 10), the following
dataset isgiven:

W2311020

The water elevation for the other cross-sections in between will be linearly interpo-
lated.

SSIIM 1 only. Specification of extrawalls for the multi-block water flow module.
Seven integers have to be given for each wall. There can be up to 29 walls, and each
wall is described on one W 4 data set.

The variable names are;

W 4 dir posneg node al a2 bl b2
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Thefirst integer, dir, indicates the plane. 1 isthe j-k plane (cross-section), 2 isthei-k
plane (longitudinal section) and 3 isthei-j plane (seen from above).

The second integer, posneg, indicates which of the sides of the cell is calculated asa
wall. Three possible options exist: 1, -1 or 0. If O isgiven, apreviously set wall is
deleted. If theindex is 1, the wall is calculated on the wall in the direction of declining
cell indexes. If -1 isgiven, thewall is calculated in the direction of increasing cell
indexes. Thisisfurther explained in Fig. 5.3.1.

The third integer is the number of the node plane.

An exampleisgivenin Fig. 4 below. The figure showsthei-j plane (the grid seen from
above). Thewall isto be given in cells where i=4 (between cross-section no. 3 and 4).
If the second integer, posneg, is 1, then wall laws are applied on cross-section no. 3,
between cell 3 and cell 4, in the negative i-direction. If posneg = -1, then the wall laws
are applied on cross-section no.4, between cell no. 4 and 5, in the positive i-direction.

]
‘ A
(4,5 (5,5 (6.5)
2
posneg=-1/ posneg=1
(4.3) % (5.3)
%
(32) (62)
[
—>

Figure5.3.1

Thefollowing integers are indexes al a2 b1 b2, which gives the two-dimensional coor-
dinates for the corner points of the part of the plane that is described. The four varia-
bles are similar to the variables with the same name on the G 7 data set.

Note that if an internal wall is used, where water isflowing on both sides of the grid
line, then wall laws must be declared on both sides of the wall, and two W 4 data sets
must be used.

Example: If the groyne givenin Fig. 4 isto block the water from the bed to the water

surface and there are four cellsin the vertical direction (cell no. 2 to 5), the following
data sets have to be given:
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W41142425
W41-152425

Two W 4 data sets have to be given, one for each side of the groyne. Thefirst isfor the
left side (Fig. 4), and the second isfor the right side.

SSIIM 1 only. Different Strickler’s values than the default value for cross-sections. An
integer isfirst read, which tells how many cross-sections are read. Then an integer and
afloat isread for each cross-section. The integer tells which cross- section is changed,
and the float tells the Strickler’s value. Several W 5 data sets can be used.

Note that the Strickler’s value in the most upstream cross-section will be used on a
reach between two cross-sections. The Strickler’s values are the inverse of the Man-
nings n values: M=1/n.

NoMovePoint - a point which isused in the Grid Editor. Two integers are read, which
isthe numbers of thei andj grid lines. The intersection of these lines are not moved by
the elliptic grid generator. One W 6 data set is required for each NoMovePoint. Maxi-
mum 19 999 points can be used. The W 6 data set is usually generated by the Grid Edi-
tor.

Attraction point used in the Grid Editor. Each W 7 data set represents attraction to one
grid line or point. Maximum 1999 attraction points can be used. An integer isread first
which tells the type of attraction. The following options are given:

0: Point attraction in i-direction
1: Point attraction in j-direction
2: Line attraction in i-direction
3: Line attraction in j-direction

Then two integers are read, that tell which grid line intersection the attraction is
towards. For the line attraction, only one of the integers are used. Then the two attrac-
tion parameters are read, which are floats.

The W7 data set is normally generated by the Grid Editor.
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5.4 The koordina and koomin files

The koordinafile describes the bed of the geometry with a structured grid (SSIIM 1). An
example is show in the figure below. The grid can be made using a map, a spreadsheet or the
GridEditor.

<,> : grid intersection

xnumber = 4 .
(,) : calculation node

ynumber = 5 <4,5>

Ccross

stream

wise

direction

i

Streamwise direction

The necessary input data is the x,y and z coordinates of the points where the grid lines meet.
The format of the datais given below.

] Xy z
An example:

11034054 011

12 0.35 0.66 0.12

Thefirst two numbers are integers, while the following three are floats. The numbers are read
in afree format, which means that the distance between them does not matter. The sequence of
the points are not important, as long as al points are included. Thisis not controlled by the

model, so the user must do the check by looking at the grid in the graphic modules of the pro-
gram.

If atunnel is simulated, or the user wants to specify the water surface, an additional floating
point number isread for each line. This givesthe top level for each grid intersection. An
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example:

110340501 121
12035 066 012 1.33

To make SSIIM read the last float, the K 2 data set in the control file must be: K 200 (SSIIM
1)

Some words about indexing and numbering of grid lines and cells. The variable namesfor the
number of grid linesin the three directions are:

xnumber : number of cross-sections
ynumber : number of longitudinal lines
znumber : number of horizontal planes

The numbering of the grid lines goes from 1 to xnumber in the streamwise direction, and sim-
ilarly for the other two directions.

However, the grid lines define cells between the grid lines. The variables are calculated in the
center of each cell. This means that a numbering system for the cellsis aso required. The
word node is often used for the center of acell.

From ageometrical view of thegrid, it isobserved that the number of lines always exceedsthe
number of cells by one in each direction. When the arrays are defined, it is therefore a choice
for the programmer to start the numbering of the cells on one or two. The choice that is made
in SSIIM isthat the numbering starts on two. This means that the cell that is defined by grid
linesi=1 and i=2 and j=1 and j=2 has the number (2,2). Cell number (1,1) does not exist. The
numbering of the cellsis also shown in Fig. 1. The numbering of the grid linesis shown with
the <,> sign, while the numbering of the calculation nodes is shown with the (,) sign. The grid
IS non-staggered.

The data on the koordina file defines a surface. It is possible to make afile with exactly the
same format and call it koomin. This surface is then used as a minimum elevation surface for
bed changes. The bed will not be lowered under this surface.

If SSIIM terminates right after startup and the boogie file contains the following message:
Error, negative areasfor cell i=13, j=2, or some other combinations of i and j, then thereisan
error in the koordina file. The indexes denote the cell number, so for i=13, j=2, the x and y
coordinates for the following grid line intersections should be checked: (13,2); (13,1); (12,2)
and (12,1).

SSIHM 2

The koordina file used in SS 1M 2 will always include the water surface location, meaning
each line has two integers and four floats.
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5.5 The unstruc file (SSIIM 2 only)

The geometry datais stored in the unstruc file. This file contains the coordinates of all grid
line intersections, which cells are connected with other cells, which surfaces are connected to
which cells etc. It also contains information about inflow/outflow of water and water quality
constituents.

Because of the complexity of thefile, it isnot possible to generate thisfile using an editor or a
spreadsheet. Thisfile must be generated by SSIM 2.

Note that the first linein the file gives the grid size for allocation of arrays. Thefirst integer is
anumber below 10, for the files generated with the newest versions of SSIM 2. The second
number is the number of grid cells. The third number is the number of surfaces. The fourth
number is the number of blocksin the grid. The fifth number is the number of connections
between the blocks. The sixth integer is the number of connection surfaces between the
blocks. The seventh integer is the number of outer surfaces on the nested blocks. The last inte-
ger on the line is the number of pointsin the grid.

Thisinformation can be used to set the size of the arrays allocated by SSI1M 2 on the F 65 data
Set.

Example: 1 22500 75600 1 0 0 0 308041

The line specifies that the unstruc file is generated by a newer version of SSIM 2, since the
first integer is below 10. The grid has 22500 cells, 75600 surfaces and 308041 points. It con-
sists of only one block, and there are no connections between blocks (sinceit is only one
block) and no nested surfaces (since there are no nested blocks).

In unstruc files generated by older versionsof SSIM 2, thefirst integer isthe number of points
in the grid. Thiswill always be above 10. Then there will be one less integer on the first line,
compared with the unstruc file produced by the newest SSIM 2 versions. The newest SSIM 2
version can read both formats and is therefore backwards compatible with old unstruc files.

Automatic grid changes

The default water surface elevation is completely horizontal when starting to make agrid
using SSIIM 2. When modelling ariver, one often would start with a sloping water surface.
Also, one might want to start with adry bed that can be wetted later. The unstruc file must also
contain some information about the grid in the dry areas. The initial grid of the unstruc file
therefore must cover the whole geometry that can be wetted, which means afairly large water
surface elevation must be used. Starting the computation with alower water surface is then
done by using the F 112 data set. If theinteger on thisdataset isset to 1, then the grid isregen-
erated right after the unstruc file is made. Before the regeneration, the koordina fileisread. In
the koordina file, the water surface elevation can be specified, and this can be a sloping sur-
face. The water surface can also be below the bed, giving a startup with a partially dry geome-

try.
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5.6 The geodata file

Thisfile contains a number of x,y and z coordinates. An example is shown below:

E223334
E453322
E334212
Z3.03.03.0

The letter E is used for counting the number of points. The letter Zis used for thelast linein
the file. The numbers on this line are not used.

The purpose of thisfileisto use geometrical datathat has been obtained from the field, adig-
itized map or a GIS system.

Thefileisused in the GridEditor, to display the pointsin the file when generating the grid.
The View option of the menu and the Geodata points option in the pull-down menu activates
this. The grid points are displayed with different colours according to which level they are.

The second use for thisfileis also in the GridEditor. It isthen used in the Make bed interpola-
tions for generating the z values for the bed of the grid. A linear interpolation procedureis
used. The procedure is further described in Chapter 4.3.

The GridEditor in SSIIM 2 makes it possible to add new geodata points graphically. After-
wards, the total set of points can be written to a new geodata file. Similarly, points can be
deleted. Thisis convenient for studies investigating changes in the geometry. Note that only
498 new geodata points can be added at once. If you want to add more points, write the geo-
data file to the disk, and then read it back again.

Also note that even if SSIIM 1 is used for the water/sediment flow computation, it is still pos-
sible to use SSIIM 2 to modify the geodata file, and read it by SSIIM 1 afterwards.

5.7 The bedrough file

Thisfileisused to give aroughness height to individual bed cells. Vauesin thisfile overrides
the value calculated from Manning-Strickler’s coefficient, and the value given on the F 16
data set. On each line a character, two integer and afloat are given. The first character isaB,
and the two following integers are indexes for the bed cell. The float is the roughnessin
meters. An exampleis given below:

B 19 2 0.001
B 19 3 0.001
B 19 4  0.001

152



5.8 The porosity and vegdata files

Note: When calculating porosity, use aP on the F 7 data set in the control file. When using the
vegdata file, the F 115 data set has to be included in the control file

The porosity fileisonly used in SSIM 1. The vegdata fileis used in both SSIM 1 and SSIM
2.

The two files are used when the bed of the river is covered by stones or vegetation, introduc-
ing asink term for the velocities.

Porosity file

The file describes the |ocation and magnitude of the porosity or vegetation in the geometry.
An example of aporosity fileis given below:

P 17 6 3.349774 3.399189 3.450101 3.499517 0.000000 0.700000 0.833333 1.000000
P 17 7 3.358273 3.413603 3.470610 3.525940 0.000000 0.653846 0.807692 1.000000
P 17 8 3.403323 3.426084 3.449536 3.472297 0.000000 0.642857 0.785714 1.000000

First, the character P isread. Then two indexes for thei and j number of the bed cell isread.
Then four vertical levels are read, which have the same zero reference as the koordina file.
The porositiesin each of these levels are then read.

The porosity file can be made from a koordina file and a geodata file. The module that does
thisis activated from the main menu of the user interface, from File and Make porosity filein
the pull-down menu. The procedure goes through each element and used the pointsin the geo-
data file to obtain the data. The procedure is described in more detail in Chapter 2.3.

Vegdatafile

The vegetation is modelled as a number of vertical cylindersin each cell. A drag formulais
used to determine the force between the water and the stems. The drag formula computes the
sink in the velocity equations as proportional to the velocity squared. If adifferent formulais
to be used, it can be coded in the vegdll.dll file.

The vegdata file issimilar to a porosity file, in that each line describes one bed cell and each
line starts with aletter and then two indexes for the cell is given. Then four levels are given.

There are different types of vegdata set. The types are identified by the first letter in the line.
AV data set is similar to the P data set, except instead of the porosity, four vegetation values
have to be given. The vegetation values are defined by multiplying the following three param-

eters.

1. The drag coefficient for the vegetation stems. Thisis usually around unity
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2. The diameter of the stems (in meters)
3. The number of stemsin each cell.

As an example, say there are five stemsin each cell, with diameter 7 cm, and the stems are cir-
cular with adrag coefficient of 1.0. The vegetation parameter becomes: 1.0x.07x5 = 0.35.

An Adatasetissimilar to aV data set, except the number of stems pr. square meter is given
instead of number of stemsin each cell.

Example:

A 76 16 37.05 37.20 37.35 37.55 3.0 1.0 1.2 05
A 76 17 37.05 37.20 37.35 37.65 3.0 1.0 0.8 0.5
A 76 18 37.05 37.20 37.25 37.75 40 1.0 1.1 05

A B data set issimilar to an A data set, but 4x4 more floats are read on each line. First, four
numbers are read, giving the number of stems pr. square meter for each of the four levels.
Then four numbers are read giving the diameter of the stems. The next four numbers are the
drag coefficients. The final four numbers are empirical parametersin the epsilon equation.
The additional terms are used for source termsin the k and epsilon equations.

The vegetation parameter can be seen in the map graphics. Thisisagood way of testing that
the correct values are given in the input file.

Using SSIIM 2, thereisonly one index for each cell. In the vegdata file, two indexes are
given. The two indexes corresponds to the indexes used in a structured grid. Thissystem is
necessary asin SSIIM 2, as the numbering of the cells changes over time during wetting and
drying.
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Figure 4.8.1 Interpolation of vegetation/porosity value, Pc, for one cell, ¢, in the grid.
Four points, 1-4 define a porosity/vegetation value as afunction of the vertical elevation

If the vegetation changes over time, it is possible to describe the vegetation at several timesin
the vegdatafile. To do this, a T data set has to be given between each group of vegetation data
sets. The T data set also has to have afloating point number, which will be the time when the
dataset isvalid. The program will interpolate between the different times given in the vegdata
file.

When time-dependent changes in the vegetation is computed, then the F 201 data set hasto be
used inthe control file. Also an U data set hasto be used in the vegdatafile. The U data set has
to have the same integers as on the F 201 data set.

Example:
Control file: contains F 201 1 4 3 (three times)
Vegdata file:

ul43

T0.0

A 76 16 37.05 37.20 37.35 37.55 3.0 1.0 1.2 05

A 76 17 37.05 37.20 37.35 37.65 3.0 1.0 0.8 0.5

A 76 18 37.05 37.20 37.25 37.75 4.0 1.0 1.1 05

... (all A data setsfor this geometry and time= 0.0 seconds)
T 10000.0
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A 76 16 37.05 37.20 37.35 37.55 5.0 20 1.2 0.5
A 76 17 37.05 37.20 37.35 37.65 5.0 2.0 0.8 0.5
A 76 18 37.05 37.20 37.25 37.75 5.0 20 1.1 05
.. (all A data sets for time=10000 seconds)

T 30000.0

A 76 16 37.05 37.20 37.35 37.55 3.0 1.0 1.2 05
A 76 17 37.05 37.20 37.35 37.65 3.0 1.0 0.8 0.5
A 76 18 37.05 37.20 37.25 37.75 40 1.0 1.1 05
.. (all A data sets for time=30000 seconds)

5.9 Theinnflow file (SSIIM 1 only)

Thisfileisused to read velocities in three directions for the upstream boundary condition. The
program searches for thisfile, and usesthe dataon thefileif it exists. If the file does not exist,
awarning message is written to the boogie file, and the program proceeds normally.

On each linethevelocitiesin acell of the upstream cross-section are given. First, the character
E iswritten. Then the indexesj and k (horizontal and vertical) are given. Then the velocity
components in the x,y and z directions are given. An example is given below:

0.299115 0.023009 O
1.79469 0.138055 O
1.9941 0.153394 O
2.19351 0.168733 O

abrwN

Thefile does not have to contain valuesfor all the nodes. The normal initialization procedures
are applied first, and then the innflow file is read. The nodes that are not present in the innflow
file will keep the values from before the file was read.

It isalso possible to specify k and € in the innflow file. Then each line should start with aD
instead of an E, and the values of k and € should be given after the velocities.

5.10 Theresult file

Thisfile contains the results from the water flow calculations. Thefileiswritten when the pre-
scribed number of iterations have been calculated or when the solution has converged. The
results are velocities in three dimensions, k, €, pressure, and the fluxes on all the walls of the
cells. The datafrom thisfileis used as input for the sediment flow calculations. Thisfile can
also be read when the user wantsto start the water flow calculations from where the result file
was last written (hot start).

An example of aresult filefor SSIIM 1:
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Results from SSIM - flow, iter = 12910

Residuals: 0.000732 0.000588 0.000002 0.000003 0.001000 0.000000

Roughness : 0.050000

C54911

ijk uv w keflf21f3p

D 1 1 10.00000000e+00 0.00000000e+ 00 0.00000000e+00 0.00000000e+00 0.00000000e+ 00 0.00000000e+ 00
0.00000000e+ 00 0.00000000e+00 0.00000000e+00

D 1 1 20.00000000e+00 0.00000000e+ 00 0.00000000e+00 0.00000000e+00 0.00000000e+ 00 0.00000000e+ 00
0.00000000e+ 00 0.00000000e+00 0.00000000e+00

D 1 1 30.00000000e+00 0.00000000e+ 00 0.00000000e+00 0.00000000e+00 0.00000000e+ 00 0.00000000e+00
0.00000000e+ 00 0.00000000e+00 0.00000000e+00

D 2 4 76.31143968e-01 2.02894592e-01 -6.80367016e-05 6.47305125e-03 3.85539263e-04 3.47858729e+03
-5.19507052e+ 02 1.39776552e+ 03 1.91355310e+ 02
D 2 4 86.38189711e-01 2.05198514e-01 -2.09522025e-04 6.40727451e-03 3.13804122e-04 3.54203761e+03
-5.25291012e+ 02 1.09548199e+ 03 1.91350056e+ 02
D 2 4 96.42687814e-01 2.06670571e-01 -3.70305526e-04 6.37079494e-03 2.71714390e-04 3.58421958e+ 03
-5.28978103e+ 02 7.51732364e+02 1.91343817e+ 02

Thefirst lines give the residuals, the roughness and the grid size. Then each line givesthe nine
valuesfor one cell. The letter D starts the line, then the three indexes for the cell. Then the
three velocities, the k and € values. Then the fluxes in the three directions and finally the pres-
sure. All the parameters are placed on one line in the file, although thisis not shown above
because the line was too long.

A commonly asked question is the meaning of the valuesin the cellswith index 1. The first
cell hasindex 2. The answer isthat these indexes denote the values at the boundary. Or in a
cell at the wall, with zero thickness. The velocity in these cells will usually be zero, unless
there is water inflow or outflow there.

An example of aresult filefor SSIIM 2:

Results, iter = 3601

Residuals: 0.054663 0.079991 0.018223 0.029072 5.240989 218.573547

Roughness : 0.005000

U 16316 11940 39679100

i u v w k e p

C 15.20752712e-002 3.87287893e-002 -2.91152289e-002 1.83900666e-004 2.20008542e-004 6.98685775e+ 001
C 2 -2.97928650e-003 1.18274871e-002 -2.83168656e-002 4.95138596e-005 1.79039199e-005 6.98566087e+ 001
C 3-2.34130748e-003 1.18835706e-002 -2.32318333e-002 2.81046242e-005 1.03435021e-005 7.16544156e+ 001
C 4 -4.91827925e-003 3.44957829e-002 -1.59890336e-002 5.50987357e-005 3.38688381e-005 7.04038680e+ 001
C 5-9.62809076e-003 5.08444254e-002 -1.13473535e-002 7.34700051e-005 1.08660059e-004 6.95710922e+ 001
C 6 -4.36046706e-003 -4.54215010e-002 -2.87338762e-004 1.13683579-004 4.87075237e-004 6.32869612e+001
C 7 -4.54495962e-003 -4.54039464e-002 -2.24038016e-004 2.32742813e-004 2.86840184e-004 6.32996242e+001
F 25735 4.35128401e-002

F 25736 -4.35876127e-002

F 25737 0.00000000e+ 000

F 25738 0.00000000e+ 000

F 25739 0.00000000e+ 000

F 25740 1.61427895e-001

F 25741 9.94855359¢e-002

F 25742 0.00000000e+ 000

F 25743 0.00000000e+ 000

F 25744 1.27727494e-001
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F 25745 1.46505934e-001
F 25746 0.00000000e+ 000

Similar to thefile for SSIIM 1, thefirst lines give the residual s, the roughness and the grid
size. The U data set gives the number of points, number of cells and number of surfacesin the
grid. Then the number of blocks, connections and connection surfaces are given. After the U
data set, the water velocity parameters are given for each cell. Each line givesthe valuesin
one cell. The line starts with the letter C starts the line, then the number of the cell isgivenin
the unstructured grid. Then the three velocities, the k and € values and the pressure for this cell
isgiven. After al the datafor the cells, the fluxes on all the surfaces are given. Each line gives
aflux for one surface. The line starts with the letter F. Then the number of the surfacesis
given. And then the flux is given, in kg/s of water.

All theresults are given in Sl units, so that for example the velocities are in meters/second,
turbulent kinetic energy is given in m%/s?, epsilon is given in m?/s® and the pressure isin Pas-
cal, or Newton/m?.

5.11 The conres/con2resfiles

The conres and con2res files contains the sediment concentrations in the grid. The conresfile
isused in SSIM 1 and the con2resfileisused in SSIM 2.

The conresfilesiswritten after the sediment concentration calculation has finished. Each line
inthe file containsfirst three indexes indicating for the node number. Then the total concentra-
tion iswritten and then Inumber floats that give the concentration for the sizes. An exampleis
given below:

11 21 0.000000e+00 0.000000e+ 00 0.000000e+ 00 0.000000e+ 00 0.000000e+00
12 2 5.075079e-04 0.000000e+ 00 1.026459e-04 1.030081e-04 1.032351e-04
12 3 4.064470e-04 0.000000e+00 1.011788e-04 1.015358e-04 1.017596e-04
12 4 4.004061e-04 0.000000e+ 00 9.967497e-05 1.000267e-04 1.002471e-04

If afile conres.preexist, thiswill be read by the program before the sediment calculation
starts. The conres.pre file has the same format as the conres file. Note only the sediment con-
centrations are given in the file, and not the grain size distribution of the bed. The concentra-
tions are given in volume fractions.

The con2res file has the same information and format as the conres file, except that each line

only starts with one integer before the concentrations are given. Theinteger isthe cell number
in the unstructured grid.
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5.12 Theinterpol and interresfiles

Vertical profiles of velocity or concentration are sometimes needed. Coordinates for the loca
tions where the profiles are wanted are given in thisfile. When the write results routine is acti-
vated and the integer on the F 48 data set in the control fileisabove 1, it will search for this
file. If thisfile is not found, it will proceed normally and write the result or the conresfile. If
the interpol file is found and the integer on the F 48 data set is above 1, the program will not
writeto the result file, but write the interpolated vertical velocitiesto afile named interres. An
example of an interpol fileis given below:

M 203 05
M 406 0.39
M 406 05

The character M isread first, and then the x and y coordinates for the point one wishesto inter-
polate the vertical profile to. If the value on the F 48 data set is 3 the concentrations are inter-
polated. If the value on the F 48 data set is 2, the velocities, k and € are written to thefile. If
the value on the F 48 data set is 1, the bed levels are written (no profile, only one point). The
results are written to afile called interres.

An example of an interresfileis given below:

C 9.250000 0.100000, size= 0
1.530130 0.000000e+00
1.491877 5.266262e-05
1.415370 9.303652e-05
1.338864 1.349549e-04
1.262357 1.740915e-04
1.185851 2.075269e-04

Thefirst line starts with a C, and then the x and y coordinates of the vertical profileis given.
Two columnsfollow. Thefirst column isthe z value of the vertical profile. The second column
isthe concentration. If velocities are interpolated instead of concentrations, an M iswritten on
thefirst line instead of the C. Instead of the concentration column, five columns are written.
The variablesin the columns are: velocity in X,y and z directions, k and €.

Time-dependent sediment computations

If atime-dependent sediment computation is done, then the question is at what time should the
concentrations be written? If the integer 19 is used on the F 48 data set, then atime in seconds
will be read first on each line of theinterpol file. Also, a T isused as an index instead of an M.
Example:

T 4000 203 05

T 8000 406 0.39
T 9000 406 05
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Theinterresfile will then contain the sediment concentrations at this time.
Thetimein thefileis given in seconds.
Printing cross-sections for ParaView from SSIIM 2.

Sometimes the user wants to see variablesin a cross-section from a SSIIM2 grid. This can be
done by specifying the integer 12 on the F 48 data set, and print the “result” file. Then a Par-
aView file will be written from the cross-section defined in the “interpol” file. Note only one
cross-section can then be given in thefile.

5.13 The verify file

Thisfileisused asinput for the VerifyProfile graphics option. The user can present calculated
velocity or concentration profiles together with measured values. Up to 20 vertical profilesin
a section of the geometry can be shown. The horizontal |ocation of the profiles are determined
by the user, so this method of presentation can be used for both cross-sections, longitudinal
section or other user-defined sections. An example of a verify fileis shown below:

P 40.010.03
5.0050.1
6.50.60.12
7.00.80.05
P 70.010.02
6.01.00.1
8.0150.8

Each profileisidentified with acapital P. Then the x and y coordinates of the point follow. The
coordinates are given in the same system as the grid. After the coordinates, an integer is read.
The integer tells how many points are measured in this profile. Up to 11 points can be given.
On thefollowing linesthe datais given. There must be the same number of lines asthe integer
onthe Pline. Three floats are given on each line. Thefirst isthe vertical coordinate where the
dataistaken. Thisis giveninthe same coordinate system asthe grid. The following two floats
are velocities or concentrations, depending on what is calculated. If velocities are cal cul ated,
the second float is the velocity component in the x-direction and the third float is the velocity
in the y- direction. If concentration is calculated, the second float is the measured concentra-
tion and the third float is a dummy number which is not used. If concentrations are given, the
user can choose in the graphics presentation whether atotal concentration or a fractional con-
centration is presented.

The example above gives two profiles. Thefirst islocated at x = 40.0 metersand y = 10.0
meters. Three data points have been measured. The first point islocated at global coordinate z
= 5.0 meters, and have a measured x-component velocity of 0.5 m/s and ay-component veloc-
ity of 0.1 m/s. The second point is located at global coordinate z = 6.5 meters, and have a
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measured x-component velocity of 0.6 m/s and ay-component velocity value of 0.12 m/s.

5.14 Thetima and timeo files

There are two files that are relevant to time series calculations. Thefirst file, timel, isan input
filefor time series of discharge, waterlevel, sediment concentration and control for output.
The second file, timeo, is an output file with time series from the model.

There are several controls for the correctness of the data given in the timei file. If an error is
detected by the program, a message will be written to the boogie file and the program will ter-
minate.

The timei file can read different types of data sets, which all begins with a capital letter. The
data sets beginning with | and O can beread in both SSIM 1 and SSIM 2.

The O data set

The O data set controlsthe output to the timeo file. A maximum of 20 O data sets can be used.
The data set begins with a capital O, and then reads afloat, Time, and an integer, Vars. Timeis
the time for when the print out starts, and Vars tells how many variables are written to the
timeo file for each time step. Maximum 3000 variables can be written. After reading Time and
Vars, the next lines read which variables are printed and in which cell. Varslines are read.
Each line starts with alower case character, and then three integers (four in case of sediment
concentration) areread. Thisisfor SSIIM 1. For SSIIM 2, only one integer is read (two for
sediment concentrations). The integers indicate which cell the variable islocated in. If sedi-
ment concentration is read (C), the last integer tells which fraction is written. O indicates the
sum of the fractions. If water quality isread (q), another integer is also read, corresponding to
which constituent is written. The characters corresponding to different variables are listed
below:

character variable
u velocity in x-direction
% velocity in y-direction
w vertical velocity
p pressure
k turb. kin. energy
e epsilon
d turb. diffusion
z vertical grid elevation
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c sediment concentration *

q water quality component *

* These variables requires an extra integer read after the index(es) for the cell(s)
Thel data set

The second type of data set isinput data. The line startswith acapital | and then five floatsare
read. Thefirst float indicates the time for when the following variables are used. The second
float is the upstream water discharge. The third float is the downstream water discharge. The
fourth float is the upstream water level, and the fifth float is the downstream water level.
Sometimes one of the last variables are unknown, and then a negative value can be inserted
and the program will try to calculate the value.

If the TFSmethod (F 37 1) isused in SSIIM 1, Inumber floats are read additionally, indicating
the upstream inflowing sediment concentration (volume fraction).

If the TFS method isused in SSIIM 2, N x Inumber floats are read additionally. N isthe
number of inflow groups. The numbers indicate sediment concentration (volume fraction) of
the inflowing sediments for each grain size. The sediment concentrations are grouped accord-
ing to the inflow group. So that first, all the concentrations for the first group is given. Then
the next group etc.

An example of atimel filefor SSIIM 1isgiven below:

0006

u222

c2220

p222

24136

z121

z221

| 0.010.0 10.0-20.0 19.5.0 0.000
| 100.0 10.0 10.0-20.0 19.0 0.000
| 200.0 10.0 10.0-20.0 18.5 0.000
| 300.0 10.0 10.0-20.0 18.0 0.000
| 400.0 10.0 10.0-20.0 17.5 0.000

For SSIM 2, the downstream water level on the | data set in the timei file corresponds to the
first point in the G 6 data set in the control file. If two fixed points are given in the G 6 data
set, the upstream water level on the | data set in the timel file will correspond. Note that this
means the corresponding indexes on the G 6 data set and the | data set in the timei file are
given in reverse order.
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The D data set

For SSIM 2, it is possible to have more than one inflow and one outflow group. Thenitisalso
possibleto vary the water discharge in each group over time. Thisis done using the additional
D dataset in thetimei file. The data set gives the discharges for each time step, similar to the |
data set. Thefirst float read isthe time. Thismust beidentical to the time on the corresponding
| data set. Then ten additional floats are read. The first nine are discharges in the nine first dis-
charge groups. The last float is the water level. Note that zero’s are given for the discharge
groups that are not used.

If the water inflow is not equal to the outflow, there will be awater continuity error. To sup-
press the error message, and keep the program running, the F 85 data set in the control file can
be used.

An example of thetimei filefor SSIM 2 is given below. There are three sediment sizes given
in the control file. In the unstruc file, two inflow groups are given and one outflow group.

I O 0.0 0.0 0.0 0.0 0.0 0.0012 0.0027 0.0 0.00029 0.00032
| 86400 0.0 0.0 0.0 0.0 0.0 0.0018 0.0021 0.0 0.00026 0.00038
| 1728000.0 0.0 0.0 0.0 0.0 0.0011 0.0017 0.0 0.00027 0.00029
DO 56 074 59 0.0 0.0 0000 0.00.0330
D 86400 54 054 151 0.0 0.0 0.0 0.0 0.0 0.033.0
D 172800 5.7 0.84 25.7 0.0 0.0 0.0 0.0 0.0 0.0 32.9

The time-varying discharge can also be used in the same way for water quality computations.
The Q data set

Thisdata set only worksfor SSIIM 2. Ten floating point numbers are read. Thefirst isthetime
step. The following nine are discharges in the nine discharge groups.

The C data set.

This data set only worksfor SSIIM 2. A time step isfirst read. Then ntimes m floats are read,
where m is the number of sediment sizes as given on the G 1 data set, and n is the number of
dishcarge groups where thereis an inflow.

The M data set

The M data set us used to specify time-dependent inflow of water quality constituents for
SSIIM 2. An M data set is also needed in the control file for each of the varying inflow con-
centrations. But instead of using the | or J data set in thetimei file, an M data set is used. On
this data set, thetime is given first, similar to the | data set. Then afloat is given, whichisa
variable time step. The variable time step is not coded yet, but it has but be given in the data
set. Then the three floats for thewind is given, if wind is specified in the control file. Then up
to 20 inflow concentrations are given. Note that the depth and water dischargesfrom the | data
set is not given. The number of inflow concentrationsis the same as the number of M data sets
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in the control file. Irradiance read as the last number of theline, if specified by the Q data sets
in the control file.

The order of the M data setsin the control fileis not important, but the order of the data on the
M datain the timei file has to be the same as the order of the M data sets in the control file.

Thetimeo file

The timeo file gives the output time series from the calculation. For each time step, aline of
variables are written to the file. Each line has Vars floats, according to which variables were
giveninthetimeli file. In the abovefile six variables are written. Thefirst variableis the veloc-
ity in x-direction for cell (2,2,2). The second variable is the sum of all sizes of concentration
for cdl (2,2,2). The pressure and vertical grid elevations for various grid intersections are
written.

The second group of parametersin thetimel fileis an input time series. Each time step in the
series are given on one line. The line starts with a capital 1. Then the time step is given. Then
four floats are read. Thisis the upstream and downstream water discharge and upstream and
downstream water level, respectively. If anegative value is given, the program will try to cal-
culate the value. The last float(s) are sediment concentration(s) for the various sediment sizes.
These are only read if the transient sediment calculation is used. Note that the time steps does
not have to correspond to the time steps of the program. The sum of the calculated time steps
is calculated by the program and compared with the time step in thefile. If the calculated time
exceeds the time from thefile, the values from this dataline will be used. The times must bein
increasing order.

An example of atimeo file corresponding to the above timei file (SSIIM 1) is given below:
0.0000e+00

2.0000e+00 8.804354e-01 6.837692e-04 -1.853305e+ 01 1.950000e+ 01 1.792479%+01
4.0000e+ 00 9.185002e-01 7.081983e-04 -3.949717e+ 01 1.950000e+ 01 1.792458e+01
6.0000e+00 1.100297e+00 1.121773e-03 5.289925e+01 1.950000e+ 01 1.792421e+01

8.0000e+ 00 1.156041e+ 00 1.389383e-03 8.122703e+ 01 1.950000e+01 1.792374e+01
1.0000e+01 1.207883e+ 00 1.614782e-03 9.418469e+01 1.950000e+01 1.792317e+01

Each line corresponds to atime step. A time step of 2 seconds have been used. The first float
isthe calculated time. The second float is the velocity in cell (2,2,2). Then the sum of the con-
centrations in cell (2,2,2) iswritten. Then the pressure and the vertical grid elevations.

Thisformat is chosen so that it is easy to import the file in a spreadsheet for presentations.

5.15 Theforcelog file (SSIIM 1 only)

Thisfile contains time series of the forces on one or more obstacles for the transient free sur-
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face calculation. One lineiswritten for each time step. An example of aforcelog fileis shown
below:

Forceson block 1 : 271.062, 0.099838 N in x and y direction
Forces on block 1 : 398.574, 0.082644 N in x and y direction

5.16 The xcyc and koosurf files (SSIIM 1 only)

The two files xcyc and koosurf contain the geometry of the grid. Thisis used when restarting
calculations which have changed the grid.

The koosurf fileisidentical to the koordinafile, except that the surface level isalso written for
each line. Thisis similar to using the koordina file with the tunnel option.

The xcyc file contains the x, y and z values of all the grid intersections.

When writing the files from the menu, both files will be written. When reading the files,
SSIIM will try to read both files, but if the xcyc fileis missing, it will only read the koosurf
file. Theinternal grid nodes will be generated by linear interpolation, as given on the G 3 data
set in the control file.

If the internal nodes of the grid are generated by linear interpolation, the only necessary fileis
the koosurf file. However, for calculations where some part of the grid moves, and someis
outblocked and does not move, it is necessary to save the xcyc file, and let SSIIM read this.

5.17 The bedresfile (SSIIM 2 only)

The bedres file contains information about the bed sediments, including grain size distribu-
tion, thickness and bed form height. It also contains information about the bed roughness. This
information isimportant when storing the results from a run that takes long computational
times. The bedres file can then be read by SSIIM, to produce graphical results from the run,
with regards to the sediments. When the result file iswritten from SSIIM 2, the bedresit fileis
also written at the same time. If the user renames the file to bedres without an extension, then
SSIIM 2 will seach for thisfile before it reads the result file. It will then use the bedresfile to
update the grid so that it will be similar to the grid written to the result file. The result file will
then be read into the grid it was produced by.

When using the P 10 option in the control file, multiple bedres files are written during a time-
dependent run. These files can also be renamed to have no extension, and read by SSIIM
together with the result file from the same time step.

The second line in the bedres file gives the structured grid size and the number of sediment
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sizes asthefirst four integers. Thisisthe same integers as on the G 1 data set in the control
file. Then the number of 2D depth-averaged cells are written, and then the maximum depth.
The maximum depth is used to determine the number of cellsin the vertical direction, and is
used in the same formula as the parameter on the F 87 data set. The last number on the second
line is an integer, giving how many cells there arein the grid.

Then thereisablock of datawhere each line givesinformation about one depth-averaged cell.
Thefirst two integers on the line gives the i and j indexes of the cell in the 2D structured grid.
Thethird number isafloat. The integer value of thisfloat gives the cell number of the bed cell
in the 2D grid. Then four additional floating point numbers are given: the bed level, the water
level, the limit of movable bed (from the koomin file) and the bed movement.

The last block of data gives information for each 2D depth-averaged cell in the grid. The 2D
cell number is given first (which is not the same as the 3D cell number). Then the 3D cell
number is given, then the roughnessis given twice, the first time from a 3D array and the sec-
ond time from a 2D array. Of course, these should be the same. Then the bedform height is
given. After this, there will be 2(1+L) floating point numbers given, where L is the number of
sediment sizes, asgiven on the G 1 data set. First, the thickness of the active (top) bed layer is
given in meters. Then the sediment fraction for each sediment sizeis given. Then the sameis
repeated for the inactive layer.

If multiple layersare used (F 37 3 and F 134), then N(1+2L) floating point numbers are given,
where N is the number of bed layers as given on the F 134 data set.

5.18 The habitat file

The habitat file gives the availability function commonly used in analysis of fish habitat. The
fileiswritten at the same time as the result file. The availability function is divided in 20
groups, and tabulated so that it can easily be imported into a spreadsheet. This can be used to
determine the preferences for the fish.

The fileis written when the result file is written, if the F 48 data set has the parameter 5.

5.19 The Tecplot and Paraview files

The Tecplot files are result files used for graphics presentation in the Tecplot program. The
files have aformat that makes them directly importable into the Tecplot program. There are
basically two version of thefiles: A 2D version and a3D version. Also, thefiles can be written
by the user interface, through the menu, or from the main program. The main program can
write multiple files for one time-dependent run, making it possible to create animationsin the
Tecplot program. The selection whether a 2D or a 3D tecplot fileis given can be specified on
the F 48 data set.
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The files written by the main program (not by the SSIIM user interface menu) can write user-
specified variables. The specification of the variablesis given on the G 24 data set. This data
set reads a number of data groups, one group for each variable. Up to 30 groups/variables can
be used. Each group consists of one character and two integers. The following table shows the

meaning of these:

Table 2: Variable explanation

Variable Character | Integer 1 | Integer 2
horizontal velocity uorV level not used
vertical velocity w level not used
pressure p level not used
turbulent kinetic energy k level not used
epsilon e level not used
eddy-viscosity d level not used
sediment concentration c level Size no.
water quality q level number
residual for horizontal velocity H level not used
residual for vertical velocity W level not used
residual for pressure R level not used
residual for turbulent kinetic energy K level not used
residual for epsilon E level not used
porosity or vegetation parameter P level not used
water level Vv not used not used
water depth y not used not used
Froude number F not used not used
depth-averaged horizontal velocity D not used not used
number of cellsin the vertical direction i not used not used
bed level z not used not used
bed shear stress m not used not used
roughness/depth h not used not used
roughness r not used not used
bed form height b not used not used
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Table 2: Variable explanation

Variable Character | Integer 1 | Integer 2
sediment fraction f notused | sizeno.
sediment thickness based on cell centres I not used not used
sediment thickness of top layer L not used not used
sediment thickness based on cell corners t not used not used
d50, or average sediment diameter at the bed a not used not used
bed movement S not used not used
temperature gradient parameter (Sperillen) X not used not used

When printing Tecplot filesfrom SSIIM 2, it is possible to use versions with both structured
(2D) and unstructured (3D) grids. However, since SSIIM 2 uses an unstructured grid, printing
the structured 2D Tecplot file, only the first block is written.

The Paraview.vtk file isafile similar to the Tecplot.dat file. The file can be viewed in the Par-
aView program, which is similar to Tecplot in functionality. ParaView is freeware and can be
downloaded from the Internet.

In SSIIM 2, athree-dimensional ParaView fileiswritten instead of aresult fileif the F 48 10
isgiveninthe control file.

Printing cross-sectionsfor ParaView from SSITM 2.

Sometimes the user wants to see variablesin a cross-section from a SSIIM 2 grid. This can
bed done by specifying the integer 12 on the F 48 data set, and print the “result” file. Then a
ParaView file will be written from the cross-section defined in the “interpol” file. Note only
one cross-section can then be given in thefile.

Both the Tecplot and Paraview programs may show strange results if using UTM coordinates
with alarge number of digits are used for the grid.

5.20 Thefracresfile

The fracres file contains information about the thickness of the active and inactive layer and
the grain size distribution in the two layers. Each line in the file describes one bed cell. The
first two integers arethe i and j values, identifying the cell in a structured grid. An indication
about the index for each cell can be seen in the grid editor or the discharge editor, by choosing
"View->legend" in the menu. Thiswill give the index for the grid intersections. The corre-
sponding cell will bein the direction of lower index values.
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After the two integers, afloating point number is given, which is the thickness of the active
sediment layer in meters. Then the fractions of each sediment size are given as floating point
numbers. After that, the thickness of the inactive layer is given (meters). Then the fractionsfor
theinactive layer are given. A total of 2 x ( 1+ n) floats are then read, where n is the number
of sediment fractions.

Example: Three sediment sizes:
230.01040.30.32.00.30.40.3

Thelineisfor cell (2,3). Thethickness of the active layer is0.01 m. In the active layer thereis
40 % sediments of size 1, 30 % of size 2 and 30 % of size 3. Theinactive layer has athickness
of 2.0 meters, and contains 30 % of sediment size 1, 40 % of size 2 and 30 % of size 3.

The fracres file can be made by using a spreadsheet.

The fracresfileisread by using an O (letter, not zero) on the F 2 data set. Or reading the com-
presfile from the menu. Also note that the active layer thicknessin the fracres file must be the
same aswhat is given on the F 106 data set. If the F 106 data set is not used, the active layer
must be the same as the maximum grain size on the S data sets.

Note that the order of the bed cellsin the fracresfile is not important. Also note that the values
for the same cell can be given multiple times. Then it is only the last value that will be used.
This"feature" can be useful when regions of different sediments are to be described. Then the
whole geometry can be covered in one particle distribution, and then the region of different
distribution can be given afterwards. It is not necessary to remove the originally given values
before adding new ones. This can be nested as many times as necessary. The only limitationis
the length of the fracres file, which must have less lines than 20 x the number of bed cells. If
thisisaproblem, it is easy to increase the number and recompile the program.

After thefileis made, the user should read it and ook at the grain size distribution and the sed-
iment thickness in the SSIIM graphics. Then possible mistakes can be seen.

5.21 The bedangle file (SSIIM 2 only)

The purpose of the bedangle file isto enable the user to give a spatially varying angle of
repose for the sediments on the bed. Thefileisonly used if an F 274 1 data set in given in the
control file.

The angles of repose are given on one line for each bed cell in the grid. Each line hastwo inte-
gers and four floating point numbers. The two integersidentify the bed cell. Then four floating
point numbers are read. The first two floating points are the angle of repose used to compute
the reduction in the critical shear stressfor erosion of a particle, for upstream slopes and
downstream slopes. These values are typically used in the Brooks or Dey’s formula. The val-
ues are given in degrees. Typical values are 25-50 degrees.
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The third floating point number on the lineis alower limiter for reduction of critical shear
stress. The reduction of the critical shear stress will not be below this value. The parameter
should be between 0 and 1.

Thefirst three parameters can also be given values on the F 109 data set, for all the cells. Note
that the angles given on the F 109 data set is the inverse tangens to the angle, not the angle in
degrees as given in the bedanglefile.

The fourth parameter is the angle of repose used in the sand dide algorithm. Thisisalso given
in degrees. The variation in angle of repose for the sand slide algorithm isonly coded for the F
56 200 option.

Example:

3440.035.00.233.0

5.22 Theinspacefile (SSIIM 2 only)

The inspace file enables the user to give a spatially varying inflow sediment concentration at
the upstream boundary. The concentration is given as a function of the (x,y,z) coordinates of
the center of the cell surfaces at the inflow boundary. The following function is used:

C = ky+ KX + Kgy + Kgh + kex® + Kgy” + ko h? + kgXy + Kgxh + kyoyh (5.22.1)

The x,y and z coordinates use the same coordinate system as the grid. Instead of using the z
coordinate, the h parameter is used, where h is the water depth, or the distance between the
water surface to the center of the inflow surface, z. In other words: h = water level - z

The values of the coefficients ki-k;q are read on eighter B data sets or C data setsin the
inspace file. The B data sets are used if the concentrations do not change over time. The C data
sets are used to specify time-variations of the parameters. For multiple grain sizes, one B/C
data set is used for each size. An integer is read first, before the ki-k; o values. The integer
denotes the sediment size.

For time-variation of the parametersin Eqg. 5.22.1, the number of time stepsin the file must be
given on the F 294 data set in the control file. Also, T data sets must be given between each
seriesof C data sets. The T data sets also contain afloat, which isthe time when the dataset is
used.

The inspace file starts with A 1.

Example: Two sediment sizes and two time steps:

Al
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T00

C10.00.00.00.00.00.00.001 0.001 0.0002 0.0002
C10.00.00.00.00.00.00.002 0.001 0.0002 0.0002
T 3600.0

C10.00.00.00.00.00.00.003 0.001 0.0002 0.0002
C10.00.00.00.00.00.00.004 0.001 0.0002 0.0002
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Chapter 6. Theoretical basis

6.1 Water flow calculation

The Navier-Stokes equations for turbulent flow in ageneral three-dimensional geometry are
solved to obtain the water velocity. The k-e model is used for calculating the turbulent shear
stress. A simpler turbulence model can be used. Thisis specified on the F 24 data set of the
control file.

The Navier-Stokes equations for non-compressible and constant density flow can be modelled
as.
— + U— = ;gj(— P~ puiu) (6.1.1)

X I

The left term on the left side of the equation is the transient term. The next term is the convec-
tive term. The first term on the right-hand side is the pressure term. The second term on the
right side of the equation is the Reynolds stress term. To evaluate this term, a turbulence
model is required.

The equations are discretized with a control-volume approach. Animplicit solver is used, also
for the multi-block option. The SIMPLE method is the default method used for pressure- cor-
rection. The SIMPLEC method is invoked by the K 9 data set in the control file. The power-
law scheme or the second-order upwind schemeis used in the discretization of the convective
terms. Thisis determined by the values on the K 6 data set in the control file. The numerical
methods are further described by Patankar (1980), Melaaen (1992) and Olsen (1991).

The Power-law scheme will reduce the diffusive flux as afunction of the Pechlet number. This
reduction is not used in the Second-order upwind scheme. It is also not used in the horizontal
directionsin SSIIM 2, only in the vertical direction. In SSIIM 1, the reduction isdonein all
directions.

The default algorithm in SSIIM neglects the transient term. To include this in the calculations
the F 33 data set in the control fileis used. The time step and number of inner iterations are
given on this data set. For transient calculations it is possible to give the water levels and dis-
charges asinput time series. The timei file isthen used. For further description of thisfile, see
Chapter 5.14.

The gravity term is not included in the standard algorithms. It is only invoked in some of the
free-surface calculations, for modelling spillways and flood waves with steep fronts. The F 36
data set is used to include the gravity term.

The wind shear stress, T, on the lake surface is calculated as a function of the measured wind
speed, U4, using the following formula:
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2
= C10P,ir Y (6.1.2)
The Boussinesq approximation

The eddy-viscosity concept is introduced with the Boussinesq approximation to model the
Reynolds stress term:

— A, M
= (5 07)()+ 23, (6.13)

Thefirst term on the right side of the equation forms the diffusive term in the Navier- Stokes
equation. The second term is often neglected, but can be included in SSIIM 1 by adding F 100
linthecontrol file. The third term on the right side isincorporated into the pressure. It isvery
small, and usually not of any significance.

Thek-¢ turbulence modél

The k- model calculates the eddy-viscosity as.

v = Cﬂ% (6.1.4)
£

k is turbulent kinetic energy, defined by:

K E%i_ui (6.1.5)
kismodelled as:

%& ujg;"j . %(ﬁ%) FP—¢ (6.1.6)
where Py is given by:

P= VT%:J(?XJ ?XJ) (6.1.7)

The dissipation of k is denoted €, and modelled as:

%‘% uj%‘j %(ﬁ%‘?) + CulPr cgz: (6.1.8)

]
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In the above equations, the c's are different constants. These can not be changed by the user.
The k- model is the default turbulence model in SSIIM.

Thek-o model
The k- model was developed by Wilcox (2000). It is given by the following equations:

e (6.1.9)

k is turbulent kinetic energy, similar to the k- model. kis modelled as:

K. K _ I K
G V% T % (GVT&() + P f ka (6.1.10)

where Py is the production of turbulence, similar to the k-epsilon mode!:

Instead of using the dissipation of k as the second variable, the model uses m, whichisthe spe-
cific dissipation rate (units seconds'l). The equation for @ ismodelled as:

dw Jdw Jd Jdw
PRl 5( 0_5()+a—Pk Bt (6.1.11)

The following values and formulas are used for the additional parameters.

18 1 g -2 -2
=2 ©°=3 PPl B =By Po=15  Po=1gg

2
1+7
oo 1 70%, 7= |28 (6.1.12)
B 2 @ 3
1+80y, (fw)
1 1 <0
1 Kkdw
f.=d1+680)° = — &L 6.1.13
Vi X;;Z N Xk o 07X07X ( )
1+ 400y,
_ LM N _yMi N
i = 2(axj - axi) 3 = 2(&xj * 5 (6.1.14)

The k- model often gives less turbulent diffusion than the k-e model. This means it may
overpredict the size of recirculation zones, whereas the k-€ model often underpredicts the
recirculation zone length.

In SSIIM, the wall laws for the k-€ model are used also for the k- model. Thisis dueto the
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easier inclusion of wall roughness and the accuracy of the bed shear stress prediction.
Influence of density variations

The effect of the density variations on the water flow field is taken into account by introducing
amodified eddy viscosity. The eddy viscosity from the k-¢ model is multiplied with a factor
taking into account the velocity and concentration gradients (Rodi, 1980):

(2%

Ip
oz

Vi = Vrollt (6.1.15)

ko
&

2
<E>

The eddy viscosity is denoted v, b is aconstant equal to 10, p is the density of the water/sed-
iment mixture, U isthe velocity, zis the geometrical variable in the vertical direction, g isthe
acceleration of gravity and a is a constant equal to -0.5.

Note that the same formulais used to change the turbulent diffusivity when calculating other
parameters than the water velocity. The constants a and b then gets the values -1.5 and 3.33,
respectively. The user can specify different parameters on the F 82 data set in the control file.

Wall laws

Thevelocity gradient towardsthewall is often very steep. If it isto beresolved inthegrid, this
will require too many grid cells. Instead, wall laws are used. This meansthat it is assumed that
the velocity profile follows a certain empirical function, called awall law. The equations we
want to solve, both the Navier-Stokes equations and the turbulence equations, have certain
discretized source terms in the main computational domain. For the cells close to the wall,
where thewall laws are applied, the wall |aws are used to derive analytical expressionsfor the
source terms. These analytical expressions are used instead of the normal source terms. For
example, when computing the velocities, the wall law is used to calculate the shear stress at
thewall. The shear stress multiplied with the area of the cell side bordering the wall is used as
asink term in the velocity equation.

The default wall law in SSIIM is given below. It is an empirical formulafor rough walls
(Schlichting, 1979):

U _ 1 30y
e Km( ks) (6.1.16)

The shear velocity is denoted u, and k is a constant equal to 0.4. The distance to thewall isy
and the roughness, K, is equivalent to adiameter of particles on the bed. It can be specified on
the F 16 data set in the control file. If the roughness varies at the bed, aroughness for each bed
cell can be given in the bedrough file.

In SSIIM 1, itisalso possible to use wall laws for smooth boundaries. Thisis done by giving
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an F 155 data set in the control file. The following function is then used:

Eyu u
L lIn( Y X) for &>11
u, K v v
(6.1.17)
Eyu u
U _ % for b< 11
u v v

E isan empirical parameter equal to 9.0.
I nfluence of sediment concentration on the water flow

Note that there is still a discussion about the following arguments in the science of sediment
transport. Some of the theories below are not generally agreed upon.

The effect of the sediment concentration on the water flow can be divided in two physical
Processes.

1. The sediments close to the bed move by jumping up into the flow and settling again. This
causes the water close to the bed to loose some of its velocity, because some of the energy is
used for moving the sediments. This can be thought of as an added roughness. Einstein and
Ning Chen (1955) conducted a set of classical experiments where they obtained a modified
velocity distribution as afunction of the sediment concentration. This function modifies the k
constant in the law wall (Equation 6.1.17). The formulais:

1
R S 6.1.18
K= Ro1+ 250 (6.1.18)

Thisformulais coded in SSIIM, and invoked automatically for the water flow calculation
whenever the sediment concentration array has values above zero.

2. The other process is the sediment concentration increasing the density of thefluid, changing

theflow characteristics. A typical exampleisadensity current. Thiseffect isadded as an extra
term in the Navier-Stokes equations:

e
P97 (6.1.19)
Thisterm is not automatically invoked. The user can invoke thisterm by using the F 18 data
set in the control file.
Note that the two effects will move the velocity profile in opposite directions. Process 1 will

decrease the water velocity close to the bed, while process 2 will increase the water velocity
close to the bed.

176



6.2 Water quality calculations

Thewater quality is calculated with the convection-diffusion equation for the concentration, c,
of each water quality constituent:

dc dc d dc
% Uiaxj - axj(r%(j) (6.2.1)
The difference from computing sediment concentration is the addition of extra source and sink
terms, due to fluxes at the water surface and chemical and biological reactions. The source
(sink=negative source) terms in the equations have been modelled in a number of different
ways by various researchers and computer programs. A goa in the implementation of water
quality in SSIIM was to give the user aflexibility on how to model each term. The user must
therefore not only specify various reaction constants, but also specify each term in the source
equation. Thisinvolves some more work than other models when making the input files, but it
gives better flexibility for the user to make new terms and models for the various situations.

The user first have to decide how many constituents are to be simulated. The user have to
number each variable from 0 to as many variables asis used. Presently, the maximum number
of variables are 20. The number of variables have to be given on the F 50 data set. The names
of each variable is given in the control file on the Q O data set. Note that only lower case |et-
ters have to be used, and a maximum of 40 characters. For each equation, the user have to
specify the source termsin the equations. Thisis done on the Q data set in the control file.
There are anumber of various Q data sets, fromQ 1, Q 2 ... etc. The various data sets are
described in Chapter 5.3.9. Each data set gives a number of integers and floats. The first inte-
ger isawaysthe index for the equation.

The temperature is defined as awater quality constituent. If the temperature influence on the
water flow isto be modelled, asin stratified flow, the temperature has to be variable no. 0.
Then also the data sets F 40, F 62 and F 67 may have to be used. Thisis only implemented for
SSIIM 2.

Each term in each equation have its own Q data set. For example, if temperature, oxygen and
nitrogen is simulated, this givesthree variables. The following Q O data sets can then be used:

Q 0 0 temperature

Q 01 oxygen
Q 0 2 nitrogen

The source terms then have to be specified. For smplicity, let us say that the temperature
source is 0.1 times the oxygen concentration and the oxygen source is 0.3 times the tempera-
ture. The nitrogen source is 2.1 times the oxygen concentration multiplied with the tempera-
ture minus 0.4 times the nitrogen concentration. Thisisthen given as:

Q10020 1.0 18.0
Q12103
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Q231221
Q132-04

Consult Chapter 5.3.13 for more details on the Q data sets. Also, one of the examplesin Chap-
ter 6.4 describes awater quality calculation.

No more than 40 variables can be smulated, and it is not allowed to have more than 200 Q
data setsin the control file.

The above example shows the flexibility of the program to incorporate new models for the
various reactions. It aso shows that the user is able to make models that make little sense from
abiological/chemical point of view, and the program will allow this calculation to be carried
out. The user must therefore have agood knowledge of water quality processesto give reason-
able input data and to obtain reasonable results. Care must also be taken not to mistype num-
bers on the Q data sets.

Initial values

Theinitial valuesfor water quality parameters when the calculation startsis given on the G 41
data set. The data set specifies avertical distribution of a variable. Horizontal homogeneity is
then assumed for the initial values. For the temperature, it is also possible to use the G 40 data
set instead.

Adsor ption

Adsorption is a process where the concentration of a variable sticks to particles. The particles
are calculated as another variable. The effect is that the absorption causes the concentration to
decrease, asthe particles sink and deposit. The Q 123 data set is used.

This processisonly implemented in SSIIM 2, and it is not tested.

Resuspension

Resuspension is calculated based on classical sediment transport theory. The source in the bed
cell iscalculated as:

Jdc _ . b
pri a(tT—"1p) (6.2.2)

where 1 isthe shear stress and aand b are coefficients. The shear stressis calculated from the
turbulence model, wall laws and roughness of the hydrodynamic model.

Resuspension can be calculated using the Q 2030 data set. Note that it is also possibleto usea
zero-order formulafor the resuspension, with the Q 2001 data set.

This process using Q data setsis only implemented in SSIIM 2, and it is not tested.
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Pathogens and toxics

Pathogen concentrations decrease/increase due to the following processes (Chapra, 1997):
1. Natural decay, constant with time

2. Settling via adsorption (Q 121)

3. Decrease dueto irradiance (Q 122 and Q 6100)

4. Resuspension (Q 2030)

The brackets indicate the data set used to specify the parameters.

This approach may also be used to model toxics, aslong asit is only necessary to model the
processes above.

Thisprocessis only implemented in SSIIM 2, and it is not tested.
Gasreaeration at the water surface

The gas reaeration can be calculated using Fick's law at the water surface (Chapra, 1997):

rVT(Cair — Co)

o (6.2.3)

Reaeration =

The constant c,;, isthe saturation concentration at the water surface film, which is assumed to
be a function of the partial gas pressure. For oxygen at 20 degrees, thisis 8.66 x 10-3 mg/m3.
The effective diffusion is afactor, r, multiplied with the turbulent eddy-viscosity.

The source can be given on the Q 1102 data set.

Thisprocessis only implemented in SSIIM 2, and it is not tested.
Inflow of water quality constituentsfor SSIIM 2

To have an inflow of nutrients of algae, the following is done:

In the discharge editor, awater discharge isgiven in different groups. Up to nine groups can be
used. The water discharge and the group index is stored in the unstruc file.

The inflow concentration of nutrientsis coded in the control file, on the M data set. The data
set takes two integers and one float. The first integer is the same integer used to index the
water discharge group in the unstruc file. The second integer is the number of the water qual-
ity constituent, similar to the Q data set. The float isthe concentration of the nutrient. The data
set can a'so be used to specify inflow of algae.

It ispossible to specify anumber of M data sets, according to the number of inflow groups and

water quality constituents. If anutrient has zero concentration at the inflow, it is not necessary
to specify an M data set for it. It is not necessary to specify M data sets for the outflow.
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Time-dependent variation in input parameters

To specify time-dependent inflow of nutrients, the timel file has to be used. Also, it is neces-
sary to specify an M data set in the control file for each of the varying inflow concentrations.
But instead of using the | or J data set in the timei file, an M data set is used. On this data set,
thetimeisgiven first, similar to the | data set. Then afloat is given, which isavariable time
step. The variable time step is not coded yet, but it has but be given in the data set. Then the
three floats for the wind is given, if wind is specified in the control file. Then up to 20 inflow
concentrations are given. Note that the depth and water discharges from the | data set is not
given. The number of inflow concentrations is the same as the number of M data setsin the
control file. Irradiance read as the last number of the line, if specified by the Q data setsin the
control file.

Note that the order of the M data sets in the control file is not important, but the order of the
dataon the M datain thetimei file hasto be the same as the order of the M data setsin the con-
trol file.

Example:

control file:

Q 0 0 cyanobacteria
Q 0 1 phosphorous
Q 0 2 nitrogen

Q 0 3 algae density
Q04 light_history

fall velocity for algae:
algae_diameter form_resistance temperature

Q13103 0.0001 1.0 20.0
algae density:
a bocl c2 c3 ks irradiance min max

Q 282 304 0.0086 0.69 0.0022 0.00000028 0.0003833 25.0 0.7 13

light history:
a b averaging period
Q1324 00.0086 0.69 86400.0

algae growth:

a b cl c2growth_phostnit ks phosks nit temp_const
Q2811230.00860.691.181.00.82 0.0009 0.042 1.106
phosphorous depletion:
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a b cl c2growth phostnit ks phosks nit temp_const nutrient_fraction
Q2911020.00860.691.181.00.82 0.0009 0.042 1.106 0.02

nitrogen depletion:
a b cl c2growth_phostnit ks nit ks phostemp_const nutrient_fraction
Q2912010.00860.691.181.00.82 0.0042 0.0009 1.106 0.14

g 42 00.0086 0.69 1.18 1.0 concentration, kc_(attenuation), c0, cl1

M 1 0 0.001 inflow concentration of cyanobacteria
M 1 1 0.0003 inflow concentration of phosphorous
M 1 2 0.002 inflow concentration of nitrogen

timei file

time timestep windspeed winddir_x winddir_y inflowO inflowl inflow2 irradiance
M 00 00 1.0 1.0 0.0 0.001 0.0003 0.002 0.0
M 1000.0 0.0 1.0 1.0 00 0.001 0.0003 0.002 10.0

Summary of special Q data sets:
The table below summarizes special Q data sets, including their creation date.

Q 1102: oxygen reaeration, 18/7-98

Q 1060: surface temperature flux, 17/7-98

Q 2030: resuspengjon, 17/7-98

Q 2149: SOD 30/7-98

Q 11: general fall velocity

Q 42: algae growth, Leven, diatoms, 3/4-98

Q 113: time history of irradiance, 20/7-98

Q 120: WQRRS data set: algae

Q 121: predatation 17/7-98

Q 122: Pathogen, light, 20/7-98

Q 123: sorption fall velocity 17/7-98

Q 131 algae fall velocity, 20/6-98, const. temperature

Q 132: light history, set, 8/7-98

Q 133: light history, passive scalar, 10/7-98

Q 151 specific algae density, SCUM, one light att. coeff.
Q 152: algae growth, Leven, diatoms, 3/2-98

Q 161: specific algae density, SCUM, two param. light att., 30/6-98
Q 162: algae growth, Leven, diatoms, 3/2-98

Q 221: algae fall velocity, SCUM, 30/6-98, variable temperature
Q 230: WQRRS data set: algae

Q 252: algae growth, 20/7-98, multiple algae, one nutrient
Q 261: nutrient depletion 20/7-98

Q 272: diatom growth, 26/2-98, diatoms, silica, .

Q 281 algae growth, cyanobacteria, 25/6-98
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Q 282: specific algae density, SCUM, 8/7-98, light history

Q 291: nutrient depletion, 25/6-98, one algae, two nutrients

Q 361: algae growth, cyanobacteria, 16/7-98, multiple algae, two nutrients
Q 371: nutrient depletion, 16/7-98, multiple algae, two nutrients

Q 6100: light irradiance, 17/7-98, multiple algae

6.3 Sediment flow calculation

SSIIM calculates sediment transport by size fractions. In the control file, each fraction is spec-
ified on an Sdata set, where the diameter and fall velocity is given. This data set hasto be
given when calculating sediment transport. The number of sediment sizesisgivenonthe G 1
data set.

There are two methods to specify sediment inflow in the control file. One method isto give
theinflow on the | data setsin kg/s. An | data set must then be given for each fraction. A ver-
tical sediment concentration distribution according to the Hunter-Rouse Equation will then be
used. This sediment concentration will be given over the entire upstream cross-section (i=1).

The other method to specify sediment inflow isto use the G 5 data set. Then the concentration
isgiven for a specified surface at the boundary of the grid. The concentration is given in vol-
ume fraction, which isused in all calculations by SSIIM. Itispossibleto useboth | and G 5
options simultaneously to specify multiple sources of sediments.

Specification of initial sediment fractions on the bed is done by using N and B data setsin the
control file. The N data sets specify a number of sediment mixes. The distribution of the mixes
in the various parts of the bed is given on the B data sets.

Theory

Sediment transport istraditionally divided in bedload and suspended |oad. The suspended load
can be calculated with the convection-diffusion equation for the sediment concentration, ¢
(volume fraction in SSIIM):

Loy LiwZk= 2 (rﬁc) (6.3.1)

Thefall velocity of the sediment particles is denoted w. The diffusion coefficient, T, is taken
from the k-¢ model:

=1
r=g (6.3.2)

Scisthe Schmidt number, set to 1.0 as default. A different value can be given onthe F 12 data
set in the control file.
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For suspended load, van Rijn (1987) developed aformula for the equilibrium sediment con-
centration, Cpey, Close to the bed:

[r— (ALE
0,3

d” 7, }
Cbed = 0,015_ <

a [(ps—pw)g}o’”

2
PuV

(6.3.3)

The sediment particle diameter is denoted d, ais areference level set equal to the roughness
height, t is the bed shear stress, 1. isthe critical bed shear stress for movement of sediment
particles according to Shield’s curve, p,, and pg are the density of water and sediment, v isthe
viscosity of the water and g is the acceleration of gravity. The empirical parametersin the
equation (0.015, 1.5 and 0.3) may be changed by using the F 6 data set in the control file.

The sediment concentration from Eq. 6.3.3 will be fixed in the cell closest to the bed. For
time-dependent computations, it is also possible to use an algorithm that converts the concen-
tration from the formulainto a sediment entrainment rate. Thisisdone by giving F 37 2in the
control file.

The decrease, K, in critical shear stress for the sediment particles as a function of the sloping
bed was given by Brooks (1963):

_ _singsing singsin )2 2 [, (tang)\?
"= tan6 J( tan 6 ) +cos ¢[1 (tang)} (634

The angle between the flow direction and a line normal to bed plane is denoted o.. The slope
angleisdenoted ¢ and 6 is a slope parameter. The factor K was calculated and multiplied with
the critical shear stress for ahorizontal surface to give the effective critical shear stressfor a
sediment particle.

In addition to the suspended |oad, the bed load, gy, can be calculated. Van Rijn’s formulafor
bed load is used:
|:’Z'_ TC:|2,1
T
o = 0,053 ¢

o s~ o (el

The empirical parametersin the equation (0.053, 2.1, 0.3 and 1.5) may be changed by using
the F 83 data set in the control file.

(6.3.5)

The bed form height, A, is calculated by van Rijn’s equation (1987):
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T— 1T,
4_ 0P, 7] %
4 - 0.11( d) 1-e (25—[ - D (6.3.6)
where d is the water depth. The effective roughness is computed as (van Rijn, 1987):

254
ke = 3Dgy+ 1,1A{1—e f] (6.3.7)
where A isthe bedform length, calculated as 7.3d.

Note that van Rjin’'s equations for bed form roughness was devel oped on mostly uniform sed-
iments. For non-uniform sediments, the bed forms will be smaller.

Many of the parameters in the formulas given above can be changed by giving different

parameters in the control file. If completely different formulas are to be used, this can be
coded in the beddll.dll file.

6.4 Temperature calculations

Temperatureis calculated as the other water quality components. Modelling temperature-strat-
ified flow isonly possiblein SSIIM 2. Temperature must then be variable no. 0. The F 40 1.0
and F 62 1 data sets must also be used in the control file.

JT JT d ( dT)
— 4 — = e —_— L
X Ul&xj 07Xj FTaxj (6.4.1)
Heat flux acrossthe water surface

The heat flux across the water surface is calculated according to the following processes:
- solar short-wave radiation

- atmospheric longwave radiation

- longwave back radiation from the water

- conduction

- evaporation

The formulafor the surface flux, I, can be written according to Chapra (1997):

| = IrB+ o(T,;, + 273)*(A+ 0,031, fe, )(1-R ) — eo(T  + 273)" (6.4.2)
_leUw(Ts_Tair) _fUW(es_eair)

Intheformula, Ir istheirradiance, T isthe temperature, sisthe Stefan-Bolzman's constant,
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f(Uw) is afunction of the wind speed, given by Chapra (1997) and ey isthe saturation vapour
pressure at the water surface. The other parameters are given below in the description of the
corresponding data set.

The parameters are specified on the Q 1060 data set. Time series of wind speed, irradiance and
air temperature is given in the timei file.

6.5 Modelling free-flowing algae

The special algal processes are only implemented in SSIIM 2.

Algae has two characteristics which needs special carein modelling. Thefirst characteristicis
its growth process. Thisis often both dependent on light and nutrients. The nutrients are often
phosphorous, but nitrogen and silica may also be important for some species and situations.

The other main algae modelling characteristic isitsfal/rise velocity. Thisis dueto changesin
its buoyancy. The buoyancy is often dependent on other parameters, for example irradiance.

A number of special data sets are made for different species of algae. Some of these can be
used in combination with each other. Also, they can be used in combination with the other
water quality data sets.

Two different groups of data sets are used, depending on whether there are multiple species of
algae or only one single species contributing to the light shading. If there is only one species
of algae, the light shading parameters are give in the growth data set. These types of data sets
are described first.

Calculation of spatial distribution of algae includes modelling of the algal vertical rise/fall
velocity. Therise/fall velocity is dependent on the algal density, algal diameter and aform fac-
tor. The algal density is dependent on the irradiance and the light extinction in the water body.
Because the agal density depends on the values of the previoustime step, it has to be mod-
elled as a separate parameter. This means that modelling algae concentration necessitates an
extravariable.

Some special Q data sets can be used to model algae settling and production. For example, Q
151 is used to calculate the density as a function of the irradiance, I, light extinction coeffi-
cient, k, and anumber of coefficientsin the density formula. The time-dependent irradianceis
given in thetimei file. The amount of irradiance, |, decrease with the factor f, as afunction of
the water depth and the algae concentration. The following formulais used:

e—kecaAz

(6.5.1)

=y

cells above current cell

The algae concentration is denoted c,, and zis the vertical size of a cell. The specific light
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transmission coefficient, kg, is given by Bindloss (1976):

ke = ac,+ b (6.5.2)

e

where a and b are constants in a regression formula based on measurementsin alake.

The algal density is calculated by the following equation given by Kromkamp and Walsby
(1990):

|

paisthe algae density, t isthe time and kq, ko, k3 and K are constants. 1,, is the average irradi-
ance over the last 24 hours. The coefficients of Kromkamp and Walsby (1990) are used. The
fall/rise velocity, w, of the algae is calculated from Stoke's equation:

2 PwPa

w = dg 18Cop,, v (6.5.4)

where p,and p,, isthe algal and water density, and v is the kinematic water viscosity, evalu-
ated as:

= 10780 55234-0,026668T (6.5.5)

where T is the temperature in degrees Centergrade.

The Q 42 data set models algal production. The algae growth isbased on light extinction and a
time series of the irradiance, |. The two first floats on the data set are coefficientsin the equa-
tion for the specific light extinction coefficient. Given the irradiance, the growth rate, k, is cal-
culated from:

f
k = a(l—e bj (6.5.6)

The parameters a and b are constants, derived from aregression analysis of observed values
(Reynolds, 1976). The two last floats on the Q 42 data set isa and b. The growth is calculated
as.

kt

C, = C, o€ (6.5.7)

a0

C, Isthe algae concentration at time t and ¢, o is the concentration at time t-1.

Thefall velocity of the algae can also be given on the Q 11 data set, where a constant value is
given.
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Other data sets that can be used are: Q 131, Q 132, Q 281, Q 282
Temperature dependency

The biochemical reaction rates as a function of the temperature is calculated by multiplying
the reaction rates with the following factor:

K. (6.5.8)

K is a constant slightly above unity, for example 1.022, and T is the temperature. K; is raised
to the power (T-20). This means that the growth rates are given at 20 degrees Centergrade,
which makes the term unity.

The term is coded in some of the data sets, where K; is given. Note that the temperature
dependency isonly used in the data sets when atemperature calculation is carried out
simultaneously - that is, if F 67 1 isused in the control file.

Multiple algae species decreasing irradiance

If multiple algae species are calculated, it is necessary to have light irradiance as a separate
variable, since more than one agae species contribute to the light reduction. It is possible to
simulate up to five different algae species or other variablesthat influence the light irradiance.
When using the Q 6100 data set, the light history is calculated with the Q 113 data set. Also,
the algae growth can be cal culated in combination with the Q 6100 data set using the Q 252 or
the Q 361 data set. Nutrient depletion is then calculated using the Q 261 or the Q 371 data set.
Nutrient depletion

The nutrient depletion data set for one algae speciesis called Q 291. The data set is used for
both nitrogen and phosphorous. It issimilar to Q 281, but the last float is the fraction of the
algae growth. For multiple algae species, the Q 371 data set is used. If the growth isonly lim-
ited by one nutrient, the Q 261 data set can be used.

The implementation of this algorithm is not tested.

Predatation

The predatation is calculated as (Chapra, 1997):

% = k,C,C (6.5.9)
dt pr~al ~¥zoo

dc

5t = Kz00%iCz00 (6.5.10)

Subscript al denotes phytoplankton, and subscript zoo denotes zooplankton.
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The sink/source term is modelled with the Q 121 data set. Note that this data set must be used
for both the phytoplankton and the zooplankton.

The implementation of this algorithm is not tested.
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Chapter 7. Programming SSIIM DLLs

7.1 Introduction

DLL isan abbreviation for Dynamic Link Library. Several functions of the SSIIM programs
have been made into DLLs. Thisislinked into the main executable when SSIIM is started.
The source code of the DLL is provided, giving the possibility to modify these functions,
compiling them and using them in the main SSIIM program. This means accessto a part of the
source code for SSIIM.

When making SSIIM available on the Internet, it was intended that the program could be used
and tested in the academic community, as MSc and PhD students would use it in their
research. This has proven successful up to now. However, some students would also like to do
some programming themselves as a part of their PhD research. Building a CFD model like
SSIIM takes many years, and is beyond the scope of a PhD study. The new DLLs providesthe
possibility to program parts of SSIIM. The accompanying source code shows an example of
thisisdone, and it isfeasible for the PhD student to make changes to the code in relatively
short time. By using the modified DLLswith SSIIM, researchers can test their own code with-
out having to program other existing features of a CFD model, for example user interface
graphics and other numerical algorithms.

Thefirst DLL was made for the bed boundary condition for the sediment transport compua-
tions. These agorithms are highly empirical, and considerable knowledge on sediment trans-
port physics are required for their modification. Such knowledge is generated by basic
sediment transport research, currently carried out by many universities in the world. Such
research is essential to improving the predictional capabilities of the CFD programs.

7.2 Compilation

The Windows versions of SSIIM are made using the C++ compiler in the Microsoft Visual
Studio 2005, together with the Intel compiler. The DLLs can be made using the same compil-
ers. The express version of Microsoft Visual Studio 2005 can be downloaded for free from
Microsofts web pages.

In the following, it is described how the sediment bed functions DLL, beddll.dll, is made
using the Microsoft Visual C++ 6.0 compiler. The same procedure is used for the other DLLSs.

The beddll.zp file contains severa source input files. Unzip the filesinto a separate subdirec-
tory. Then start the compiler. Choose File -> Open, and in the dialog box choose All files * .*
in the Files of type edit field. Then go to the directory where the beddl| files are, and choose
thefile beddll.dsw. Thisloadsall thefiles. Intheleft workspace window, choose FileMView, and
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see all the Source Files. Then choose the beddll.cpp file. Thisfile isthen loaded in the main
window. The file contains the six functions (A function in C issimilar to asubroutinein
FORTRAN). By scrolling in the window, the source code is seen, together with explanation of
all the variables. The source code iswritten in C, and a basic knowledge of thislanguage is
required.

After thefileis modified, it should be saved, and then compiled. The compilation and making
the beddll.dll fileis done by using Build->Build beddl|.dll. Possible error messagesin the
compilation have to be sorted out, and the process repeated. Finally, the beddl|.dll fileis made.
Thisislocated in the subdirectory Release or Debug, according to which of the two optionsis
chosen (Debug is default). The beddll.dll fileisthen copied to the same directory asthe SSIM
executable file and input files, and the SSIM program can be run.

For further details, the user isreferred to the documentation of Microsoft Visual C++.

7.3 The BEDDLL file - sediment transport functions

The sediment transport functions are given in the beddll.dll library. There are six functions:

- computeShear

- computeCritical Shear

- computeBedSlopeCorrection
- computeBedConcentration

- computeBedForms

- computeBedRoughness

The names indicate the purpose of the functions. A brief description is given below. More
detailed information about the input parameters are given in the source code.

The computeShear function computes the shear stress on the bed as a function of the turbu-
lent kinetic energy closeto the bed. It isalso possible to take into account the effect of the bed
forms and the roughness as input parameters.

The computeCritical Shear function computes the critical shear stressfor movement of a sed-
iment particle. The default routine uses a parameterization of Shields graph, where the input
parameters are the sediment size, density of the sediments and the bed shear stress.

The computeBedS|lopeCorrection function computes the changes in the critical shear stress
for the particle as afunction of the sloping bed. The three vector components normal to the
bed are used as input, together with the velocity vector components and two empirical param-
eters.

The computeBedConcentration is the main function for computing the boundary condition

for the sediment transport. The default routine uses van Rijn’s formulas, together with the
Hunter-Rouse sediment distribution. A number of parameters are used as input, including the
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bed shear stress, critical bed shear stress, sediment size, empirical parameters, velocity com-
ponents close to the bed etc.

The computeBedFor ms function computes the bed form height. Van Rijn’sformulaisused in
the default routine. Input parameters are water depth, dsj, dgg and a shear stress parameter.

The computeBedRoughness function computes the bed roughness. Thisisthen used in the

solution of the Navier-Stokes equation. Input parameters are bed form height, water depth, dgg
etc.
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Appendix |. Transfer of grid between SSIIM 1
and SSIIM 2.

Transfer of grid from SSIIM 1to SSIIM 2, alternative A.

1. Start the SSIIM 1 program with the existing grid.

2. Write the XCYC file from the menu. This also writes the koosurf file.

3. Make anew directory for the SSIIM 2 input files

4. Copy the SSIIM 1 control fileto the new directory

5. Copy the koosurf file to the new directory

6. Copy the koosurf file to the file koordina

7. Edit the contral file in the new directory. Increase the two first integers on the G 1 data set
by 3. Add an F 64 data set, for example F 64 11. Save the control file

8. Start SSIIM 2.0 from the new directory

9. Start the Grid Editor

10. Choose from the menu: Blocks->Add block from koosur

11. Generate the grid (Menu option: Generate -> 3D Grid)

12. If an alocation error occurs, increase the numbers on the F 65 data set in the contral file
and start from point 8 again.

13. Write the unstruc file

14. End the program

15. Check the boogiefileto seeif an allocation error had occurred. If so, increase the numbers
on the F 65 data set in the control file and start from point 8 again.

16. Start SSIIM 2.0 again

17. Enter the Discharge Editor

18. Specify the discharge

19. Write the unstruc file.

20. If you want to start the computations with a grid with alower water surface, then edit the
koordina file so that it contains the new water surface. Then add the F 112 1 data set to the
control file. The program then removes dry cellsin the startup procedure.

Transfer of grid from SSIIM 1to SSIIM 2, alternative B.

The koosurf filein SSIIM 1 issimilar to the koordina filein SSIIM 2. Follow the instructions
below:

1. Start the SSIIM 1 program with the existing grid.

2. Write the XCYC file from the menu. This also writes the koosurf file.

3. Make anew directory for the SSIIM 2 input files

4. Copy the SSIIM 1 control file to the new directory

5. Copy the koosurf file to the new directory

6. In the new directory, rename the koosurf file to koordina

7. Edit the control file in the new directory, and note the two first numbers on the G 1 data set,
I and j, on a separete piece of paper.

8. Increase i and j by 3 and save the control file
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9. Start SSIIM 2.0 from the new directory

10. Start the Grid Editor

11. Make one block anywhere in the window. The size of the block given in the dialog box
must equal to the original i and j from point 7.

12. Use the Transfinite Interpolation if the grid looks strange (Menu option: Generate ->
Transfinitel)

13. Generate the grid (Menu option: Generate -> 3D Grid)

14. If an alocation error occurs, increase the cell numbers on the F 65 data set in the control
file and start from point 9 again.

15. Write the unstruc file

16. End the program

17. Check the boogiefile to seeif an allocation error had occurred. If so, increase the cell
numbers on the F 65 data set in the control file and start from point 9 again.

18. Edit the control file and specify a gridding option on the F 64 data set, for example F 64 11

19. If specifying the F 64 11 option, remember to also add an F 94 data set, giving the
minimum cell height. If thisistoo small, instabilities will occur. The default is very small.

20. Start SSIIM 2.0 again

21. Read the unstruc file

22. Enter the Grid Editor (Note that the window may be blank. Just proceed with next point)

23. Generate the 3D grid (Menu options. Generate -> 3D Grid)

24. Write the unstruc file.

25. Start SSIIM 2.0 again

26. Enter the Discharge Editor

27. Specify the discharge

28. Write the unstruc file.

29. If you want to start the computations with a grid with alower water surface, then edit the
koordinafile, so that it contains the new water surface, and add the F 112 1 data set in the
control file. The program then removes dry cells in the startup procedure.

Transfer of grid from SSIIM 2to SSIIM 1.

Transfer of grid from SSIIM 2 to SSIIM 1 isonly possibleif the grid has one block.

1. When the unstruc file iswritten from SSIIM 2, afile called koordina.si1 is written at the
same time. Thisfile can be used by SSIIM 1. Copy thefile to a separate directory, and
rename it koordina, without an extension.

2. Copy the control file to the same directory.

3. Edit the G 1 data set in the control file so that the grid size is the same as the block
generated in SSIIM 2.

4. Remove SSIIM 2 - specific data sets from the control file.
The default algorithm in SSIIM 1 defines one side to be inflow and the other outflow. To make

the SSIIM 2 grid compatible with this definition, the GridEditor in SSIIM 2 has the menu
option View->S3 1M 1 inflow/outflow. This shows with atext what isinflow and outflow. The
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grid can be rotated with the menu option Blocks-> Rotate+/- to get the inflow and outflow at
the correct side.
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Appendix Il. Flowcharts

Flow chart SSIIM

Grid editor

Graphics

Discharge editor

\\

}

/

Startup: 1. Read control and koordina

2. F 2 choices
3. Menu choices

F2S
F2Q F2S £371 F2W
F33>0
Water quality Steady Transient Water flow
Temperature sediment Sediment computation
transport Computation (WaterSolve)
(SSIIM 1 only) (TSC)
< F50>0

The flow chart shows the main modules of the program. At startup, the control and koordina
files are read. Then the choices described on the F 2 data set are activated. This can be one of
the four main modules: water quality, steady sediment transport, transient sediment transport
or water flow computations. After the F 2 activated routines are finished, the user can activate
the modules from the menu. The user can activate the graphics, grid editor and discharge edi-

tor while the other modules are running.

On the following page, a flowchart of the time-dependent sediment transport routine from
SSIIM 2. The routine uses the two DLL filesTSC2DLL and BEDDLL, and the functions are
given in bold smaller letters. The page after shows aflowchart of the WaterSolve routine, that

solves the Navier-Stokes equations.
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Flowchart water flow function “WaterSolve()”, SSIIM 1

Initiation: metric BedMake startup waterflow

Gor(lter=start_iter;Iter<iterGIobaIMax(K1);Iter++) Iter shown on user interface )

write to timeo file

( for(Innerlter=1;Innerlter<Translinnerlter(F33);Innerlter++) )
check if grid has changed:| metric BedMake startup waterflow
gamma

generates ap, coefficients (K 6 SOU) (F 118 coeffeDLL)

Gor(VeIzl-B) loop for velocities in 3 directions )

a number of source terms for the velocities:
StressOrt | | WallLaws | | pressure_source
time steps, wind forces, density currents, Coriolis, porosity

vegetation F 115 (extra_sourceDLL)
compute a, residual

K5 | BlockCorrection

WaterGaussSeidel/WaterTDMA | solver

compute pressure

compute turbulence: k+epsilon
generates ay, coefficients (K 6 SOU) (F 118 coeffeDLL)
source terms include vegetation F 115 (extra_sourceDLL)

compute temperature
compute max residual, Max, and print to boogie file if in last iter. of inner loop
if (Max > 1010) program crashed
if (Max < 0.001 and TimeStep (F 33) < 10'8) program converged

if (Iter dividable with K 1, 2n integer, and Max < 0.01 (G 6), and F 36 is O,
and 1st integer K 2 is 1 )\

surface

if (TimeStep (F 33) < 108 and Max < 1077 (F 54) ) jump out of loop

if (F36is1) | surface_tfs

surface

if (F 36 >=2 and Max < 1000 and K 2is 1)
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Flowchart for function bedchange() in SSIIM 2

Transfer bed changes from variable Bedmove[b] to zval[i][j][1]

Check if the bed changes are under limit of erodible bed. If it is, write a warning to the
boogie file if F 1 D is used in the control file

Smooth the bed if the F 144 data set in the control file is used.

Prevent build-up of sediments at outflow section, unless F 122 0 is used in the control file

Sand slide algorithm, if F 56 is used in the control file

if( F 198 > 0) computeSlide2 (DLL)

if( Iter dividable with F 99 data set) {

Unstructure regenerate the grid

metric compute areas, volumes etc.

BedMake interpolate variables from old to new grid
waterflow compute fluxes on cell surfaces
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Flowchart for function surface () in SSIIM 2

if (F 116 > 0) {

surface2DLL

return

Find iSurfLocal, the reference cell for update of the water surface

if(iSurfLocal == 0) print error message “reference cell dry” to boogie file and exit

if timei file used, interpolate the reference water level

if(F 36 == 3) {

move water level up by adding dz=refence level - level in reference cell

if (F 1 == E) print debugging information to boogie-t file

}
if(F 36 == 4) {
compute anp, &, Source: computeCoeffSurf

fix reference values by multiplying a,, and source wth 1e%0

surfaceSolver (4)

if (F1==D orE) surfaceBugtrap

surfaceUpdate

}else if (F 36 == 8, 9 or 10) {

computeBFroude compute Froude numbers

compute apy, ap, source:

: v 20
fix reference values by multiplying a, and source wth 1e

surfaceSolver (8)

if(F1==DorE) surfaceBugtrap

surfaceUpdate

} end else if (F 36 == 8,9,10)
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} elseif (F36==7){

new algorithm

} else if ( 2nd integer on G 6 data set is zero) {
interpolate pressure to grid corners and compute the new water surface location
} else { 2nd integer on G 6 data set is non-zero
interpolate pressure to grid corner and compute new water surface location based

on the average of the two reference levels, weighted with the inverse distance to the
reference points

}

if (F154 >1) surface_smoother

if(F37==00rF166==1) {

update variables from previous time step

Unstructure regenerate the grid
metric compute areas, volumes etc.
BedMake interpolate variables from old to new grid
waterflow compute fluxes on cell surfaces
if (F168>0) AlgMGMake remakes grid for multi-grid solver
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Flowchart focusing on time steps and iterations for
transient sediment computations in SSIIM 2

The variable Iter is important. This is the number of time steps in the
sediment computation. If only water flow is computed, this variable is
also used. When water and sediments are computed at the same time,
the local variable loclter is used instead for inner water flow iterations.

iterGlobalMax is the 1st parameter on the K 1 data set in the control file
Translnnerlter is the 2nd parameter on the F 33 data set in the control file

morphology_tsc () {

( for ( Iter = 1 to iterGlobalMax
( ( ){ )

WaterSolve()
compute sediment transport

bedchange()

T
W/

WaterSolve () {

if(F 36 > 0) lociterGlobalMax = 1
else lociterGlobalMax = iterGlobalMax

Cfor (loclter = 1 to lociterGlobalMax ) { )

if(F 36 == 0) Iter = loclter

or ( Innerlter = 1 to Translnnerlter) D

compute velocities, pressure, turbulence
C D)

if(Iter dividable with F 105 and residual < 1e®) surface()

C D
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